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CHAPTER 1: Welcome to DMI-Services  

 

Disaster Management Interoperability Services (DMI-Services) is 
part of the President's Disaster Management e-Government 
Initiative -- a larger initiative aimed at greatly enhancing Disaster 
Management on an interagency and intergovernmental basis. 
 DMI-Services are primarily focused on assisting individuals and 
organizations with crisis and consequence management 
responsibilities for disasters and for the mitigation of all hazards. 
 
The primary mission of DMI-Services is to provide Interoperability 
services.  DMI-Services is service, not an application. The 
service is providing a portal for the rapid and secure exchange of 
information between emergency management organizations.  
DMI-Services connectivity and functionality is also applicable to 
prevention, preparedness, response, and recovery at the local, 
state, and federal levels.  
 
Organizations will obtain maximum benefit through day-to-day 
usage of DMI-Services as a tool for preventing and responding to 
disasters.  Connectivity is provided through a connection to the 
Internet.   
Access to the information is controlled by an authentication and 
registration process (explained on our web site at www.dmi-
services.org.  Data transfer is secured by the use of a virtual 
private network (VPN).  DMI-Services functionality is constantly 
being reviewed and expanded to provide the best possible 
service to the Emergency Management community.  
 

 This manual explains DMI-Services  capabilities, fundamental 
concepts and capabilities including DMI-Services  Collaborative 
Operations Groups (COGs), Tactical Information Exchange (TIE), 
and Desktop Mapping Tools (also called GIS), among others. 
 

 For help using DMI-Services or to submit comments, contact 
DMI-Services at 1-800-451-2647. 
 
To get help via email, send questions to help@dmi-services.org.  
 
Thank you for using DMI-Services. 
 

Updated Features in This Release 
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 National Incident Summary Map (NISM) – has been upgraded and 
replaced by the new Disaster Management Map (DMM) Web-based 
application (please see below). 
 
Disaster Management Map (DMM) – a secure Web-based 
application that is accessible through the DMI-Services/Disaster 
Management Tools menu and consists of the following features: 

National Map – displays alerts and Incidents of national 
interest that have been posted and selected to be viewed on 
the National Map by all DMIS COGs. 
My Map – displays alerts and incidents that have been selected 
to appear on My Map by your own COG for your own COG’s 
use – the items displayed on My Map are only viewable by your 
COG. 

 
Non-Weather Emergency Messages (NWEMs) – an integral part of 
the National Weather Service (NWS) All-Hazards Emergency 
Message Collection System (HAZCollect) Program.  This feature 
allows Primary Operators from within DMIS COGs that have received 
prior NWS approval to author and post NWEMs, which are relayed 
through NWS communications channels and broadcast to the public. 
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CHAPTER 2: Getting Started 
Starting DMI-Services  
 
 This chapter provides an overview, detailing how to log into DMI-

Services, getting around the screens, and accessing DMI-Services 
Help. 

 

 
1.   Double-click on the DMI-Services icon. 
 

The Login screen is displayed. 
  

2. Enter the assigned Operator (User) name in the Operator Login 
Name field. 
 

 

 
NOTE:  Never give anyone else access to an assigned account 
password! If the initial password is forgotten, the COG Administrator 
can assign a new one. 
 

  
3. Enter the assigned password in the Password field. 
 

 4. When a DMI-Services Operator is a member of more than one 
COG, he or she can select which COG to log into from a drop-down 
list. 

  
5. Click the OK button or press the Enter key to log into DMI-Services. 

  
 

The Login screen closes and the DMI-Services Desktop menu 
becomes active.  
 
Note: This is a machine dependent functionality.  Log on at a 
different machine may prohibit full viewing of COG list. 
 
The COG Administrator authorizes permissions based on roles.  
Once permissions are set, the DMI-Services Operator can access 
functions as defined by the Administrator.    
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NOTE: If any Alerts or Incidents were posted to the COG while the 
account was logged off, a notification message appears indicating how 
many of each was posted.   Acknowledge the message by pressing the 
OK button. 
 

Using Quick Start 
 
  

The Quick Start screen displays once the operator has logged 
into DMI-Services. Quick Start provides the ability to quickly 
create new Incidents and Alerts.  In addition, access an 
Operator Profile or start an Instant Messenger session. 
 

 

 
  

Click on the:  
o New Incident button to begin a new incident. 
o New Alert button to create a new Alert. 
o Operator Profile button to display the Operator Profile 

screen. 
o Instant Message button to start a new DMI-

Services Messenger session. 
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NOTE:  To bypass the Quick Start screen for a single session, click 
the X in the red square in the right-hand corner of the screen's title 
bar.  
To turn off the Quick Start screen, check the box marked "Do not 
display this dialog in the future.” 
 

 

Restoring the Quick Start Screen 
 
  

1. To restore the Quick Start screen, select Desktop Settings from the 
DMI-Services drop-down menu (DMI-Services ► Administration ► 
Settings). 

 

 
 
The DMI-Services Desktop Settings screen displays. 
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 1. Check the box next to the label "Automatically Launch Quick Start 
on Start Up." 

 

 
2. Click the Save button or select the command item for Save from 

the File drop-down menu. 
 A dialog box will display a confirmation message. 

 
3. Click the OK button to acknowledge the confirmation message.  

Accessing Functions 
 
 Access DMI-Services functions from the DMI-Services 

menu. 
 
NOTE: Access to most functions depends on user 
permissions as set by the COG Administrator. 
 

 

 

 
Many commands have Hot Keys  associated with them. 
Hot Keys are keys that are used with the Control key 
(Ctrl) or Alternate (Alt) key to perform a function normally 
found in a pull-down menu.  
Commands in the menus have underlined letters that 
indicate what keys can be used to perform the action.  For 
example, use Ctrl + O to access the Operator Profile 
screen. 

 
Logout Menu Option 
 
To log out of DMI-Services, use the Logout command 
accessible under the DMI-Services menu. 
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Administration Menu Option 
 
Use the Administration menu, located in the DMI-Services  menu, to 
access: 

o Settings 
o COG Configuration  
o COG Profile   
o Operator Profile  
o Reports 
 

 
 
Access to administrative functions is controlled by the role associated with each 
Operator. 

 
Tactical Information Exchange Menu Option 
 
The Tactical Information Exchange menu, located in the DMI-
Services  menu, enables the DMI-Services  Operator to access 
commands for: 

o Incident List 
o Archived Incident List 

 

 
 

 
Expert Reference Menu Option 
 
The Disaster Management Tools menu is available through the DMI-
Services menu. Within Disaster Management Tools access the 
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following:  
o Web Based Tools 

o DMI-Services  Home 
o DMI-Services  Web Tools 
o Disaster Help 
o Nimcast 
o NOAA nowCoast 

o Disaster Management Map 
o COG Location Map 
o DMIS Messenger 
o Weather Forecast Tool 
o Alerts List 
o Distribution List  

 
 

Accessing the Disaster Management Map 
 

 1. From the menu bar: Click DMI-Services ► Disaster Management Tools ► 
Disaster Management Map 

 
 2. New web browser will open requiring User Name, Password, and COG. 
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Using Screen Controls 
 
 A DMI-Services screen is made up of different controls, 

including text boxes, option buttons, drop-down lists, 
tables, etc.   

 
 Text Boxes 

Text boxes hold a limited amount of data.  To enter information in a text 
box, click inside the box and begin typing.   Use the Tab key to move 
from field to field. 
 

Memo Fields 
Memo fields contain narrative text and can hold several lines of 
information. 
 

 
 
 
 

Radio buttons 
Use radio buttons to select one option from a group of many options. 
 Only one choice can be selected at a given time.  To select an option, 
click the radio button to the left of its description. 
 

Checkboxes 
Use checkboxes to select more than one choice in a group.  Select any 
number of checkboxes (or leave them blank).  
 

 
Drop-down Lists 
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Drop-down lists enable Operators to select from a pre-set list of entries. 
 Drop-down lists offer flexibility that enables the Operator to select a 
previously-used entry or, in some cases, to add their own entry.   
 

To access items in the list, click on the arrow and highlight the desired 
item in the list. 

 
 
 

Calendars 
Calendars are available on many screens to help enter dates.    
 
To change the Date and Time, follow these steps: 

1. Access the calendar by clicking on the calendar icon .  
2. Select the appropriate month and year by using the left and right 

arrow icons adjacent to the Month and Year displayed. 
3. To select a date, click on the appropriate date.  
4. Enter time by typing in the hour in the left text box and the 

minutes in the right text box. 
5.   Click on the arrow within the gray box to select AM or PM. 
6.   Once entered, click OK to save the date and time displayed.  

 
NOTE: Click the close button  to close the calendar without selecting 
a date. 
 

Tree View 
 
DMI-Services use a tree structure in many situations. The tree structure 
displays the relationship of several items. For example, in TIE the 
screens for an Incident are represented by a tree structure that makes it 
easy to move through the screens in any order.  To open a screen, click 
on the paper icon  beside the name.  To open the Casualties panel, 
click on the icon next to the word Casualties.  For more information, 
see Tree View. 
 
 

 
Tables 
Many screens utilize tables for data entry and for displaying information.  
  
There are multiple ways to add and delete rows: 

o Use the Actions menu or the toolbar buttons to add and delete 
rows 
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o Use the  icon to add a row and use the   icon to 
delete a row.   

o Use the right-click menu to add or delete rows. 
o Select from the icons adjacent to the list box:  

Icon for adding a row; 

Icon for deleting a row. 
 
Many tables contain columns whose width can be adjusted based upon 
personal preferences.   
To expand the column: 

o Place the cursor over the column header. 
o Hold down the left mouse key. 
o When the mouse becomes a double-headed arrow, drag the 

cursor to the right or to the left as appropriate. 

 
 
 Tabs 

 
Many forms have tabs that are much like notebook tabs.  Click on the 
name of the tab to display the desired information. 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 

Resizing Windows and Panes  
 
If a window is too small or too large, resize it to gain a better view. 
To resize the windows: 

1. Place the cursor on a corner of the viewer; 
2. Hold down the left mouse button (be sure the cursor becomes a 

double-headed arrow); and 
3. Drag the corner of the window in the direction desired.   

 
NOTE: If a window is already "maximized," restore the window to its 
original size before resizing.  To restore it, use the Restore Down 
button. 
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Resize the navigation pane in a similar way 
 
To resize the Navigation Pane: 

1. Place the mouse cursor on the divider between the panes; 
2. Hold down the left mouse button (be sure the cursor becomes a 

double-headed arrow); and 
3. Drag the divider to the appropriate point in the screen. 

 
 

  
 
 

To make more room for other panes, temporarily hide a pane 
that is not needed.    
 
To hide a pane: 

1. Click on the arrowhead associated with the pane.   
For example, to view more of the lower panes hide the top pane in a 
TIE Incident. 
 
To hide the top pane: 

1. Click the arrow head with the narrow end pointing up. 
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Use maximizes and minimizes buttons to resize the help screen or DMI-
Services. 
 

 
 
 
NOTE: Once a content panel within the Tactical Information Exchange 
has been resized, this size will remain constant unless otherwise 
changed. 
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Using Hot Keys 
  

Many commands have Hot Keys associated with them. Hot Keys are 
keys that are used with the Control key (Ctrl) or Alternate (Alt) key to 
perform a function normally found in a pull-down menu. Hot Keys are 
available depending on which screen is currently displayed. Commands 
in the menus have underlined letters that indicate what keys can be 
used to perform the action.  For example, use Ctrl + O to access the 
Operator Profile screen. 
 
Link to Hot Keys 
 
 

 

Getting Help 
 
  

Obtain Help with DMI-Services  from the following sources: 
 

o View DMI-Services 
o Use the Training Materials 
o Obtain Telephone Support 

Using DMI-Services Help 
 

 

 
To access the contents tab of help, select the Contents option from 
the Help menu, or use the help button. 
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Tips for Printing Help Topics 
 
  

To print a topic, use the print button.  Change margins and paper 
settings with the Page Setup button. 

 
  

1. Click the Print icon. 
 

 
 

 The standard Windows Print screen opens. 
 

  
2. Make sure to specify the correct printer.  Click OK. 

 

 

 
NOTE:  Problems with the online help printing incorrectly or printing 
too many pages may require installation of an earlier version of a print 
driver. 

 

 

 
Alternatively, copy and paste the text of a topic into a Word document. 
 Simply drag the cursor over the text to highlight the words and press 
CTRL-C to copy the text.  Open a word processing program file and 
press CTRL-V to paste. 
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Navigating through Help 
 
 

 

 
NOTE: Graphics may take as much as 15 seconds to display in Help. 
 

Topics in the Help system include a variety of navigation 
components including: 

  
Links to pop-up windows: To view a topic in a pop-up window, 
click links that are blue without an underline.  (When done, click 
anywhere outside of the popup window to close it.)  
Jumps:  To view information in the right pane rather than When 
the Operator clicks on links that are blue with an underline, the 
information for that topic opens in the right pane, rather than 
displaying the topic in a pop-up). Jumps are links that are blue 
with an underline. 
 

 

 

 
 
Use the Back button in the help viewer to return to the previous 
window. 
 

  
Access the Index and the full text search function by clicking tabs 
in the left pane. 
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Resizing the Help window and the panes by dragging them in the 
desired direction. 
 

 

 
Also See topics: In the Online Help, most topics have a list of 
related topics.  To view a related topic, click on its link. 
 

Using the Contents Tab 
 

 

 
The Contents tab displays folder and page icons that represent the 
categories of information in the online Help system.  The Contents tab 
is the tab displayed when the Operator clicks on the book icon. 

  

 
 

 o Double-click a closed folder to display its contents (sub-folders and 
topics). 

 o Double-click an open folder to close it and fold the topics under it. 
 o Click the page icon to select the topic. The selected topic is 

displayed in the right-hand pane of the Help viewer. 
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The "lollipop"-like symbol next to folders that have subfolders indicates 
whether the contents are displayed.  When the "stick" of the "lollipop" 
is pointing to the folder, then the contents are NOT displayed (in other 
words, the folder is "collapsed").  When the "stick" is pointing down, 
the contents are displayed (or, in other words, the folder is 
"expanded"). 
 

 

 

Using the Index Tab 
 

 The Index tab displays a multi-level list of keywords and keyword 
phrases.  These terms are associated with topics in the Help system. 
Keywords are often cross-referenced with synonyms to provide multiple 
ways to locate information.  

  

 
 

 To open a topic in the right-hand pane associated with a keyword: 
1. Select the keyword. 

  
Use the Find box to move the cursor through the list:  
2. Type the desired term; and  
3. Press the Enter key.   

  
To move from term to term in the index: 
 
1. Press the Enter key again until the end of the index is reached. 
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The Find box only looks for terms listed in the index. 
To find terms not in the index, use the full-text search capability, which 
is performed on the Search tab.   
 
The full-text search capability provides the ability to perform "partial 
word searches."  For example, type "CO" and the help system will open 
all topics that include those two letters next to each other, no matter 
where the letters are in the topic. 
 

Using the Search Tab 
 

 Use the Search tab to search for words in the Help system, no matter 
where they are in the topic.  
To do a search, enter the text in the Find text box and press the Enter 
key. 

  
Full-text searching looks through every word in the online Help to find 
matches, rather than searching just the index list. 
 

 When the search is completed, a list of topics is displayed with the 
number of times the word or phase occurs in the topic.  
 

 
Basic rules for full-text searches 
 
The basic rules for formulating queries are: 

o Searches are not case-sensitive, so the Operator may type 
search terms in uppercase or lowercase characters. 

o Search using any combination of letters (a-z) and numbers (0-9).
o Punctuation marks such as the period, colon, semicolon, 

comma, and hyphen are ignored during a search. 
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CHAPTER 3: All about COGs 
What are COGs? 
  

A DMI-Services Collaborative Operations Group (COG) is a group of 
Operators who need to coordinate actions, communicate, and 
exchange disaster management information in a collaborative 
environment.  A COG can consist of any number of Operators from 
multiple organizations who need to work together to respond to an 
Incident.   

  
Examples of organizations that may form a COG include: 

  
- An entire state or county Emergency 
Management (EM) Office 
 
- Federal agencies 
 
- Divisions of an EM Organization 
 
- A public or private consulting 
organization that participates in 
Consequence Management 
 
- Any combination of the organizations 
mentioned above 

 DMI-Services functionality, exercised through COGs, supports and 
supplements existing emergency management organizations, 
relationships, policies, and procedures. 
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How do COGs Work? 
 DMI-Services (DMI-SERVICES   ) are a configurable set of tools that 

enables information to be shared throughout the professional 
emergency management community.  To improve communication and 
coordination during disasters, local DMI-Services  Administrators and 
Operators need to understand how DMI-SERVICES    works and 
become familiar with its options through regular use.  
A COG Administrator’s ability to assign Operator roles and privileges, 
coupled with the ability to establish multiple COG organizations, 
enables organizations involved in emergency management to 
collaborate and exchange data at a level and in an environment that 
suits their particular needs.  
When deciding how to organize one or more COGs, officials must 
determine what levels of collaboration they need on a regular basis, 
and consider how operating procedures may change in response to a 
larger-scale incident.   

 Potential variations of an organization’s approach to establishing its 
COG are as numerous and complex as the organizations that play a 
role in consequence management. DMI-Services’ flexibility in assigning 
roles and privileges will support many possible configurations.     
Organizations preparing to establish their COGs should carefully weigh 
the advantages of each approach to determine the method that best 
supports their operational requirements.   Along the way, the DMI-
Services  project team will be available for technical and functional 
support organizations in establishing their COG structure, as well as 
integrating DMI-Services ’ capabilities into their operating procedures.  

 

 
NOTE: The COG Cookbook is a significant resource to use in planning 
a COG. 
 

Does it Matter who is a Member of My COG? 
 
 Yes, it matters who is a member of a COG.  Being a member of the 

same COG enables easier and more complete collaboration based on 
assigned DMI-Services roles and permissions.  
Operators of the same COG can see data as it is being refreshed 
through the Save Command.   
To share information with a member of another COG, an Operator must 
post the information to that COG.  Also, the COG that receives the 
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posted information cannot change or edit posted information.  However, 
they can read it, respond to it, and export data from it for import into 
their own applications.  

  
For example, if the EOC Manager and another member of the same 
COG are collaborating on a map.  The two Operators can see each 
other's changes when the Save Command is selected.  In order to 
share the map with an Operator in another COG, the Operator must 
post a copy of the Incident containing the map to that COG (assuming 
the Operator has Post permission). 

 The Operator of the "receiving" COG can edit a separate layer of the 
map (the layer belonging to his/her COG) and the Operator in the 
originating COG will be able to view the markings in the working version 
of the incident.  While an Operator cannot make changes to the layer 
belonging to another COG, they can use the markup as a guide to 
make changes to the layer(s) on the map.   
 

  

 
 

Things to Keep in Mind when setting up a COG 
 
  

When setting up a COG, keep in mind which Operators need to 
collaborate and how often.  COGs can use DMI-Services to 
communicate in two ways: internal collaboration and external sharing. 
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Internal Collaboration:  COG members can collaborate internally with 
their working group.  That is, COG members with appropriate 
permissions work in a shared environment where changes are seen by 
everyone with the appropriate permissions in the COG as the data is 
refreshed (which is when an Operator saves their changes). 

 External Sharing:  When COGs have a need to communicate 
externally, they can “post” information.  Only the COGs that they select 
during the post process can view the information.  COGs that receive 
posted information cannot change or edit posted information.  However, 
they can read it, respond to it, and export data from it for import into 
their own applications.   

 

When starting a COG, it may be helpful to train a small “core” of users 
to assist the Administrator. 
Install DMI-Services at a few selected locations and conduct small 
table-top exercises using current processes and one (1) central DMI-
Services Operator. 
As time goes on, add Operator privileges as comfort levels allow. 
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CHAPTER 4: Administration 
This chapter shows how the COG Administrator may do the following:  add and delete, 
Operators, assign roles and privileges, reset Operator passwords, and designate 
specific Operators as Points of Contact for their COG.  In addition, the Operator portion 
of the chapter shows the following:  how to set Desktop Settings, how to set DMI-
Services Messenger to launch at start-up, how to specify a Time Zone, and how to 
select the Desktop Environment.  
 

Administrator 

 

 
NOTE:  New Operator IDs and passwords do not immediately become 
active.  Try the new ID and password about 5 minutes after the profile 
was created.   If they are not active after 10 minutes, please notify the 
DMI-Services Help Desk at 1-800-451-2647. 

 
To add a new user: 
1. Select DMI-Services ► Administration ► Operator Profile. 

The Operator Profile screen is displayed. 
 

 
 

  
2. Click the New button or select New from the File menu. 

  
3. Enter the name and address of the new Operator in the appropriate 

fields. 
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4. Assign an Operator ID. The Operator ID should conform to the 

standards set by the organization. 
 

  
5. Assign a password that conforms to the strong password guidelines 

established below:  
 

Passwords: 
o Should be changed at least every 90 days. 
o Must be a minimum of 9 characters and a maximum of 20 

characters. 
o Must have at least one uppercase character. 
o Must have at least one number (0-9). 
o Must have at least one special character. 
o Cannot consist solely of periods, spaces or the @ sign. 
o Cannot begin or end with a period or space. 

 
Example: Jomyrg1%n 
 
The following special characters can be used: 
 
! $ % & ‘ 
( ) * - . 
/ : = ? @ 
[ ] ^ _ ` 
{ } | ~ space 

 
The following special characters cannot be used: 
 

A 
leading 
space 

A 
trailing 
space 

# , +

“ \ < > ; 
 

 
  

6. Click the Add button to enter contact information, such as telephone 
number or FAX number, in the Contact Information table.  Specify 
the type of number (such as home telephone, FAX, pager, etc.) in 
the Type column and enter the number in the Value column. 
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To remove a contact entry, select the entry in the Contact 
Information table and click the Remove button. 
 

  
Assign privileges to the Operator.   For more information on setting 
privileges, see Assigning Roles and Privileges 
 

 7. To enable the Operator to view sensitive data in the TIE application, 
select the Sensitive Data Access checkbox for TIE. 
 

 NOTE:  When an Administrator posts "Restricted Viewing" incidents to 
a destination COG, the DMI-Services System enables all Operators in 
the destination COG that have the Sensitive Data Access privilege to 
view these incidents.  

 
 8. Make the Operator a point of contact for the COG by selecting the 

Display as COG Point-of-Contact checkbox. 
 

 
 
There may be multiple POCs for a COG.  To view the list of POCs, 
use the COG Profile screen. 

 9. Activate the Operator by selecting the Operator Activated 
checkbox. 

 
  

NOTE: Remember, only after Operators have been activated can they 
access DMI-Services  
 

 
10. Save the new user profile by clicking the Save button. 
 

 11. Close the Operator Profile screen by selecting Exit from the File 
menu or by clicking the Close button. 
 

Deleting (Deactivating) Operators 
 
  

To remove an Operator's ability to access DMI-Services, deactivate his 
or her Operator Profile.  . 
 
1. Go to DMI-Services menu → select Administration menu → 

Operator Profile → next the Operator Profile screen opens → select 
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Operator name to be deactivated. 
2. To deactivate the Operator, select the Delete from the File drop-

down menu or click on the Delete toolbar button. 
 

 
 

 
3. Select Save from the File menu or click the Save menu button. 
 

 The Administrator's Operator Profile screen enables him/her to filter 
Operators.   
To filter the list of Operators: 
1. Select the appropriate radio button (All, Active, or Inactive); 
2. Click the Refresh button. 
The filtered list of COG Operators will display along the left-hand pane. 
The All filter will show ALL Operators in the COG (Active and Inactive); 
The Active radio button will display only Active COG Operators. 
The Inactive radio button will display only Inactive COG Operators. 
 

Assigning Roles and Privileges 
 
  

When adding a new DMI-Services Operator to DMI-Services, 
remember that roles for TIE are set at the "panel," or sub-application 
level. This capability can help balance the need for security with the 
need to allow Operators access to do their work.   
For example, it is possible to set roles so that an Operator can have 
update privileges for Casualty information, but not have the privilege 
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to view Medical information.  To do this, make sure the Operator is an 
Update Operator for the TIE application.  Make them an Update 
Operator for the Casualty Information screen and leave them as a 
Null Operator for the Medical Information screen. 
 

 

 
NOTE:  When adding an Operator to DMI-Services, all of the 
Operator's roles are initially set to null.  The Administrator must 
specifically enable the Operator to view anything in DMI-Services. 
 

 

  
The roles that can be assigned are as follows: 

o Administrator 
o Primary Operator 
o Update Operator 
o View Operator 
o Null Operator 

 

The only difference between Primary Operators and Update Operators 
is that a Primary Operator may Post Incidents and/or Alerts; However, 
both are allowed to plot both Alerts and Incident to the NSM and/or My 
Map. 
 
Remember:  The roles and privileges that are assigned to Operators 
determine how they can function in their COG.   

 
To assign a role to an Operator: 
1. Make sure that the correct Operator is selected in the list of 

Operators in the left pane. 
2. Scroll down to the appropriate application in the List Box. 
3. Select the appropriate radio button for the desired role for that 

specific sub-application (if appropriate and available). 
4. Click the Save menu button. 
The Roles/Privileges list is much like a tree view.  The Administrator 
must assign the role to the higher application level before selecting 
roles at the lower level. 
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Resetting Operator Passwords 
 
  

An Administrator can reset an Operator's password using the Operator 
Profile screen.  This feature can be helpful for times when Operators 
forget their passwords and cannot log into DMI-Services. 
 

  
1. To access the Operator Profile screen, select Operator Profile 

from the Administration menu, located in the DMI-Services menu. 
  

The Operator Profile screen appears. 
 

 2. Select the name of the Operator whose password will be changed. 
 
3. To reset the password, click the Reset Password button. 

 
  

The Reset Password screen opens. 

 
 4. Enter a new password in the New Password field. The password 

must conform to the strong password guidelines.  
 5. Enter the new password again in the Confirm Password field. 

6. Click the OK button.  (If the Cancel button is pressed, the password 
change will be cancelled.) 

 
7. Click the Save button (or select Save from the File menu). 
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Using the Operator Profile Screen 
  COG Administrators can view profiles of all Operators in their COG.   

COG Administrators can change the passwords of ALL Operators 
within their COG.  This can be useful if an Operator forgets their 
password and cannot access DMI-Services. 

 1. Select Operator Profile from the Administration menu, located in 
the DMI-Services menu. 

 2. Select the name of an Operator whose profile needs to be modified. 
To switch Operator Profiles, select the name of another Operator 
from the list. The Operator Profile screen is displayed again -- this 
time with the newly-selected Operator's data in the fields. 

 3. Modify the data as appropriate in the fields provided.  If necessary, 
change the Operator's password. 

 
NOTE:  Once logged into DMI-Services, an Operator can change 
his/her own password. 

 4. If the Operator will be a point of contact for the COG, select the 
Display as COG Point-Of-Contact checkbox.  When this option is 
selected, the Operator's name is added to the list on the COG 
Profile screen. 

 
 5. If the Administrator moves the cursor to another Operator's Profile 

without saving changes, the Confirm Operator Selection screen 
opens.   

 6. Click yes to disregard completed changes.  Click No to save 
completed changes. 

 
7. Select Save from the File drop-down menu or click the Save button.
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Using the COG Profile Screen 
 COG Administrators have the ability to maintain the COG Profile 

screen, which displays general information about the COG and a list 
of points of contact for the COG. Operators can view the COG Profile 
screen, but the text is in a non-editable format. 

  
1.  Select the DMI-Services  menu → Administration → COG 

Profile  
 

  
The COG Profile screen opens. 

 
  

 
 2. Enter information in the fields as necessary. 

o The COG Type describes the type of COG, such as Local, 
Federal, State, etc. 

o The Organization is the name of the COG Administrator's 
organization. 

o The COG Name is the unique name of the COG. 
o The Description field is used to contain free text about the 

COG.  The field can hold up to 2000 characters. 
The Address information is the address for the COG Administrator. 

  
The lower part of the COG Profile screen is much like a Tree View. 
 The names of the points of contact for the COG are listed with their 
telephone numbers underneath. 
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The information for the points of contact comes from the Operator 
Profile screen.  COG Administrators can edit this information by using 
the Operator Profile screen.    

 3. Click the Save menu button. 

 

 
NOTE: It is extremely important to keep each COG Profile up to date. 
 This contact information is used by DMI-Services to keep COG 
Administrators informed about the latest DMI-Services release or 
other important information regarding system status. 

Generating Administrative Reports 
 
  

COG Administrators can generate the following Administrative Reports: 
o The Operator Detail report shows the details of one Operator; 
o The Operator List report lists all Operators in a given COG; and 
o The COG List report is a list of all COGs in DMI-Services.   
 

 

 
For more information about the Report List Filter, see reports can be 
filtered. 

 To generate an Administrative Report, complete the following steps: 
1. Select DMI-Services  → Administration → Profile  

 2. To generate an Operator Profile report, select the Operator from 
the Operator Profile List, located in the left pane of the Operator 
Profile screen. 

 3. From the menu: select DMI-Services  → Administration  → 
Reports  

 4. The Reports screen opens. 
 5. Select the type of report to be produced.   
 6. To generate the report, click the Generate Button.  (To cancel 

the report, click the Close button.) 
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Operator 
 
The Operator portion of this chapter shows the following: how to set Desktop Settings, 
how to set DMI-SERVICES    Messenger to launch at start-up, how to specify a Time 
Zone and how to select the Desktop Environment, how an Operator adds and removes 
access to his/her COGs using the COG Configuration Tool, and view and modify their 
contact information in their Operator Profile and changing their password. 
 

Using the DMI-Services Desktop Settings Screen 
  

The DMI-Services Desktop Settings screen enables Administrators 
and Operators to select start up, time zone, and desktop options for 
each workstation.   
 

  
To Access the DMI-Services  Desktop Setting Screen: 
 

 1. Select Settings from the Administration menu, which is located in 
the DMI-Services menu. 
 

 The DMI-Services Desktop Setting screen opens. 
  

 
 

 Use the Start Up tab to have DMI-Services Messenger and Quick 
Start to start up automatically at the beginning of each session. 
 

 Use the Time Zone tab to select the appropriate time zone for a 
workstation.   
 

 Use the Desktop tab to select the type of graphical user interface 
(GUI) environment to be used.  
 

 Use the Network tab to configure outbound proxy information for a 
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workstation. 
 

Automatically Launching DMI-Services Messenger at Startup 
 
 DMI-Services Messenger must be running for an Operator to be invited 

into a DMI-Services Messenger session.  Therefore, it may be helpful to 
select the option to Automatically Launch DMI-Services Messenger 
on Start Up.  Use the Start Up tab to set the preference for launching 
DMI-SERVICES    Messenger. 

 
To Automatically Launch DMI-SERVICES    Messenger at Start 
Up: 
 

 1. Select Settings from the Administration menu, located in the DMI-
Services menu. 

2. If necessary, click the Start Up tab to make the tab active. 
3. Ensure the Automatically Launch DMI-SERVICES    Messenger 

at Start Up checkbox is selected. 
4. Click the Save menu button and then click the close box in the upper 

right-hand corner of the screen to close the Desktop Settings 
screen. 

 

Specifying a Time Zone 
 Select a Time Zone to ensure that all times are displayed correctly in 

DMI-Services. 
  

To specify a Time Zone: 
 

 1. Select Settings from the Administration menu, located in the DMI-
Services drop-down menu. 

  
The DMI-Services Desktop Settings screen opens. 

 
 2. Click the Time Zone tab to make the tab active. 
 3. Select the appropriate time zone from the drop-down box. 
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 4. Click the Save menu button and then click the close box in the upper 
right-hand corner of the Desktop Settings screen. 

 

 
NOTE: Set the workstation's Operating System Time Zone to the same 
setting as the DMI-SERVICES    Time Zone to ensure consistency in 
timestamps. 

Selecting the Desktop Environment 
 
 Use the Desktop option on the DMI-Services Desktop Settings 

screen to specify how the DMI-Services graphical user interface (GUI) 
is displayed.  These settings affect only the GUI on that particular 
workstation; GUI settings do not in any way affect the operational 
capability of DMI-Services. 

  

 
 

 1. To display text in toolbar button, select the Display text on toolbar 
buttons checkbox. 

 2. To enable sounds (sound files for use with DMI-SERVICES    
Messenger), select the Enable Sounds checkbox. 

 3. To determine the Look and Feel for screens within DMI-Services, 
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choose the radio button for DMI-Services or Windows. 
 4. To change the color of all tables in DMI-Services, click the Choose 

Table Color button to display a color palette.   
  

 
 5. Select the color and click the OK button to return to the DMI-

Services Desktop Settings screen. 
 6. Click the Save button. 

 
 

To Return the Color of Table to the Default Color:   
 

 1. Click the Reset button in the color palette screen. 
 2. Click the OK button to return to the DMI-Services Desktop 

Settings screen. 
 3.  Click the Save button. 
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Using the COG Configuration Screen 
  

During installation the use the COG Configuration Tool to select one or 
more COGs.  To add additional COGs, use the COG Configuration 
menu from the Administration menu. 
 
1. Administration menu → COG Configuration → DMI-Services 

menu.   
  

The COG Configuration screen opens. 

 
 

 2. Select the desired COG from the All COGs column. 
3. Click the Add button. 

  
The new COG name will display in the COG list on the login screen. 

 



Page 40 of 220 

 

Removing COGs from the COG Configuration List 
 
  

To remove a COG from the Login screen: 
 
1. Administration menu → COG Configuration → DMI-

Services menu.   
  

The COG Configuration screen opens. 
 

 2. Select the COG from the Available COGs column.  
 3. Click the Remove button. 
  

The COG no longer appears in the COG list on the log in screen. 

 
 

4.   Click the Save button. 

Viewing Your Operator Profile 
 

 

Operators can view only their own profiles and cannot see the profiles 
of other Operators.  Operators can change their own passwords.  
NOTE: Only COG Administrators can reset permissions.  If an 
Operator forgets his/her password and cannot access DMI-Services, 
the COG Administrator to reset the password. 

 Open an Operator Profile: Administration menu → DMI-Services 
menu → Operator Profile → Operator Profile screen displays. 

 2. Edit contact information by clicking in the text fields provided.  An 
Operator can change his/her own password.  

  
3. Prior to closing the screen the Operator will be asked if they wish to 

save.  If the Operator selects YES the changes will be saved.  If the 
Operator selects NO then all changes will be lost.  The Operator 
can also select Cancel and return to the previous screen. 

 
4. Click the Save menu button or select Save from the File drop-down 

menu to save all changes. 
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An Operator can only access those DMI-Services to which the 
COG administrator has granted permission.     

 

Changing Your Password 

 

 
Remember, never give anyone else access to an account 
password. 

 To change a password, use the Operator Profile screen.   
 1. To access the Operator Profile screen, select DMI-Services ► 

Administration ► Operator Profile. 
The Operator Profile screen displays. 

 2. Click the Change Password button. 
  

The Change Password screen opens. 
 

 3. Enter the old password in the Old Password field. 
4. Enter a new password in the New Password field.  The new 

password must conform to the strong password guidelines.  
 

 5. Enter the new password again in the Confirm Password field. 

 

NOTE:  The new password may not become active immediately.  If the 
new password is not active after ten (10) minutes, please notify the 
DMI-Services Help Desk at 1-800-451-2647. 

 6. Click the OK button to make the change.  Click the Cancel button 
to close the screen without making the changes. 

7. If the Operator enters the incorrect password, the Invalid Field 
screen will display.  Click OK to close the screen and return to the 
Change Password screen. 
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CHAPTER 5: Tactical Information Exchange 
What is TIE? 
 TIE is the Tactical Information Exchange portion of DMI-Services.  TIE 

is made up of two major parts:  Incident Information and Specific Needs 
Requests.  The Incident Information component enables Operators to 
share information about an Incident, including maps, sheltering 
information, weather, etc.  Specific Needs Request provides a means of 
communicating needs for resources (personnel, supplies, etc.) and of 
replying to the requests that are made. 

 TIE provides broadly accessible capabilities for exchange of information 
within and between emergency management organizations.  Those 
already using situation reporting software (such as Computer-Aided 
Management of Emergency Operations -- CAMEO), as well as those 
using the TIE application from DMI-Services , are able to rapidly develop 
and exchange Incident Information with other DMI-Services  Operators.  

 DMI-Services provide Operators with an enhanced ability to present a 
common operating picture and to improve the overall level of situational 
awareness of incident conditions.  DMI-Services include tools to expedite 
information exchange about mutual aid, state and Federal assistance, and 
cascading consequences.   

Working with Incidents 
 
This section will provide the operator the steps necessary for navigating the Incidents 
List to include filtering and archiving. 

Using the Incident List 
 The Incident List table in the middle of the screen displays the active 

Incidents for that COG.   
DMI-Services  retrieves and displays an updated Incident List when an 
Operator:  
o Creates a new incident  
o Modifies an incident 
o Posts an incident 
o Archives an incident 
o Filters the Incident List by any criteria 
o Sorts the Incident List by any of the fields 
o Clicks on the Refresh button.   
Each entry or row in the Incident List displays data in the following 
fields:  
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o Status/Attachments Icon 
o Specific Needs Request 
o Version 
o Number 
o Name 
o Category 
o Type 
o Date, and  
o Description.   

 
 

To open an Incident: 
o Double-click on the Incident; or single-click on the Incident and click 

the Open Incident menu button; or  
o Single-click on the Incident and select Open Incident from the File 

drop-down menu. 
 

 

 The Map Symbols  on the Incident List indicate the status (working vs. 
posted) of the Incident and indicate if the Incident contains any 
attachments or Specific Needs Requests. 

 

NOTE: Version 0 of an active incident is also known as the "working 
version" because only Version 0 can be edited.  
 
When Version 0 is modified and posted to a COG or COGs, that 
posted version is numbered Version 1.  
Subsequent edits to the working version (Version 0) that are posted 
become Versions 2, 3, 4, etc. when posted.  The version number is 
determined by the number of times the altered incident is posted. 
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 The Posted to table displays the names of the COGs to whom the 
selected incident has been posted.    For more information about 
posting Incidents, see posted incident  

 

 
 The Sites table displays the name and address of the sites associated 

with the selected Incident. 
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Fields on the Incident List screen: 
Field: Description: 

Filter Options:  
 

Number Filters the list for specific Incident Numbers. 
 Type in the desired number. 

Name Filters the list for specific Incident Names.  Type 
in the desired name. 

Category Filters the list for specific Categories.  Values can 
include:  Actual, Planning, Training, Exercise 

Type Filters the list for specific Incident Types.  Values 
can include:  Chemical, Biological, Radiological, 
Nuclear, Explosive, Other 

Severity Filters the list for specific types of Severity. 
 

Incident List:  
 

Icon Status Displays the appropriate icon for the status of 
that specific incident. See icons. 

SNR Icon Displays SNR Icon if a Specific Needs Request 
has been created and/or posted. 

Version Displays the version number for the Incident. 
Number Displays the Incident Number. 
Name Displays the Incident Name. 
Category Displays the Incident Category.  Valid values are: 

 Actual, Planning, Training, and Exercise. 
Type Displays the Incident Type.  Valid Values are: 

 Chemical, Biological, Radiological, Nuclear, 
Explosive, And Other. 

Date Displays the date of the Incident. 
Last Update/ 
Post Date 

Displays the date of the last update or the date 
the incident was posted. 

Description Displays a short description of the Incident. 
Phase Displays the incident's phase. Valid values are: 

Closed, Investigation, Mitigation, Recovery, and 
Response. 

Notification 
Level 

Displays the notification level of the incident. 
Values are Activation, Advisory, Alert, 
Cancellation, National and Warning. 

Status Displays the current status of the incident. Values 
are: Unknown, Archived, Closed, Improving, 
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Under Control, and Worsening. 
Severity Displays the severity of the incident. Values are: 

Minor, Major, Emergency, Catastrophic, And 
Cataclysmic. 

General Comments Displays any comments that have been entered 
regarding the incident. 
 

Posted To:  
 

COG ID Displays the ID of the COG the Incident has been 
posted to. 

COG Name Displays the Name of the COG(s) the Incident 
was posted to. 

Date Received Displays the date the COG received the posting. 
 

Sites:  
 

Name Displays the name of the Site associated with the 
currently selected Incident. 

Address 1 Displays the address of the Site associated with 
the currently selected Incident. 

Address 2 Displays the address of the Site associated with 
the currently selected Incident. 

City Displays the city of the Site associated with the 
currently selected Incident. 

State Displays the state of the Site associated with the 
currently selected Incident. 

Country Displays the Country of the Site associated with 
the currently selected Incident. 

Postal Code  Displays the Postal Code of the Site associated 
with the currently selected Incident. 

Description Displays a short description of the Site 
associated with the currently selected Incident. 

Latitude Displays the latitude of the Site in Degrees, 
Minutes, and Seconds.  Positive values represent 
latitudes above the Equator; negative values 
represent latitudes below the Equator. 

Longitude Displays the longitude of the Site in Degrees, 
Minutes, and Seconds. Positive values represent 
longitudes East of the Prime Meridian. Negative 
values represent longitudes West of the Prime 
Meridian. 

Cross Streets Displays the street names of Roads that intersect 
the street where the incident occurred. 
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Filtering the Incident List 
 Since the Incident List displays all incidents created by, posted from, 

and posted to a COG, the Incident List could become quite long. 
 
To quickly find a specific incident, filter the list to display only incidents 
that meet desired criteria. Criteria are specified through the Filter 
Options portion of the Incident List screen.   

 Filter options are displayed across the top of the Incident List.  The 
filter options (Number, Name, Category, Type, and Severity) are 
shown as drop-down lists that allow the Operator to select a condition. 
 

 

 The Number and Name drop-down lists are text fields in which the 
Operator may type a specific number or word, respectively.  
 
To filter on Number or Name: 
1. Type a number or word in the Number or Name drop-down text 

box. 
The number or word is displayed in the input box. 
2. Click on the Filter button. 
Incidents matching the number or word are displayed in the List Box.  

 The drop-down list box recalls any criteria previously entered.  
To re-use the same criteria: 
1. Open the appropriate drop-down list. 
2. Navigate to the appropriate number or word; and 
3. Click on the Filter button. 
Incidents matching the criteria are displayed in the List Box.  

 The Category drop-down list contains the following options: 
o Not Assigned  
o Actual  
o Planning  
o Training  
o Exercise 
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 The Type drop-down list contains the following options: 
o Explosion-Chemical (A sudden release of mechanical or 

chemical energy in a violent manner, usually with the generation 
of high temperature and the release of non-toxic gases.) 

o Explosion-Nuclear (The explosive release of alpha, beta, 
and/or gamma particles secondary to a thermonuclear chain 
reaction.) 

o Fire-Rural (A conflagration that results in uncontrolled 
destruction of forests, brush, field crops and grasslands caused 
by nature or humans.) 

o Fire-Urban (A conflagration that occurs primarily in cities or 
towns with the potential to rapidly spread to adjoining 
structures.) 

o Geological-Avalanche (A mass of sliding snow, ice, earth, and 
rock that grows and collects additional material as it descends.) 

o Geological-Earthquake (The shaking of the ground caused by 
an abrupt shift of rock along a fracture in the earth, called a 
fault.) 

o Geological-Flood (An inundation of dry land with water. Types 
of floods in Washington State are primarily river, surface water, 
flash, and tidal.) 

o Geological-Mud/Landslide (The sliding movement of masses 
of loosened rock and soil down a hillside or slope.) 

o Geological-Volcanic Eruption (The occurrence of a discharge, 
usually violent, of molten lava and gases from a fissure in the 
earth's crust.) 

o HAZMAT-Biological (A release of biological material [e.g., 
virus, bacterium] capable of posing a substantial risk to health 
and safety.  The onset of symptoms usually requires days to 
weeks.) 

o HAZMAT-Chemical (A release of a toxic industrial chemical or 
weapon zed agent that can present extreme hazards to health, 
safety, and property.) 

o HAZMAT-Industrial Material (A release of a material [during its 
manufacture, use, storage, or transportation] which is capable of 
posing a substantial risk to health, safety, and property.) 

o HAZMAT-Radiological (The release of alpha, beta, and/or 
gamma particles from a radioactive source.) 

o Maritime-Iceberg (A large piece of ice that has that has broken 
off from a glacier or ice shelf and is floating in open water.) 

o Maritime-Tsunami/Tidal Wave (A series of traveling ocean 
waves of long length generated by earthquakes, volcanic 
eruptions, and landslides occurring below the ocean floor.) 
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o Not Assigned (No Incident Type Assigned) 
o Other-Cyber (Using a computer and the Internet to disrupt 

operations with malevolent programs or false information.) 
o Other-Not Assigned (Any incident that is not on the current list 

of Incident types.) 
o Other-Refugee Event (An exodus of people fleeing from home 

or country.) 
o Transportation-Aircraft (A crash or other disaster primarily 

involving aircraft; e.g., plane, helicopter, space shuttle, dirigible.) 
o Transportation-Land Vehicle (A crash or other disaster 

primarily involving vehicles that travel the land; e.g., multi-car 
accident.) 

o Transportation-Rail (A crash or other disaster primarily 
involving the railroad; e.g., train wreck.) 

o Transportation-Ship/Boat (A crash or other disaster primarily 
involving craft that navigate the oceans or rivers; e.g., ship 
collision, river barge grounding.) 

o Weather-Heat Incident (A period of excessively hot weather, 
relative to the usual weather in the area, causing consequences 
to humans or critical infrastructure.) 

o Weather-Hurricane/Typhoon (A type of low-pressure system 
accompanied by thunderstorms & a circulation of winds near the 
Earth’s surface - clockwise in the Southern hemisphere; 
counter-clockwise in the Northern hemisphere.) 

o Weather-Summer Storm (An atmospheric disturbance with 
consequences manifested by rain, wind, or lightning.) 

o Weather-Tornado (A localized violently destructive windstorm 
occurring over land and characterized by a long funnel-shaped 
cloud that extends to the ground.) 

o Weather-Winter Storm (An atmospheric disturbance with 
consequences manifested by snow, ice, freezing rain, or sleet.) 

 The Severity drop-down list contains the following conditions: 
o Unknown  
o Emergency  
o Minor  
o Major  
o Catastrophic  
o Cataclysmic 
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An Operator can select criteria from more than one of the filtering 
drop-down lists to further filter the list.  However, remember that 
the target incident must satisfy ALL of the criteria.  It is possible 
to over-filter the list and omit the incident being sought, 
especially if the Operator is unsure about one of the criteria. 

 For example, to filter the list to display only the Incidents of the type 
Biological, select Biological from the Type drop-down menu and click 
the Filter button. 

 

 To un-filter the list: 
1. Highlight the text displayed in the drop-down list. 
2. Delete the text; and  
3. Click the Filter button. 

Incident List Icons 
 
 The icons on the Incident List indicate the status (working vs. posted) of 

the Incident and indicate if the Incident contains any attachments. 

 

Icon Description 
 Working Incident 
 Posted Incident (can also 

have an Attachment) 
 Working Incident with 

Attachment 
 Incident Posted from another 

COG 
 Incident Posted from another 

COG with an Attachment 
 Incident has Specific Needs 

Requests associated with it. 
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Creating New Incidents 

 

Primary Operators and Update Operators are able to create new 
Incidents.  Operators may confirm their permissions by reviewing their 
operator profile.  

 To create a new Incident from within TIE: 
1. From the Tool Bar click "NEW" or Select New from the File drop-

down menu or use the Hot Key incur + N (hold down the Ctrl key 
and then press the N key). 

 The Incident Information panel of a New Incident displays. 

 2. Enter the core incident information as appropriate.  For more 
information on entering the information on the panel, see Entering 
Core Incident Information.    

 

NOTE: The Core Incident Information panel required fields are: 
Incident Number, Incident Name, Incident Type, Date & Time of 
Incident; and Description.  The Operator must complete all required 
fields in order to save the data.  In addition, the plot to map checkbox 
must select for the incident to be plotted to the National Summary Map. 

 

 
Make a habit of saving data as each panel is completed. This practice 
ensures changes are shared with others in the COG and will prevent 
loss of data if power is lost. 

 3. Exit from the Incident by clicking the Close button or select Close 
from the File drop-down menu. 
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Viewing Incident Information 
 To view an Incident: 

1. Retrieve the Incident List; 
2. Select the desired incident from the Incident Information table in 

the center of the screen.   

 3. To open an Incident: 
o Double-click on the Incident; or 
o Single-click on the Incident and click the Open Incident menu 

button; or  
o Single-click on the Incident and select Open Incident from the 

File drop-down menu. 
 

 The Incident Information screen opens.   

 4. Use the tree view to navigate through the screens for the Incident. 
 Only Operators who can view a panel can access it. 

 

 
If an Operator has edit privileges, they can use the Edit button at this 
time to make changes.  For more information about editing, see 
Modifying Incidents. 

 5. To exit from the Incident, either click the Close button or select 
Close from the File drop-down menu. 

 

NOTE: To generate an Alert from within an open Incident Record, simply 

press the Alert toolbar button . A new Alert screen will be 
generated and displayed. 

 



Page 53 of 220 

 

Modifying Incident Information 

 

Primary Operators and Update Operators have the ability to edit 
Incidents.  
When an incident is first opened, it is in "read only" mode.  To edit 
the incident, the Operator must click the Edit Data button to enable 
editing.   Once editing is enabled, the incident will stay in edit mode 
until they either closes the Incident or clicks the Edit Data button 
again to turn off editing. 

 1. Retrieve the Incident List. 

 2. Open the Incident. 

 3. Enable Edit mode.   

 4. Make all appropriate changes.  

 

NOTE: To save the incident to the National Summary Map, select the 
plot the incident to the National Summary Map located in the address 
pane of the Site Information Panel.  
 

 

5. Save the incident. 

 6. Exit from the Incident. 

 

If an Operator closes an incident without saving changes, a message 
will display asking if they want to save changes before closing. 

Using the Attach Screen Controls 
 
 The Attach screen offers controls to assist the Operator in finding files to 

attach to the Incident.  The controls on the Attach screen consist of 
buttons, drop-down menus and tree views. 
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 Use Up one Level to move up one level in the folder structure.  Use 

Home to go to the Desktop.  Use List to display the files in a list without 
details.  Use Details to display the files in a list with details. 

 Also, use the drop-down list at the bottom of the screen to filter the list by 
file type.  In this example, the Operator has chosen to list only those files 
with the .jpg extension. 

 

Viewing Attached Files – Place before Attaching Files section 
 

 
This feature enables an Operator to view files that other Operators 
have created regarding an incident.  Select files from the Attach 
screen for viewing.    

 

NOTE: In order to view files there must be an application installed on 
the PC that can open and read that type of file.  For example, to view a 
Microsoft Word file (*.doc), then the file can be opened by the Microsoft 
Word application. 

 1. To view an attached file, select the file name of the file from the 
TIE-Incident Attachments screen. 

 
2. Click the View button. 

 DMI-Services launches the application necessary to open the file and 
displays the file in the new window. 
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DMI-Services uses the program associated with the file extension.  So, 
if an Operator has changed default settings in Windows Explorer, then 
DMI-Services will use what is specified as the default application.  For 
example, if the new default setting for ".txt" files is MS Word, then DMI-
Services will open the file in MS Word.  

 3. To return to DMI-Services, close the external application. 

Attaching Files to Incidents 
 
 From any panel, an Operator can attach files to an Incident. 
 1. Retrieve the Incident list and open the Incident Information Form. 

 2. From the Incident Information panel, click the Attach icon or select 
Attach from the File drop-down menu. 

 The Attachments screen opens. 

 3. Click the Add button. 

 The Attach screen opens. 

 4. Select the file to be attached.  For more information on using the 
controls to browse for files, see using the Attach Screen Controls. 

 5. Click Attach.  The name of the file will appear in the list of the TIE-
Incident Attachments screen. 

Removing Attached Files  
 
 It may become necessary to remove an attached file. 
 1. To remove an attachment, select the file name of the file from the 

TIE-Incident Attachments screen. 

 
2. Click the Delete button. 

 3. Click the Yes button to remove the attachment from the Incident. (If 
the Operator clicks No, they will cancel the removal process.) 

 

Using the Contact Information Screen 
 The Contact Information screen enables organizations to add a table of 

contact information to be associated with an incident’s Site Information, 
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Medical Facility, or the Designated Shelters portion of the Population 
Actions panel.  
Prior to adding Contact Information, the Operator has: 
1. Opened an incident; and 
2. Is editing one of the following panels: 

o Site Information panel,  
o Medical Facility information panel, or  
o The Designated Shelters portion of the Population Actions panel. 

 To add Contact information: 
1. Select the row for which contact information is being created or 

modified. 

 2. Click the Contacts button. 

 The Contact Information screen opens.    

 1. Enter contact information as appropriate. 

 
4. Click the Save button or select Save from the File drop-down menu. 

 5. Click the Close button to close the screen. 

Most Recently Used (MRU) List 
 
 The Most Recently Used (MRU) List provides convenient and easy 

access to the Operator's four (4) most recent Incident Records and 
Alerts.  The MRU List changes as a result of Operator activity. 

 To use the MRU List: 
1. Select the File drop-down menu to display the MRU List.  
The MRU List displays the four most recently Incidents or Alerts 
showing the most recent item first. 
2. Click on the desired Incident or Alert from the MRU List. 
The selected Incident or Alert displays on the screen for viewing 
and/or editing. 
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NOTE: The MRU List works in offline mode as well. 

Using the Edit Address Button 
 
 Use the Edit Address button to access the Address data entry screen. 

 

NOTE: The Address screen can only be access from one of the 
following panels: Site Information, Population Actions, Medical Facility, or 
the Details portion of the Property Damage panel. 

 2. Retrieve the Incident list and open the Incident Information 
panel of the selected incident. 

 2. From the Actions menu, select Edit Address.  Or, click the Edit 
Address icon on the tool bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Address screen opens: 
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 3. Enter or edit the information as appropriate. 
4. Click OK to close the screen or click Cancel to cancel the changes. 

 
5. Click the Save icon or select save from the File drop-down menu to 

save the address changes to the Incident. 
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Importing Quick Pick Data 
 
 As many first responders track locations of incident sites, medical 

facilities, and shelters in databases, DMI-Services  offers the ability for 
COG Administrators to import this Quick Pick data and store it for 
future use. Quick Pick Data must be imported as a comma separated 
values (*.CSV) file. 

 

NOTE: To import Quick Pick data, the Administrator must be logged 
into DMI-Services and working within an active Incident Record. 

 1. From the File drop-down menu, select Import ...   
The DMI-SERVICES    Import Tool screen displays. 

2. Click the Open ... button. 
The file selection screen displays. 

3. Navigate to and select the appropriate *.CSV file to be imported 
and click the Open button. 
DMI-Services  imports the data into the DMI-SERVICES    Import 
Tool and displays the screen as follows: 

 
 

4. Select the Import Type (Medical Facilities, Shelter Facilities, 
Weather Facilities, or Incident Sites). 

 5. Select target field name for each column, as appropriate (SKIP, 
Name, Description, Address Line 1, Address Line 2, City, State, 
Postal Code, Country, Cross Streets, Latitude, Longitude). 
Select SKIP to indicate that DMI-SERVICES    should skip that 
column of data when the import is performed. 
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 NOTE: ALL data columns are designated as Select Target by 

default. The COG Operator must select a field name for at least 
one column of data. If all column field names remain as Select 
Target, then DMI-Services will SKIP all data -- and no data will be 
imported. 

6. Click the OK button to import the data (or click the Cancel button to 
cancel the import). 
DMI-Services imports and saves the file data to the end of the 
existing database for that type of information. 

Using the Quick Pick Screen 
 
 Since address information can apply to more than one incident, DMI-

Services offers a Quick Pick screen enables COGs to store addresses 
for future use. 

 NOTE: The Quick Pick screen can only be accessed from an active 
Incident. 

 1. Retrieve the Incident List and open Incident. 

 
2.   From the Actions drop-down menu, select Quick Pick or click the 
Quick Pick button. 

 The Quick Pick Data Tool screen opens. 



Page 61 of 220 

 
 3. Select the appropriate category from the Select Data Category drop-

down menu to filter the list for a specific category.   
The categories are:  
o Incident Sites 
o Medical Facilities  
o Property Damage Sites  
o Shelter Facilities  
o Weather Facilities. 

4. Select the site from the list. 
5. Click the OK button to select the entry. The selected information 

displays in the appropriate incident panel. 
 In addition to Site information, use Quick Pick to add Contact Information 

for  Incident 
Sites, Medical Facilities, or the Designated Shelters (within the 
Populations Action 
Panel). 
To add a Contact via Quick Pick: 

1. Select the appropriate panel (Site Information, Medical 
Facilities, Designated Shelters portion of the Population Actions 
panel) 

2. Select Contacts from the Actions drop-down menu or click on 
the Contacts button.  
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3. With the Contacts panel open, select Quick Pick from the 
Actions drop-down menu or click on the Quick Pick toolbar 
button.  

4. Select appropriate contacts from the Quick Pick database.  
5. Click on the OK button on the Quick Pick panel to add the 

contact.  
DMI-Services adds the contact as a new entry in the Contracts panel.  

6. Select the Save option from the File drop-down menu or click 
on the Save button in the toolbar menu. 

NOTE: To cancel the selection in the Quick Pick List, press the Cancel 
button. 

Generating Incident List Reports 
 
 Two types of Incident Reports are available from TIE: list reports and 

detail reports.    
 
List reports are generated from the Incident List screen. The available List 
Reports are: 

o Posted Incident List Report; and 
o Working Incident List Report.   

 
The Incident Detail Report is generated from within an Incident. 

 To generate a report: 
1. Retrieve the Incident List. 
2. Select Reports from the DMI-Services menu. 
3. The Reports screen opens. 
4. Select the type of report to be produced. 
5. Click ok to generate the report. (To cancel the report, click the 

Cancel button.) 
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Generating Incident Detail Reports 
 Two types of Incident Reports are available: list reports and detail 

reports.  The list reports, which are generated from the Incident List 
screen, include the Posted Incident List Report and the Working 
Incident List Report.  The Incident Detail Report is generated from 
within an Incident. 

 

When generating an Incident Detail Report, it is necessary to open 
the Map screen to load the map so that it can be included in the 
report.  Otherwise, an error message will indicate that no image 
was available for the report. 

 The list of reports can be filtered. 

 To generate a detailed report for an Incident:  
1. Be in the Incident Information panel,  
2. From the DMI-Services menu select the Reports menu option.    
3. Choose sub reports if desired.  The sub reports correspond to the 

sub-applications in TIE (such as the Site Information screen, 
Casualty Information screen, etc.). 

 1. Retrieve the Incident List and open the Incident on which the report 
will be based. 

2. Select Reports from the DMI-Services menu. 
 The Reports screen opens. 

 3. Select the report to be generated and click the OK button. 
 The Select Sub-Reports screen opens. 

 4. Select the sub-reports to be included in the report. 
5. Click OK to generate the report.  Or, click Cancel to cancel the 

report. 
6. Click the OK button.   
7. The Select Sub-Reports screen opens. 
8. Select the desired subreports to be included.  The subreports 

correspond to the forms in the Incident Information panel.  Select 
multiple subreports by pressing the Ctrl key. 

9. Click the OK button to generate the report. 

 

 
To cancel the report, click the Close button. 
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Using the Reports Filter 
 
 The Reports screens have a report filter at the top of the screen to filter 

the list of reports.  This feature is especially useful when the number of 
reports begins to grow. 

 

 
 As an Operator begins typing letters into the Search Report Type field, 

the list will be filtered to display ONLY the report name that matches the 
text entered.  (Thus, anything that does not begin with the letter being 
typed will disappear as soon as the Operator begins typing.)  
NOTE: When using the Search Report Type field, an Operator must 
enter the report name exactly as it appears in the list (or at least the 
beginning of the title as it appears in the list).    

 

If the Operator does not know the exact title of a report, they can use 
the Search by Substring text box.  The Search by Substring text box 
enables an Operator to filter the list using any word or phrase in the 
report title, regardless of where it appears in the title. 

 Each Operator has the option to make the filter text boxes case-
sensitive.  A case-sensitive filter only displays items that match the 
same case as the text entered.  However, if an Operator enters the text 
"post," the filter will not display the "Post" report.   
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 To sort the List, click the Sort list box. The sort drop-down list displays, 
presenting the Operator with the choice of Ascending or Descending. 

 

Posting Incidents 
 

 

Only Primary Operators may post an incident.  Incidents may be 
posted from either the Incident List or within the Incident 
Information form.   
When Incidents are posted to other COGs, a snapshot of the Incident is 
taken for members of the outside organizations.  This "snapshot" is not 
updated when changes are made to the working version of the Incident. 
Thus, it may be necessary to post several versions of the Incident over 
time. 
NOTE: All Operators in the receiving COG with TIE viewing privileges 
can view the posted Incident.  To restrict access to the incident, post 
the incident with the "Restricted Viewing" option selected.  Thus, only 
Operators with the Sensitive Data Access option enabled in their 
operator file will be able to view the incident.   

 To post an Incident: 

 1. Click the Post menu button or select Post.... from the File drop-
down menu. 
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The Post Incident screen opens:  

 

 

2. Select the COG(s) or Distribution List of COGs to which the Incident 
will be posted. 
 

To post to a Distribution List, locate the Distribution List by searching 
for "DL-<name of distribution list>" in the search field, then select the 
appropriate Distribution List and post as usual. 
To post to multiple COGs not in a formal Distribution List, use the 
Control key (Ctrl) to select more than one COG. 

 3. Enter any comments concerning the post in the Comments field. 

 NOTE: If the Incident is to be posted with restrictions, select the 
Restricted Viewing checkbox.   

 4. Click the OK button to post the Incident or click the Cancel 
button to cancel the post.  

5. If the Operator clicks the Cancel button, a message box will 
display asking if the Operator is sure they want to cancel posting 
the incident.  Click yes to close the screen and cancel the post 
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or click No to return to the Post Incident screen without posting. 

 

NOTE: When a COG Operator re-posts an Incident Record, the DMI-
Services System automatically re-sends any Specific Needs Requests 
(SNRs) associated with that Incident Record.  

Display or Remove an Incident from the Map in DMI-Services Web 
Tools 
 

 

Overview 
From the DMI-Services Desktop, an operator will choose to plot an 
Incident (depending on permissions) to the map located within DMI-
SERVICES    Web Tools. 
 
Within DMI-Services Web Tools, operators have access to view all of 
the content on the map.  Operators can display the National Map 
Incidents and/or their COG’s Incidents via My Map.  

National Summary Map 
Only Primary Operators have permission to plot Incidents to the 
National Map.   

My Map 
Both Primary and Update Operators have permission to plot Incidents 
to their COG via My Map. 
 
 

 From the menu bar, select Tactical Information Exchange, then 
Incident List. 

 
 
 

From the Incident list, select the Incident.  
 
*After selection of the Incident, the line will change in colors. 
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 Plotting from a Working or Posted Incident 
 
A working incident is always version 0.  This can be seen from the 
Incident List. 
 

 

 

 

 
From the incident list, a Posted Incident is recognized by its Incident 
Icon.  In addition, it will never be version 0.   
 

 

 
  

Whether you have created a new incident or opened an incident from 
the Incident List, click the Incident Information form.  In most cases, 
once an incident is opened, it will be set to this form by default. 
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 Within the Incident, fill out all of the applicable forms.  The system will 
require the operator to save changes made to each form prior to 
moving on to the next form. 
 

 
 
 

 Once all of the applicable forms are completed, look to the tool bar for 
the Plot Buttons.  Click on whichever button to plot an incident to the 
National Summary Map or My Map.  
 

           
 
If the box is selected with a check mark, the Incident may not be added 
to the Map but instead removed.    
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Note: To plot an incident to the National Summary Map within DMI-
SERVICES    Web Tools, the following criterions must be satisfied; 
otherwise, the request is cancelled and the operator is prompted with 
an error message displaying the deficiencies. 
 

o Designate Primary Site for Geocode (Located in the Site 
Information Panel) 

o Incident category is Actual 
o The Time of Occurrence date field, in the Incident Table of the 

Working Incident , is no more then 90 days prior. 
 
The fulfillment of the above criterions is not required to plot an incident 
to the My Map located within DMI-SERVICES    Web Tools. 

Using Distribution Lists 
 

 

Primary Operators can create Distribution Lists -- literally a list of 
COGs to which the Operator normally posts Incident Records and 
Alerts.  
 
The Distribution Lists, which can be Public (seen by other Operators in 
the COG) or Private (seen only by the Operator who created it), can 
help save time and effort.   
 
When an Incident Record or Alert is posted to a public or private 
Distribution List, it is posted to all COGs that make up the list. 
 
Distribution Lists can be seen in the Posting Alert window. 

 DMI-Services  has two forms of distribution list 
1. Private Distribution List: will be used only by the Operator who 

created it. 
2.  Public Distribution List can be used by all members of the 

Operator's COG 
 

 
 

To Work on a Distribution List 
1. Select the Distribution List screen from the DMI-Services 

drop-down menu (DMI-Services ► Disaster Management Tools 
► Distribution List). 

 The Distribution List screen displays along with menu buttons for 
Add, Edit, Delete, and Help. 
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 To view all the COGs within a given Distribution List, select the expand 

icon (the small plus-sign) adjacent to the folder icon and name of the 
Distribution List.   This bulleted list of COGs will display vertically 
beneath the Distribution List Name. 
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To Add a New Distribution List: 
1. Press the Add menu button.   

DMI-SERVICES    will display the Add Distribution List screen. 
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 2. Type in the Distribution List name along with a brief description.  
3. Select a radio button to determine whether this Distribution List will 

be public (so it displays in the Post Alert window for all other 
Operators in a COG) or private (so it displays in the Post Alert 
window of the Operator which created it). 

4. Select the desired COG(s) from the COG List in the left-hand pane. 
 Be sure to use the Right Carrot or Move Into (>) button to move 
the selected COG into the new Distribution List. 

5. Press the OK button to create the Distribution List. Or, to cancel the 
Distribution List, press the Cancel button. 

 
To Edit A Distribution List 
1. Select the appropriate Distribution List  
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 2. Move the cursor to the appropriate Distribution List and 
select it, then press the Edit button. 

 
The Edit Distribution List window will display on the screen. 
 
3. Edit the Name and/or Brief Description as needed.  
4. Make the list either Public or Private by selecting either the 

Public radio button or the Private radio button. 
5. Add or remove COGs in the Distribution List as follows: 
 

To add COGs to the List: 
o Select the desired COG(s) from the COG List in the 

left-hand pane. 
o Click the Right Carrot or Move Into (>) button.   

 
To remove COGs from the List: 
o Select the appropriate COG; and  
o Click the Left Carrot or Move Out (<) button. 

 
6. Click OK to save the Distribution List or click Cancel to 

cancel all edits to this Distribution List. 

 
To Delete A Distribution List 
1. Select the appropriate Distribution List such that it is 

highlighted; 
2. Click the Delete menu button. 
 
A Delete Confirmation dialog box will display.  To continue with 
the deletion, click the Yes button. To cancel the deletion, click 
the No button. 
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 The deleted Distribution List will no longer be an option within 
the Post Alert window. 

Save a Copy 
 
 Organizations can now save a copy of an existing Incident or Alert 

Record to use as a template in the future.  In fact, any time an Operator 
thinks they may be able to use a similar incident in the future for 
repeated events (traffic, floods, fire, etc. . .); they may be able to save 
time by saving a copy of an existing Incident Record. 

 To save a copy of an existing Incident Record: 
1. Open the selected Incident Record in DMI-Services. 
2. Select Save Copy from the File drop-down menu. 

 DMI-Services will display a Save Copy dialog box to allow the Operator 
to specify the name of the copied file and Save or Cancel the file. 
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3. Click the Save button to save the copied incident record, or click 

Cancel to cancel the process. 
 

 Once saved, a confirmation window will display.  
4. Click the OK button to acknowledge the Incident has been copied. 

 

When the Save Copy command is used to create a copy of an Alert, 
DMI-Services creates a unique 19-digit Identifier for the new Alert.  
Every Alert must have a unique Identifier to comply with the CAP 
standard and for tracking purposes in the DMI-Services database. 

Transfer of Ownership 
 
  DMI-Services enables a COG to transfer an incident record to another 

COG.  The receiving COG can then edit the active incident record; the 
transferring COG no longer has access to it.  The transferring COG 
does not retain an editable “copy” of the incident.  Thus, this feature 
should only be used when responsibility for documentation of an 
incident is truly being transferred from one COG to another. 

 The transfer of ownership capability could be used in situations where 
a “vertical cluster” of COGs need to rapidly collaborate on a major 
incident.  For example, there is a national “umbrella” COG to facilitate 
local, state, regional, and national response to agro-terror.  The local 
responders may wish to transfer ownership of an incident record to the 
“umbrella” COG in order to facilitate collaboration on all levels of 
government within the same incident record. 
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COGs that are clustered horizontally and that have a need to continue 
to actively work the incident in question may find that the use of the 
transfer of ownership is not advisable at this time.  COGs that wish to 
retain control of the incident record should not transfer ownership of 
an incident.  For example, consider a tornado skipping across a 
metropolitan area with an umbrella DMI-SERVICES    COG for the 
area plus multiple municipal DMI-SERVICES    COGs.  Each 
municipality will probably want to retain control of its own incident 
documentation and not wish to transfer ownership to the metropolitan 
area COG. 

 

 

 

When transferring ownership of an incident to another COG, the 
originating COG gives up control of that incident and loses access to 
the incident within the active incident list.  The incident will be 
removed from the originating COG's active incident list and all 
versions of the incident will be archived.  DMI-Services place the 
incident into the new COG's active Incident List.  The originating 
Operator will be able to view the incident when the new COG posts the 
incident to the originating COG. 



Page 78 of 220 

 
To transfer ownership of an incident to another COG: 
1. Retrieve the Incident List and open the Incident Information 

screen. 
Select Transfer Ownership from the File drop-down menu. 

 
 3. Select the COG to which the incident will be transferred. 
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 4. Click the OK button to complete the transfer. 

 
 DMI-Services will display a notification dialog box when the transfer is 

complete.  Click OK to close the dialog box. 
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NOTE: If members of the originating COG are viewing the incident 
when a transfer is attempted, DMI-Services will issue a message 
stating that other Operators are viewing the incident.  It will also 
provide a list of those Operators.  The incident may only be transferred 
if no other Operators are viewing or editing it. In addition, when the 
working version of an Incident Record is transferred, the DMI-Services 
System automatically transfers all Specific Needs Requests (SNRs) 
associated with that Incident Record. 
 

Using the Incident Information Form 
 
 The first panel displayed when a new incident is created is often called the Core 

Incident Information panel.  Here the Operator adds and edits basic information 
such as: 

o Category,  
o Incident Name,  
o Incident Number,  
o Incident Type,  
o Date & Time of Incident,  
o Level of Confidence (Estimated or Actual),  
o Description, Incident Phase,  
o Incident Notification Level,  
o Incident Status,  
o Incident Severity; and  
o General Comments.  

 
This core information remains displayed in the top pane of the main panel to keep 
Operators focused on the pending incident. 



Page 81 of 220 

 

 
 Field Description 
 Incident Number Used to assign an identification number 

to an incident.  Use local policies to 
establish numbering convention. 
Maximum of 80 alphanumeric 
characters. 

 Incident Category Option buttons used to classify the 
Incident.  Options are: Not Assigned, 
Actual, Planning, Training, and 
Exercise. 

 Incident Name A short description of the Incident. 
 Maximum of 80 alphanumeric 
characters. 

 Incident Type A drop-down list of categories of 
Incidents.  Choices are:  Explosion-
Chemical, Explosion-Nuclear, Fire-
Rural, Fire-Urban, Geological-
Avalanche, Geological-Earthquake, 
Geological-Flood, Geological-
Mud/Landslide, Geological-volcanic 
Eruption, HAZMAT-Biological, 
HAZMAT-Chemical, HAZMAT-Industrial 
Material, HAZMAT-Radiological, 
Maritime-Iceberg, Maritime-
Tsunami/Tidal Wave, Not Assigned, 
Other-Cyber, Other-Not Assigned, 
Other-refugee Event, Transportation-
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Aircraft, Transportation-Land Vehicle, 
Transportation-Rail, Transportation-
Ship/Boat, Weather-heat Incident, 
Weather-Hurricane/Typhoon, Weather-
Summer Storm, Weather-Tornado, 
Weather-Winter Storm  

 Date/Time of Incident Used to indicate when the Incident 
occurred.  Use the calendar icon to 
select the date and enter the time. This 
is a required field. 

 Level of Confidence (Estimated or 
Actual) 

Used to indicate how sure the Operator 
is of the date and time when the 
Incident occurred.  Choices are: 
Estimated and Actual.  This field is 
required. 

 Description A memo field used to enter a description 
of the Incident.  Maximum field length is 
2000 alphanumeric characters.  This is 
a required field. 

 Incident Phase A drop-down list used to indicate the 
phase of the Incident.  Choices are: Not 
Assigned, Investigation, Response, 
Recovery, Closed, and Archived. 

 Incident Notification Level A drop-down list used to indicate the 
level of notification.  Choices are: None, 
Advisory-info only, Alert-Action 
Possible, Activation Action Required, 
and Cancel No Further Action. 

 Incident Status A drop-down list used to indicate the 
status of the Incident.  Choices are: 
Unknown, Worsening, Improving, Under 
Control, and Closed. 

 Incident Severity A drop-down list used to indicate the 
severity of the Incident.  Choices are: 
Unknown, Emergency, Minor, Major, 
Catastrophic, and Cataclysmic. 

 General Comments A memo field used to add any additional 
information. Maximum field length is 
2000 alphanumeric characters. 

 
Using the Tree View 
 
 The tree view in TIE is much like the tree view in help.  It enables an 

Operator to quickly navigate through the panels.  For example, the 
Operator can move from the core Incident Information panel to the 
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Medical Information panel by clicking on the Medical Information icon. 
 

 Each icon has a specific meaning. 
The folder icon is a means of organizing the screens.  For example, in 
TIE, the folder icon would have the name of the Incident.  If the Incident 
includes attachments, the folder icon is displayed with a paper clip . 
The page icon indicates whether data has been entered on the panel it 
represents.  If the page icon is filled  (has lines on it), then it has data 
filled in.  If the page icon is blank  (no lines), then no data has been 
added to it. 

 
NOTE: The COG Administrator has the ability to limit Operator access to 
various panels.  For example, an Operator could have access to the Site 
Information panel, but not to Medical Facilities. 
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Incident Information Tool Bar Buttons 
 The following tool bar buttons are available from the screens in TIE. 

 Use the buttons to perform many commands, or use the menu 
commands.  

 

 
 Letter Meaning 
 A Attaching files to an Incident 
 B Post Incident 
 C Save Incident 
 D Creating New Incidents 
 E Using the Contact Information Screen  
 F Using the Edit Address Button 
 G Using the Quick Pick Screen 
 H Insert Row 
 I Delete Row 
 J Modifying Incident Information 
 K Help 

 
Entering Core Incident Information 
 
 The first panel displayed when a new incident is created is often called 

the Core Incident Information panel.  Add and Edit basic information 
such as the Category, Incident Name, Incident Number, Incident Type, 
Date, and Time of Incident, Level of Confidence (Estimated or Actual), 
Description, Incident Phase, Incident Notification Level, Incident 
Status, Incident Severity, and General Comments here.   
This core information remains displayed in the top pane of the main 
panel to keep Operators focused on the pending incident. 

 1. To add or edit information on the Incident Information screen, 
open the Incident from the Incident List screen. 

2. Enter an Incident Number.  Incident Number is a required field. 

 

NOTE: The Incident Number can consist of numbers and letters.  The 
numbering conventions for the Incident Number are determined by 
each COG's local procedures. 

 3. Select the Incident category from the following option buttons.   

 



Page 85 of 220 

 4. Enter a name for the Incident and enter a description.  Incident 
Name and Description are required fields. 

5. Select the date and enter the time on the calendar.  Be sure to 
indicate whether the time is estimated or actual by selecting the 
appropriate option button.  The date and time are required fields. 

 

 

 
The following are required fields:  Incident Number, Incident 
Name, Description, Date and Time. 

 6. Select the phase from the Incident Phase field.  Options are: Not 
Assigned, Investigation, Response, Recovery, Closed, and 
Archived. 

7. Select the Incident Notification level from the Incident Notification 
Level field.  Options are: National, None, Advisory-info only, 
Alert-action possible, and Activation Action required, and 
Cancel-No further action. 

 

NOTE: If this Incident is to appear on the Disaster Management Map, 
select its Notification Level as National and select Actual for 
Incident Category.  Also, at least one address on the Site 
Information panel must be checked as a Primary Site. 

 8. Select the Incident Status from the Incident Status field.  Options 
are: Unknown, Worsening, Improving, Under Control, Closed, 
and Archived. 

9. Select the Incident Severity from the Incident Severity field. 
10. Select the Save command from the File drop-down menu to save 

the information.   

 

NOTE: All required information must be entered in the panel before it 
can be saved.  If an Operator tries to close the Incident without saving 
changes, a message box will open asking if they want to save changes 
before closing. Click Yes in the message box to save the changes and 
close the Incident.  Click No to close without saving the changes.  Click 
Cancel to return to the Incident. 

 11. Once changes have been saved, a message box will display a 
confirmation message that the changes have been saved.  Click 
the OK button to close the message box. 
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Use the "tree" structure in the left pane of the screen to move to 
the other screens in the Incident. 

Entering Site Information 
 
 Use the Site Information screen to enter information about sites 

affected by an Incident.  As there can be more than one site 
associated with an Incident, the panel allows for multiple entries 
in the table at the bottom of the screen.  Core Incident 
Information is displayed in the top pane. 

 1. Retrieve the Incident list and open the Incident Information 
screen. 

2. From the Incident Information form, click the Site 
icon . 

 The Site Information screen opens. 

  

 3. Enable editing if not already enabled. If not already 
enabled, click the Edit button to enable editing on the 
Incident.  Once editing is enabled, the Operator can move 
around the Incident without having to turn it back on. 

4. Double-click on the top row to open the Address screen.  
5. Enter the site information in the fields as appropriate. 

 Once completed, this information is displayed as a row in 
the table. 

 

NOTE: Use the Quick Pick to select from a pre-existing set of 
Shelter Facilities via the Quick Pick function.  Click the Quick 
Pick button and select the appropriate Shelter Facility.  Each 
time a new site is entered by a COG Operator into the 
Designated Shelters tab of the Population Actions panel, it 
is added to the Quick Pick database.  However Operators will 
not see Shelter Facilities entered by other COGs. 

 6.  Use the Plot on Map field to indicate whether the site 
should be plotted on the Incident Map.   
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NOTE: If the Plot on Map checkbox is NOT checked, the 
address will NOT be plotted on the map. 

 

 

The selection of 'Plot on Map' serves multiple purposes other 
then just plotting the address to the Incident Map.   
• The selection of 'Plot on Map' can also plot an address to 
the My Map within DMI-Services   Web Tools 
• It also satisfies a criterion for displaying the incident to the 
National Summary Map (NSM). 
In the case of multiple addresses, the system requires 
'Primary Site' be selected to acknowledge a single 
displayable address on the NSM or My Map within DMI-
SERVICES    Web Tools. 

 7. In the Name field, enter a name for the site (JFK Airport, 
Madison Square Garden, etc.). 

 
 8. Use the Description field to enter a brief description of 

the site (football stadium, high school, etc.). 

 
 9. Enter the Address, City, State, Country, Postal Code, 

and Cross Streets in their appropriate fields.  
 
NOTE: The Cross Street section is a text area where 
additional street information pertaining to the location may be 
added.   
 
10. Optionally, the Latitude and Longitude coordinates in 

their respective fields to give a precise location of the site. 
 

 
 
 
 

NOTE: To find the Latitude and Longitude coordinates, use 
the Find Address tool in the Map screen to enter the Street 
Address. Once a mark for that address appears on the map, 
place the cursor on the mark and right-click. Then select 
Coordinate to display the Latitude and Longitude of the 
address.  

 
When entering Longitude and Latitude, be sure to use the 
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 accepted GIS Format.  For longitudes West of the Prime 
Meridian, use the minus sign as a prefix before the 
measurement.  For latitudes South of the Equator, use the 
minus sign as a prefix before the measurement. Once 
recorded, press the convert button to find the Degrees, 
Minutes, and Seconds of the exact longitude and latitude 
coordinates. 

 11. Click the OK button to save the Address information. Click 
the Cancel button to return to the Site Information panel. 

 

If Incident is closed without saving changes, a message 
box displays asking if they want to save changes.  

 

NOTE: To add or delete rows, click the Add Row or Delete 
Row button, or select Add Row or Delete Row from the 
Actions drop-down menu, or right-click on a row to view and 
make a selection (Add Row or Delete Row) from the context 
menu.  Alternatively, select from the icons adjacent to the 
Site Information list box:  

Icon for adding a row; 

Icon for deleting a row; and 

Icon to view details of the row of information. 

 12. To enter contacts for the incident’s site, select the 
appropriate row of site information by clicking on it once 
with the cursor.  

 
13. Click the Contacts button.  For more information about 
entering contact information, see Using the Contact Screen. 

 14. Select the Save command from the File drop-down menu 
to save the information or click the save icon. 

 A message box appears indicating that the information has been 
saved. 

 15. After the Operator has saved contacts information, the 
icon in the Contacts column will change from a blank icon 

 to a Contact icon . 
16. Click OK to close the screen. 
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Use the "tree" structure in the left pane of the screen to 
move to the other screens in the Incident. 

Entering Agent Information 
 
 Use the Agent Information panel to help identify an agent that may 

have been used in an Incident.  This panel lets the Operator enter 
information about sampling and observations of the agent.  Core 
Incident Information is displayed in the top pane. 

 1. Retrieve the Incident list and open the Incident Information 
screen. 

2. From the Incident Information panel, click the Agent Information 
icon . 

 The Agent Information panel opens. 

 3. If a terrorist act is suspected, click the Terrorist Act Suspected 
radio button.  

 

 4. If the Operator suspects that a chemical or biological agent is the 
suspected cause of the incident, indicate it in the checkbox. 
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 5. If the agent name is known or suspected, indicate it in the Agent 
Name table.  To enter information, click once on the table cell and 
begin typing.  Select the level of certainty from the Confirmed 
drop-down list. 

 
 
NOTE: To add or delete rows, click the Add Row or Delete Row 
button, or select Add Row or Delete Row from the Actions drop-down 
menu, or right-click on a row to view and make a selection (Add Row 
or Delete Row) from the context menu. Alternatively, the Operator may 
select from the icons adjacent to the Agents list box:  

 Icon for adding a row; 

 Icon for deleting a row. 

 

NOTE: To add or delete rows, click the Add Row or Delete Row 
button, or select Add Row or Delete Row from the Actions drop-down 
menu, or right-click on a row to view and make a selection (Add Row 
or Delete Row) from the context menu. Alternatively, the Operator may 
select from the icons adjacent to the Agents list box:  

 Icon for adding a row; 

 Icon for deleting a row. 
 6. Enter any related remarks in the Remarks field. 

 Observation, Sample and Testing Information is maintained in the 
Observation and Sample Info tabs.  
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 7. Select the type of observation from the Observation drop-down.  

 
 8. Enter descriptive text in the Value field. 

9. Select a date and time through use of the calendar icon. 
 
NOTE: Add or delete rows as necessary using any of the four methods 
described earlier. 

 Use the Sample Info Tab to enter sampling information. 

 10. Click the Sample Info Tab to make the tab active. 

 

 11. If a sample was taken, place a check in the checkbox and use the 
Calendar icon to select the date and time the same was taken. 

12. If a sample was tested, place a check in the checkbox and use the 
Calendar icon to select the date and time the sample was tested. 

13. Enter the name of the specialist taking the sample or testing the 
sample along with their contact information (Address Line 1, 
Address Line 2, City, State, Country, Postal Code, and Cross 
Streets). 

14. Enter details about the Test Equipment used, Agent Monitoring 
Comments, or any other information in the fields provided. 

 NOTE: Add or delete rows as necessary using any of the four 
methods described earlier. 
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If the Operator closes an Incident without saving changes, a message 
box will open asking if they want to save changes before closing. 

 15. Click Yes to save the changes before closing, click No to close 
without saving the changes, or click Cancel to return to the 
Incident. 

 
16. Select the Save command from the File drop-down menu to save 

the information or click the save icon. 
 A message box opens, indicating that changes saved. 
 17. Click OK to close the screen. 

Entering Casualty Information 
 
 The Casualty Information panel is used to enter information about 

casualties, such as the number of fatalities, injured, missing, or 
displaced.  Core Incident Information is displayed in the top pane. 

 1. Retrieve the Incident list and open the Incident Information panel. 
2. From the Incident Information panel, select the Casualties 

icon . 

 The Casualty Information panel opens. 

  
 3. Click on the Victim Type cell to select the type of victim (such as 

Injured, Fatalities, etc.) 
4. Enter the estimated number of fatalities, injured, missing and 

displaced as appropriate.  
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NOTE: The estimated number field is a "free text" field, meaning the 
Operator can enter text or numbers.  If necessary, the Operator can 
enter a range, such as "Between 90-150." 

 5. Select the Confidence level (estimated, Actual, or Unknown) from 
the drop-down list. 

6. Enter related remarks in the associated fields. 

 7. Select the Save command from the File menu to save the 
information or click the save icon. 

 A message box displays a confirmation message stating the changes 
have been saved. 

 8. Click OK to close the panel. 
 

 

NOTE: To add or delete rows, click the Add Row or Delete Row 
button, or select Add Row or Delete Row from the Actions drop-down 
menu, or right-click on a row to view and make a selection (Add Row 
or Delete Row) from the context menu.  Alternatively, the Operator 
may select from the icons adjacent to the Casualties Information list 
box:  

 Icon for adding a row; 

 Icon for deleting a row. 

 

 
Use the "tree" structure in the left pane of the screen to move to 
the other screens in the Incident. 

Viewing Weather Forecasts (from TIE) 
 
 The DMI-Services Weather Tool enables an Operator to view local 

weather forecasts based on the Postal Code entered.  The data is 
automatically updated at regular intervals.   



Page 94 of 220 

 

NOTE: When an Incident is posted, weather forecast data current 
as of the posting time is displayed when the posted Incident is 
viewed. 

 Access the Weather Tool either from TIE or from the Disaster 
Management Tools menu, located in the DMI-Services menu. 
For more information about viewing weather forecast data from The 
Disaster Management Tools menu, see  
Viewing Local Weather Forecasts 

 To access the DMI-Services  Weather Tool from TIE: 

 1. Retrieve the Incident List and open the Incident Information 
panel. 

2. From the Incident Information form, select the Weather 
Forecasts icon  to open the panel. 

 The Weather Forecasts panel is displayed. 

 3. Enter the Postal Code in the field provided and click the Go 
button. 

 DMI-Services refreshed the screen to display the forecast for the 
entered Postal Code. 
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 For more information on the forecast data, see  
 
Weather Terms 

 4. To view Radar data, select and open Radar from the WEATHER 
DATA tree in the left pane. 

 The Radar screen is displayed. 

 

 
 5. To view current weather alerts, select Alerts from the WEATHER 

DATA tree in the left pane. 
 The Alerts screen is displayed. 
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Converting Current Weather to Weather Observations 
 
 Use the convert button to convert data from the Weather Forecast Tool 

to On Scene Weather observations. 

 1. Retrieve the Incident List and open the Incident Information panel. 
2. From the Incident Information panel, select the Weather Forecasts 

icon . 

 DMI-Services displays the Weather Forecast screen. 

 3. Enter the Postal Code of the area for which the Operator is obtaining 
a weather forecast. 

4. Click the Go button. 
 DMI-Services displays the current weather conditions on the screen. 

 5. Click the Convert button to convert the forecast into on scene 
Weather observations. 
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 DMI-Services displays a message confirming that the conversion was 
successful. 

 

 6. Click OK to close the message box. 
7. Click Save to save the weather observations. 
8. To view the new weather observations, click the On Scene Weather 

icon .  

 For more info on viewing On Scene Weather observations, see Editing 
and Viewing Existing Weather Observations. 

Viewing Weather for Posted Incidents 
 
 Operators can view the weather conditions that were current at the time 

an Incident posted.  To view the weather conditions for a posted incident : 
 1. Select the incident to be viewed from the Incident List. 
 DMI-Services display the Incident Information panel.   
 2. Select the On Scene Weather icon from the Incident Information 

tree located in the left pane. 
 DMI-Services display the weather conditions as they existed when the 

incident was posted.  The following data points are displayed: 
o Observation Name (optional, user input during conversion of 

current weather to observation) 
o Date and Time the weather data was obtained 
o Weather conditions (Rain, Snow, Ice, Sleet, Freezing Rain, 

Partly Sunny, Mostly Sunny, Partly Cloudy, Mostly Cloudy) 
o Precipitation Type (Rain, Snow, Ice, Sleet, Freezing Rain) 
o Ceiling Height (ft X 100) 
o Wind Direction (Compass) 
o Relative Humidity (%) 
o Visibility (mi) 
o Temperature (degrees F) 
o Real Feel Temperature (degrees F) 
o Dew Point (degrees F) 
o Wet bulb 
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o Wind Speed (mph) 
o Wind Gust (mph) 
o Hourly Snow (in) 
o Hourly Ice (in) 
o Hourly Rain (in) 
o Hourly Liquid Equivalent (in) 

 Moving between Weather Observations 
To move from viewing one detailed weather observation to another: 

1. Click on the Edit Data button.  
DMI-Services will display the columns of recorded weather observations 
in the main pane of the On Scene Weather panel.  

2. Select the desired on scene weather observation by clicking on the 
hyperlink of the desired weather observation.  (NOTE: The 
hyperlink shows the date, time, and Postal Code of the appropriate 
weather site of the observation.) 

The selected Weather Observation will display in the main pane of the On 
Scene Weather panel. 

Entering New Weather Observations 
 
 Use the On Scene Weather panel to capture observed weather data at 

one or more of the incident sites.  

 1. Retrieve the Incident List and open the Incident Information panel. 
2. From the Incident Information panel, select the On Scene 

Weather icon . 

 The On Scene Weather Observations screen is displayed.  If no 
observations have been entered, then a message will be displayed 
(see example below) and will offer a link to a screen to enter 
observations.   

 
If the Operator wants to enter a new weather observation, they clicks the 
link to open the Observation Site Information panel (skip step 3).  
 
If the Operator is simply editing existing observations, the Operator 
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must perform step 3. 

 3. To edit an existing weather observation, the Operator clicks the Edit 
Data button or Edit from the Actions drop-down menu. 

 A message box opens asking the Operator to select an observation to 
edit. 

 
 4. Click the New button to enter a new observation. 

The Observation Site Information panel opens. 
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 For more information about using weather terms on this panel, see 
 
Weather Terms 

5. From the Observation Site Information panel, enter the 
necessary information in the fields provided.   

NOTE: The Site Name, Date and Time and Postal Code fields are 
required.  If the Operator does not enter a Postal Code, they must 
enter a city and state.  If the Postal Code is outside the U.S., then 
they must enter a Country, 
 
Also, the Operator may select from a pre-existing set of Weather 
Facilities by via Quick Pick function. Just press the Quick Pick 
button and select the appropriate Weather Facility.  Each time a 
new site is entered by a COG Operator into the Observation Site 
Information portion of the On Scene Weather panel, it is added to 
the Quick Pick database.  However Operators will not see Weather 
Facilities entered by other COGs. 
 
When entering Longitude and Latitude, be sure to use the accepted 
GIS Format.  For longitudes West of the Prime Meridian, use the 
minus sign as a prefix before the measurement.  For latitudes 
South of the Equator, use the minus sign as a prefix before the 
measurement. Once recorded, press the convert button to find the 
Degrees, Minutes, and Seconds of the exact longitude and latitude 
coordinates. 

 

If the Operator has not entered information in all required fields 
(Site Name, Date and Time and Postal Code), then the New 
Incident Error screen opens. 

 6. Click the Close button to close this screen and return to the 
Incident.  The Operator must supply information for the required 
fields before proceeding. 

 

If the Operator closes an Incident without saving changes, a 
message box will open asking if they want to save his/her changes 
before closing. 

 7. Click Yes to save the changes before closing, click No to close 
without saving the changes, or click Cancel to return to the 
Incident. 

 When the changes have been saved, a message box opens indicating 
that the changes have been saved.   



Page 101 of 220 

 8. Click the OK button to close the message box. 

 

 
Use the "tree" structure in the left pane of the screen to move 
to the other screens in the Incident. 

 
Editing and Viewing Existing Weather Observations 
 
 Use the On Scene Weather Observation information panel to capture 

observed weather data at one or more of the incident sites.  
Core Incident Information is displayed in the top pane.    

 1. Retrieve the Incident List and open the Incident Information 
panel. 

2. From the Incident Information panel, select the On Scene 
Weather icon . 

 The On Scene Weather Observations panel appears.  If no 
observations have been entered, then a message will display stating 
that fact and will offer a link to a screen to enter observations.  For 
more information on entering new weather observations, see Entering 
New Weather Observations. 

 

 

 3. If there is an existing observation, the site name will have a link that 
the Operator can use to edit the observation.  Click this link to open 
the Observation Site Information screen populated with the data for 
the site.  If the Operator uses this link, they can skip steps 4 and 5. 
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 4. To edit an observation without using the link, click the Edit button 
or select Edit from the File menu.  

 A message box appears asking the Operator to select an observation 
to edit: 

 

 
Select the observation to edit and click OK.  To enter a new 
observation, the Operator clicks the New button.  For more information 
about adding new weather observations, see Entering New Weather 
Observations.  To cancel the edit process, click Cancel. 
From the Observation Site Information screen, enter the necessary 
information in the fields provided.  For more information about weather 
terms used on this screen, see Weather Terms.  

 

If the Operator closes an Incident without saving changes, a 
message box will display asking if they want to save his/her 
changes before closing. 

 7. Click yes to save the changes before closing; click No to close 
without saving the changes; or click Cancel to return to the 
Incident. 

 
8. To save the information, select the Save command from the File 

drop-down or click the Save button. 

 

Use the "tree" structure in the left pane of the screen to move to 
the other screens in the Incident. 
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Weather Terms 
 The following terms are valid values for weather observations: 

Cloud Cover: The amount of sky obstructed by clouds, measured in 
tenths of sky or percent of sky. 
Sunlight Intensity: Intensity of the sun, measured in Day Low, Day 
Moderate, Day High and Night. 
Air Temperature: The free air or ambient temperature close to the 
surface of the earth, measured in Celsius or Fahrenheit. 
Thermal Inversion: An increase in temperature with height, which is the 
reverse of the normal cooling with height in the atmosphere.  Thermal 
Inversion Indicated has the choices of “Yes” or “No”.  Thermal Inversion 
Height is the height where the Inversion begins, measured in feet or 
meters.  Thermal Inversion Description is a description of the thermal 
inversion. 
Surface Conditions Description: A general description of the weather 
on land. 
Barometric Status: Refers to the status of the barometric pressure, 
indicating if the pressure is rising or falling.   
Barometric Pressure: The pressure exerted by the atmosphere at a 
given point. Its measurement can be expressed in several ways, such as 
millibars or in inches or millimeters of Mercury (Hg). One millibar is 
equivalent to 100 newtons per square meter. Standard surface pressure 
is 1,013.2 millibars.  Inches Of Mercury (Hg) comes from the use of 
mercurial barometers, which equate the height of a column of mercury 
with air pressure.  One inch of mercury is equivalent to 33.86 millibars or 
25.40 millimeters.  
Precipitation Description:  A description of any precipitation. 
 Precipitation includes all forms of water, whether liquid or solid that falls 
from clouds and reaches the ground, including drizzle, freezing rain, ice 
pellets, rain, and snow.   
Relative Humidity (RH):  The ratio of the water vapor pressure or water 
vapor content to the saturation vapor pressure or the maximum vapor 
content at the temperature of the air or gas. The saturation vapor 
pressure in the air varies with air temperature, the higher the 
temperature, the more water vapor it can hold.  When saturated, the 
relative humidity in the air is 100 %RH.   
Wind Consistency:  Refers to the consistency of the wind.  Valid values 
are “Steady” and “Variable”. 
Wind Direction:  The direction from which the wind is blowing. For 
example, an easterly wind is blowing from the east, not toward the east. 
 It is reported with reference to true north, or 360 degrees on the 
compass, and expressed to the nearest 10 degrees, or to one of the 16 
points of the compass (N, NE, WNW, etc.). 

 Wind Speed:  The rate of the motion of the air on a unit of time. It can be 
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measured in a number of ways.  For observations, it is measured in Knots 
(KTS), or nautical miles per hour.  The unit most often used in the United 
States is miles per hour (MPH). 

 Variable Wind Speed Range (minimum) and (maximum): The range of 
speed of the wind when the speed is variable.  An example would be a 
range of “Variable Wind Speed Range (minimum) 2 mph”.  The 
associated observation (entered on another line) would be “Variable Wind 
Speed Range (maximum) 4 mph”.  Both minimum and maximum speeds 
must be entered because they are parts of the same data element.  Valid 
units of measure are:  MPH, KPH and KTS.  

 Variable Wind Direction (from) and (to):  The range of direction of the 
wind when the direction is variable.   In this case, the "from" and "to" are 
indicating that the Operator is specifying a range of direction (such as 
"from x to y").   An example would be: “Variable Wind Direction (from) 
North”.  The associated observation (entered on another line) would be 
“Variable Wind Direction (to) North East”.  Both to and from directions 
must be present because they are parts of the same data element.  Valid 
units of measure are compass points or degrees. 

 Wind Measurement:  The height of the wind, measured in Feet or 
Meters. 
Weather Data Source:  Where the source of data came from. 
 Examples : Instruments, observation, Internet, etc. 

 Maritime: 
    Tides:   
          Next Low Tide:  Time of the next low tide.  
          Next High Tide:  Time of the next high tide. 
    Water Temperature:  Temperature of the water in degrees Fahrenheit 
or Celsius. 
    Water Current Speed: Speed of the water current, measured in Knots 
(KTS). 
    Water Current Temperature:  Temperature of the water current, 
measured in Fahrenheit or Celsius. 
    Wave Height:  Average height of the waves, measured in Feet or 
Meters. 
    Wave Direction (from):  Direction from which the waves are coming, 
measured in compass points or degrees. 
    Swell Height:  The height of a swell, measured in Feet or Meters. 
 Swells are ocean waves that have traveled out of their generating area. 
 Swells characteristically exhibit more regular and longer periods and 
have flatter wave crests than waves within their fetch (generating area). 
    Swell Direction (from):  The direction from which the swells are 
coming, measured in degrees or compass points. 
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Entering Population Actions 
 Use the Population Actions function to estimate, track, or report 

the number of persons needing or assigned shelters, evacuation 
information, etc.   

 The Population Actions screen contains three tabs. The first tab is 
used for Evacuation Information.  The second tab is used for Shelter 
In Place information.  The third tab is used for Designated Shelters 
information. 

 To enter Population Action information: 
 1. Retrieve the Incident List and open the Incident Information panel. 

From the Incident Information panel, select the Population Actions 
icon  from the Tree View structure. 

 The Population Actions screen opens. 

 3. To enter evacuation information, select the Evacuation Information 
tab.  The Evacuation Information table is displayed.   

 
 4. Enter information into the Areas Evacuated field and enter the 

Number of Evacuees in the adjacent field. 
 

 5. If the population will be sheltered in place, select the Shelter in 
Place tab.   

The Shelter in Place table is displayed. 

 
 6. Enter the information as necessary into the fields Shelter 

Descriptions and the Number Sheltered. 
 
NOTE: Add or delete rows as necessary using any of the four methods 
described earlier. 
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 7. To enter designated shelter information, press the Designated 
Shelters tab.   

The Designated Shelters table is displayed.  The fields are: 
o Contacts 
o Plot? 
o Shelter Name  
o Address Line 1  
o Address Line 2  
o City 
o State  
o Country 
o Postal Code  
o Latitude  
o Longitude  
o Description  
o Cross Streets.  

 
 
When entering Longitude and Latitude, use the accepted GIS Format. 
 For longitudes West of the Prime Meridian, use the minus sign as a 
prefix before the measurement.  For latitudes South of the Equator, use 
the minus sign as a prefix before the measurement.  
 
Click the convert button to find the Degrees, Minutes, and Seconds of 
the exact longitude and latitude coordinates. 
 
Use the Quick Pick function to select from a pre-existing set of Shelter 
Facilities. Just click the Quick Pick button and select the appropriate 
Shelter Facility.  Each time a new site is entered by a COG Operator into 
the Designated Shelters tab of the Population Actions panel, it is added 
to the Quick Pick database.  However Operators will not see Shelter 
Facilities entered by other COGs. 
 
Enter a Contact for a specific shelter and that entry will automatically be 
stored in the Contacts database. It may be re-used in future incidents. 
 
NOTE: Add or delete rows as necessary using any of the four methods 
described earlier. 
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 8. If desired, enter Shelter Property information.  For the Property 
field, select either Capacity or Shelter Facility Type and then 
enter its appropriate value in the Value field. 

 
NOTE: Add or delete rows as necessary using any of the four methods 
described earlier. 

 

If the Operator closes an Incident without saving changes, a 
message box will display asking if they want to save his/her 
changes before closing. 

 9. Click Yes to save the changes before closing, click No to close 
without saving the changes, or click Cancel to return to the 
Incident. 

 When the changes have been saved, a message box opens indicating 
that the changes have been saved.   

 10. Click the OK button to close the message box. 
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 Entering Property Damage Information 
 Property Damage information aids in preparing a summary of the area 

experiencing damage. Building plans, if available, can be attached.  The 
Property Damage Information panel has two tabs.  The first tab is used 
to enter Summary information about property damage.  The second tab is 
used to enter detailed information about property damage. 
Core Incident Information is displayed in the top pane.   

 1. Retrieve the Incident List and open the Incident Information panel. 
2. From the Incident Information panel, select the Property Damage 

icon . 
The Property Damage screen appears. 

 The Summary tab is used to enter general information.   

 

 3. Enter a description and estimated size of the impacted area and a 
description of the damage. 

 4. Enter Property Damage by type with the estimated number of damaged 
buildings. 

 
 5. Enter comments in the Comments field. 

 

 Use the Details tab to enter detailed address information about the 
damaged buildings. 
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 6. Click the Details tab to open the Damaged Sites panel.   

 

 7. Once in the Damaged Sites list box of the Details tab, double-click on 
the row to bring up the Address screen.   Enter the address information 
(Plot?, Site Name, Address Line 1, Address Line 2, City, State, 
Country, Postal Code, Latitude, Longitude, Description, and Cross 
Streets) of the damaged building locations as appropriate. 

 
Use the Quick Pick function to select the appropriate Property Damage 
Site.  Each time a new site is entered by a COG Operator into the Details 
tab of the Property Damage panel, it is added to the Quick Pick database. 
 However Operators will not see Shelter Facilities entered by other COGs. 
 
NOTE: Add or delete rows as necessary using any of the four methods 
described earlier. 

 8. If the Operator closes the Incident without saving changes, a message 
box will open asking if they want to save his/her changes before 
closing. 

9. Click Yes to save the changes before closing, click No to close without 
saving the changes, or click Cancel to return to the Incident. 

 When the changes have been saved, a message box opens indicating that 
the changes have been saved.   

 10. Click the OK button to close the message box. 

Entering Infrastructure Information 
 
 The Infrastructure panel provides information on damage to and 

interruption of utilities, transportation, and supplies.   
Core Incident Information remains displayed in the top pane. 
1. Retrieve the Incident List and open the Incident Information panel. 

 2. From the Incident Information panel, select the infrastructure 
Information icon . 

 3. The Infrastructure Form is displayed. 
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 4. Enter Utilities information in the Utilities table by selecting the 
appropriate type of utility and then enter comments regarding that 
utility. 

 
5. To add or delete rows, the Operator can press the Add Row or Delete 

Row menu button, or select Add Row or Delete Row from the Actions 
drop-down menu, or right-click on a row to view and make a selection 
(Add Row or Delete Row) from the context menu. Alternatively, the 
Operator may select from the icons adjacent to the Utilities list box:  

Icon for adding a row; and 

Icon for deleting a row. 
 6. Enter Transportation information in the Transportation table by 

selecting the appropriate type of Transportation and then enter 
comments regarding that type of Transportation. 

 
7. Add or delete rows as appropriate. 
8. Enter Supplies information in the Supplies table by selecting the 

appropriate type of supply and then enter comments regarding that 
supply type. 

 
9. Add or delete rows as appropriate. 
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 10. Click the Save menu button or select the Save from the File drop-
down menu. 

 If the Operator closes the Incident without saving changes, a message 
box will open asking if they want to save changes before closing. 

 11. Click Yes to save the changes before closing, click No to close without 
saving the changes, or click Cancel to return to the Incident. 

When the changes have been saved, a message box opens indicating 
that the changes have been saved.   

 12. Click the OK button to close the message box. 

 

Use the "tree" structure in the left pane of the screen to move to the 
other screens in the Incident. 
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Entering Medical Information 
 
 Medical Information includes hospital locations, outpatient and 

inpatient capacity, and numbers of patients, special capabilities, and 
special requirements.   
Core Incident Information remains displayed in the top pane. 

 1. Retrieve the Incident List and open the Incident Information 
panel. 

 2. From the Incident Information panel, select the Medical 
Information icon . 

The Medical Information panel opens. 

 3. To enter address information, click the Edit Address button (or 
double-click in the table). 

 

 The Address screen opens. 
4. If the Operator wants the facility to appear on the Incident Map, 

click the Plot on Map checkbox. 

 
 

5. Enter the Facility Name and Address in the fields provided. 
Instead of entering the address, the Operator can enter the Latitude 
and Longitude of the facility in the fields provided. 
 
6. Use the Quick Pick function to select from a pre-existing set of 

Medical Sites.  Click the Quick Pick menu button and select the 
appropriate Medical Site.   Each time a new site is entered by a 
COG Operator into the Medical panel, it is added to the Quick Pick 
database.  However, Operators will not see Medical Site 
information entered by other COGs. 

 
When the Operator enters a Contact for a Medical Facility, it will 
automatically be stored in the COG's Contacts database and may be 
re-used in future incidents. 
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NOTE: When entering Longitude and Latitude, be sure to use the 
accepted GIS Format.  For longitudes West of the Prime Meridian, use 
the minus sign as a prefix before the measurement.  For latitudes 
South of the Equator, use the minus sign as a prefix before the 
measurement.  
7. Click the convert button to find the Degrees, Minutes, and Seconds 

of the exact longitude and latitude coordinates. 
 8. Click the OK button to save the entries. To cancel, click the Cancel 

button. 

 
Facility Properties 
 

 
 
9. Select the Facility Property from the drop-down list and type in a 

value for the selected property.  
 
NOTE: Add or delete rows as appropriate. 

 10. Click the Save button to save the changes before closing. 

 When the changes have been saved, a message box opens indicating 
that the changes have been saved. 

 11. Click the OK button to close the message box. 

Viewing the Incident Map 
 
 TIE Incident Information uses the DMI-Services  Geospatial Information 

Service (GIS) capability to associate an area map with an incident and to 
add icons that make the area map relevant to the Incident.   
Core Incident Information remains displayed in the top pane. 

 1. Retrieve the Incident List and open the Incident Information panel. 
 2. From the Incident Information panel, select the Map icon . 
 The Map panel opens.  For more information on using the map, see About 
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the Map. 

Making Journal Entries 
 

 

NOTE: Set the workstation's Operating System Time Zone to the 
same setting as the DMI-SERVICES    Time Zone to ensure 
consistency in timestamps. 
 
The Journal screen lets an Operator add freeform text for additional 
information regarding an Incident.   
Journal entries are NOT posted with the rest of the Incident. 

 To make a Journal entry: 
1. Retrieve the Incident List and open the incident record. 
2. The DMI-Services  System opens and displays the Incident 

Information screen.  
3. From the Incident Information panel, select the Journal 

icon . 
4. The DMI-Services  System opens and displays the Journal 

screen. 
5. The DMI-Services  System pre-populates the Operator’s field 

with the Operator’s user name and pre-populates the Date 
and Time field with the current date and time. 

6. Enter a category for the Journal in the Category field. 
7. Enter the text for the Journal entry in the Comments field. 

 

Note: When entering categories, organizations may want to "plan 
ahead" and be sure to standardize entries.  Planned future 
functionality may allow Operators to sort on categories for reports 
(such as a "Lessons Learned" report).  Although Journal entries are 
"free form," please plan for future functionality.  
 
Watch out for misspellings and abbreviations (for example, if an 
Operator is printing a "Lessons Learned" report, entries with the 
category of "Less Learned" will not be included).  Entries suggested 
by colleagues throughout the country include:  LESSON LEARNED, 
TELCON FROM, TELCON TO, EMAIL FROM, EMAIL TO, RADIO 
FROM, RADIO TO, TASK RECEIVED, TASK ISSUED, ACTION 
TAKEN, TASK STATUS, BRIEFING FROM, BRIEFING TO, and 
SHIFT TURNOVER. 



Page 115 of 220 

 8. Enter the text for the Journal entry in the Comments field. 
 
NOTE: To add rows, click the Add Row menu button, or select Add 
Row from the Actions drop-down menu, or right-click on a row to 
view and make a selection (Add Row) from the context menu. 

Alternatively, the Operator may select the Add Row icon  adjacent 
to the Journal list box. 

 
9. Click the Save menu button or select Save from the File drop-

down menu to save recent changes. 

 NOTE: An Operator may not edit or delete Journal entries in saved 
records.  This helps COGs to preserve an accurate record of journal 
entries during the Incident. It is possible for an Operator to add 
additional entries after an incident has been saved. 

 

Entering Additional Information 
 DMI-Services  provide a panel in which the Operator can enter Additional 

Information that may not fit in other Incident panels.   
Core Incident Information remains displayed in the top pane. 

 1. Retrieve the Incident list and open the Incident Information panel. 
 2. From the Incident Information panel, select the Additional 

Information icon . 
 The Additional Information panel opens. 
 3. Enter the additional information as necessary in the given fields. 
 4. If the Operator closes the panel and has not entered information in all 

required fields, then the New Incident Error screen opens. 
 5. If the Operator closes the Incident without saving changes, a message 

box will open asking if they want to save changes before closing. 
 6. Click Yes to save the changes before closing, click No to close without 

saving the changes, or click Cancel to return to the Incident. 

 7. Click the Save menu button or select Save from the File drop-down 
menu. 

 A message box appears indicating that the changes have been saved. 
 8. Click OK to close the panel. 

Specific Needs RequestsUsing the Specific Needs Request/Replies 
Screen 
 Specific Needs Requests (SNR) are requests for personnel or 
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materials necessary for response and recovery efforts. The Specific 
Needs Request capability provides a central area to which the 
organizations can post requests and replies.  SNR provides a 
consolidated source of information on identity, quantity, packaging, 
handling, storage, and transportation considerations.  SNR provides the 
capability to conduct an active exchange of information between 
organizations seeking outside assistance and second (supporting) 
responder organizations providing assistance.  
Use Specific Needs Request/Replies to list all requests, request line 
items and associated replies for an Incident. 

 

Use of DMI-Services  does not automatically authorize anyone to 
commit resources.  Authorization to commit resources lies within 
the policies and procedures for the Operator’s jurisdiction. 

 To Access the Specific Needs Request/Replies panel from the 
Incident List panel: 

 1. Select the Incident of interest from the Incident List.. 

 2. Click the Open SNR button. 

 The Specific Needs Request/Replies screen opens. 
 

 
 The upper part of the screen displays the requests associated with the 

selected Incident.  The fields displayed in this table come from 
information entered in the Specific Needs Request screen. 

 The lower part of the screen displays two tabs.  One tab displays the 
line items of the request.  The second tab displays the line items of the 
replies.  Replies are associated with the Request Line Items. 

 The Operator will have different filter options depending on whether they 
is a member of the sending COG or the receiving COG.  If they is an 
Operator with the sending COG, they has the option to filter the list to 
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display only Working or Sent.  
If the Operator’s COG is receiving the Request, they has the option to 
display only Working or Incoming. 
 

 
The default filter setting is to display all Specific Needs Requests. 

 From this screen, the Operator can create Specific Needs Requests, 
Reply to Specific Needs Requests, and Post Specific Needs Requests. 

 The information in the Request Line Items table comes from the 
Specific Needs Request Line Item screen. 

 

A Specific Needs Request can also be created or accessed from within 
an Incident Record. 

  

To Access Specific Needs Requests from an Incident: 
 

 
From an open Incident, click the Open SNR button. 

Creating Specific Needs Requests 
 The COG Administrator must grant permission to create Specific Needs 

Requests (SNRs).     

 1. Retrieve the Incident List for the COG. 
2. Highlight the Incident or Open the Incident.  
NOTE: Because all SNRs must be associated with an Incident Record, 
the Operator must either be inside of an Incident, or have the Incident 
highlighted before they clicks the Open SNR button. 

 3. Click the Open SNR menu button. 

 The Specific Needs Request/Replies screen opens. 

 4. Click the New button or select New SNR from the File drop-down 
menu. 

 The Specific Needs Request screen opens. 
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 5. Enter data in the fields as necessary.   
Only the SNR Number field is required. The SNR Number identifies the 
SNR.  The SNR number can contain text and numbers.  The numbering 
scheme used depends on the conventions set down by the jurisdiction. 
If an Operator does not enter contact information using the Requestor 
button, DMI-Services  displays his/her COG name in the 
Send/Attention To field after they has saved the Request. 

 Other fields on this screen:  
o Priority: Select the priority of the request from the drop-down 

list. Valid values are:  
o High  
o Low 
o Normal 
o Immediate 
o Urgent. 

o Status: Select the status of the request. Valid values are:  
o Not Assigned 
o Open Full Reply 
o Open No Reply 
o Open Partial Reply 
o Closed-Fully Provided 
o Closed-Cancelled 
o Closed-Partial. 

o Transportation Instructions:  Enter instructions on how the 
items requested should be transported. 

o Special Instructions:  Type any special instructions that 
could include special handling or instructions concerning care 
of the equipment or personnel (such as feeding, sheltering, 
etc.) 

o Deployment Instructions:  Enter any information pertinent for 
responding organizations such as where personnel should 
report. 

 6. To enter contact information, click the Requestor button.  For more 
information about the SNR Request screen, see Entering Requestor 
Information. 

 7. To enter delivery information, click the Delivery button. For more 
information about the Delivery / Attention To screen, see Entering 
Delivery Information. 
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 8. Click OK to save the changes and return to the Specific Needs 
Request /Replies screen. 

 

NOTE: When the Request Line Item is modified, DMI-Services  System 
will populate the Update Date and Time. 

Adding Request Line Items 
 
 Enter line items for a Request with the SNR Line Item screen. 

 

The Line Item number is auto-generated and cannot be edited. 
NOTE: The Operator must save the Specific Needs Request before they 
can add line items. 

 To Add a Request Line Item: 

 1. From the Specific Needs Request/Replies screen, select the 
Specific Needs Request for which the Operator is adding line items. 

 2. Double-click on the top row of the table on the Requests tab. 

 

 
 3. The Specific Needs Request Line Item screen is displayed. 

 4. Select a status from the Status drop-down list. Valid values are: 
o Open Full Reply 
o Open No Reply 
o Open Partial Reply 
o Closed - Fully Provided 
o Closed - Cancelled 
o Closed - Partial. 

 5. Select a Resource Type from the drop-down list to specify the kind 
of resource required. Valid values are:  

o Not Assigned 
o Organizational Unit 
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o Personnel 
o Equipment supplies 
o Transport 
o Other 
o Facility  

 6. Select a Capability Type from the drop-down list. Valid values are: 
o Not Assigned 
o Healthcare 
o Fire 
o Emergency 
o Personal Protective Equipment 
o Detection Equipment 
o Sanitation 
o Rescue 
o Law enforcement 
o Operational Equipment 
o Explosive Device Mitigation/Remediation 
o Interoperable Communication/Info System 
o Decontamination 
o Medical Equipment 

 The items available in the Capability Type drop-down list are 
determined by the selected Resource Type.  

 7. Enter the Item Name. 

 8. Enter the quantity required in the Quantity field. NOTE: Quantity can 
be expressed in whole numbers or in decimal values. 

 9. Select a unit of measure from the Unit of Measure field. Valid values 
are:  

o Each 
o ft  
o m  
o ft3  
o m3 
o in 
o in3  
o cm  
o cc 
o gal  



Page 121 of 220 

o liter. 

 10. Select a priority from the Priority field. Valid values are:  
o Not Assigned  
o Normal  
o High 
o Immediate  
o Urgent.  

 11. If desired, enter any additional information in the Resource 
Comments field. 

 12. Select the date and time needed from the Date/Time Needed 
calendar control. 

 13. If the selected Resource Type is Equipment, Unit, or Personnel, then 
the Operator must enter information in the Self-Sustained 
Instructions on what is needed to sustain the requested items. 

14. Click the OK button to save the changes and return to the Specific 
Needs Request/Replies screen. 
 

Entering Requestor Information 
 Use the SNR Request Form to enter information about the organization 

making the request.   

 

While none of the fields on this screen is required, it may be helpful to 
the organizations replying to the request to have the information.  If no 
information is entered on this screen, DMI-Services  will enter the COG 
Name in the Send/Attention To column. 

 To enter Requestor Information in an SNR: 
1. Click the Requestor button on the Specific Needs Request screen. 
The Requestor screen will be displayed. 

 2. Enter the name of the contact person in the Name field. 
 3. Select a role for Receiving Operator from the Role drop-down list. 
 Valid values in the Role drop-down list are:   

o Not Assigned  
o Primary POC  
o Secondary POC  
o COG 
o CMI-Services Project Team Member 
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 4. Enter address information in the Address Line 1 and Address Line 
2 fields. 

5. Enter the City. 
6. Enter the State. 
7. Enter the Country. 
8. Enter the Postal Code. 
9. Enter the Cross Streets (if any). 
10. Click the OK button to save the changes and return to the Specific 

Needs Request screen.  Or click the Cancel button to cancel the 
changes and return to the Specific Needs Request screen. 

Entering Delivery Information 
 Use the SNR Delivery /Attention To screen to enter information about 

where to deliver the requested personnel or equipment.  While none of 
the fields on this screen is required, the organization fulfilling the request 
may find the information quite helpful. 

 
To enter Delivery / Attention To Information in a SNR: 
1. Click the Delivery button on the Specific Needs Request screen. 
The Delivery screen will be displayed. 

 2. Select the Attention To COG from a drop-down list of all current 
operating COGs. 
 

 

NOTE: Though the SNR will be sent to all of the COGS to which the 
Incident Record was posted, the Attention To designation lets 
receiving COGs know which COG should fulfill this particular Request 
Line Item. 

 3. Enter the name of the point of contact receiving the request in the 
Name field. 

4. Select the receiving Operator's Role from the drop-down list.  Valid 
values are:  

o Not Assigned  
o Primary POC  
o Secondary POC  
o COG 
o CMI-Services Project Team Member 

 5. Enter street address in the Address Line 1 and Address Line 
2 fields. 

6. Enter the City. 
7. Enter the State. 
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8. Enter the Postal Code. 
9. Enter the Country Code. 
10. Enter the Cross Streets (if any). 
11. If desired, the Operator can enter Latitude and Longitude 

information and convert the information to degrees. 
12. Enter a name for the site in the Site Name field. 
13. Enter a description in the Description field. 
14. To plot the site on the Incident Map, click the Plot on Map checkbox. 
15. Click the OK button to save the changes and return to the Specific 

Needs Request screen. 
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Send a Specific Needs Request 
 To send a saved SNR: 

1. Highlight the saved SNR by clicking on the appropriate SNR in the 
top portion of the Working tab. 

2. Click the Send button on the Specific Needs Request screen. 
The Send SNR screen will be displayed. 

 
 3. Click the OK button to send the SNR. (Or click the Cancel button to 

cancel the operation.) 
The DMI-Services  System will send the SNR to the COGs to which 
the Incident Record had been posted.  
A confirmation dialog box is displayed.  

4. Click the OK button to acknowledge the Sent notification.  
 

 

NOTE: A Specific Needs Request can only be sent if the Incident 
Record with which it is associated has been posted. 
 

Replying to Specific Needs Requests 
 
 The COG Administrator must grant an Operator permission to reply to a 

Specific Needs Request.   
  

To reply to a Specific Needs Request: 
 1. Retrieve the Incident List for the COG. 

2. Select the appropriate Incident. 

 3. Click the Open SNR button.    
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An Operator also has the option to open the Incident and access 
Specific Needs Request from the Incident. 

 The Specific Needs Request/Replies screen opens. 
 For best results, select the Incoming tab to view only the Requests 

being sent to the COG. 
 4. Select the appropriate Request. 

5. Double-click on the line item that will be fulfilled. 
 The Specific Needs Request Line Item screen opens. 

 6. Click the Reply button. 
 7. The Reply screen is displayed. 

8. Enter a Reply number in the Reply Number field. 
9. Enter any desired comments in the Comments field. 
10. DMI-Services  display the line item number in the Line Item Number 

field. 

 

In a Reply to a Specific Needs Request, the Status, Resource Type, 
Capability Type, Item Name, Quantity, Unit of Measure, Priority, 
Resource Comments, Date/Time Needed, and Self-sustained 
Instructions are viewable in non-editable text. 

 The Reply area includes the following fields: Quantity, Unit of Measure, 
and Remarks.   

 11. Enter the Quantity and select a Unit of Measure. (Quantity can be 
entered in whole numbers or in decimal values.) 

12. If desired, the Operator can enter comments in the Remarks field. 
13. Click the OK button to return to the Specific Needs Request Line 

Item screen. 
14. Click the OK button on the Specific Needs Request Line Item screen 

to return to the Specific Needs Requests/Replies screen. 
 DMI-Services  places the Reply line item on the Reply tab.  To view the 

line item, click the Reply tab. 
 

 

Remember, when an Incident Record is transferred to another COG, 
any Specific Needs Requests and Replies associated with that Incident 
Record are transferred to the new COG. 

Archiving Incidents 
 
 The Archive function in DMI-Services  enables COGs to retain completed 
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and final incidents along with exercises and any internal training incidents 
in a separate and permanent repository.  These incidents provide an 
historical snapshot of all COG activities, and allow EOC managers to 
review performance in a given incident. 
 
Moreover, archived incidents show the interaction between responders 
over time and may be used in developing or refining procedures and 
training exercises.   
 
A COG may choose to take advantage of the DMI-SERVICES    Archive 
capability for any number of reasons.  Typical reasons are:   
o All interactions with Federal and state authorities are complete; 
o Completed incidents do not require further action; 
o The COG wants to keep Training and Exercise records in the Archive. 
In any case, archiving retains COG Incident Records in a view-only mode 
– that is, once archived an Incident Record may not be altered in any 
way. 
If a COG responds to recurring incidents such as floods, major traffic 
jams, or any other repetitive event, the Organization may wish to save a 
copy of an incident as a template to be used later.  
For more information about the Save Copy feature, see Saving a 
Copy of an Incident Record. 
Before an incident can be archived, its Incident Status must be set to 
“Closed.” 
Remember, an Archived Incident Record cannot be modified or 
transferred and will appear in view-only mode in the Archived 
Incident List of the originating COG. If the Incident Record had been 
posted to other COGs, those records will be removed from their 
Active Incident Lists and will be placed into that COG’s Archived 
Incident List.  

 

NOTE: Only a Primary Operator may archive an Incident Record. 
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How to Archive an Incident 
 Only Primary Operators have the authority to archive incidents.   

1. Retrieve the Incident List. 
2. Select and open the Incident Record by double-clicking on the 

appropriate item in the Active Incidents List. Or select the appropriate 
record and select “Open” from the File drop-down menu. 

The DMI-Services  System opens and displays the selected Incident 
Record’s Core Incident Information panel. 
3. Select the Edit Data icon to activate Edit Mode. 
4. If the incident hasn’t already been closed, select the “Closed” option 

in the Incident Status drop-down list and press the Save button. 

 
 

5. Select “Archive” from the File drop-down menu. 
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 6. The DMI-Services  System displays a dialog box with the message: 
"Do you want to archive this record?” and presents the Operator with 
choices for Yes, No and Cancel.  Select Yes to archive the Incident. 

 
NOTE:  It is possible for another Operator to be in the Incident Record 
when the initial Operator is trying to archive it.  In that case, the Incident 
Record will be archived after the second Operator has exited the record. 
 
7. Select the Yes button.  DMI-Services  will display a dialog box stating 

“Archive succeeded” along with a command button to acknowledge 
the message.  

 
(NOTE: If No or Cancel is selected, the dialog box will close and the 
Incident will remain open in the active Incident List.) 
 
8. Select the OK button on the dialog box to acknowledge the “Archive 

succeeded” message. 
 

9. The Incident Record panel will close and then the active Incident List 
will refresh. The recently Archived Incident Record will no longer be 
displayed in the active Incident List but it may still be viewed in the 
Archived Incident List. 

 Remember, whenever an Incident Record is archived, any 
Attachments and any Specific Needs Requests associated with it are 
also archived. 

 NOTE: Only a Primary Operator may archive an Incident Record. 
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Using the Archived Incident List 
 All archived Incident Records will be displayed in a COG’s Archived 

Incident List.  The Archived Incident List displays incidents created by the 
COG’s Operators as well as incidents posted by other COGs. 
 
The archived Incident List is accessed by selecting Archived Incident 
List from the Tactical Information Exchange submenu of DMI-Services 
.  

 

 
 The Archived Incident List works much like the active Incident List. An 

Operator can sort and filter the list, view archived Incidents and Generate 
Reports. 
 
Because these incidents have been closed and archived, an Operator 
may only view the Incident Record. The Operator may not alter data and 
may not transfer the Incident Record to another COG. 
 
An Operator may view attachments to an Archived Incident Record and 
may view all Specific Needs Requests. 

 Symbols in the Archived Incident List 
 Icon Description 
  Archived Incident 
  Archived Incident with Attachment 
  Incident has Specific Needs Requests 
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Sorting the Archived Incident List 
 To sort the Archived Incident List by a particular field, click on the 

appropriate column heading.  
 NOTE: The default sort order for the Archived Incidents List is by status 

(posted then received) and within that order by date. The working version 
will be renumbered as the latest numbered version of the Archived 
Incident Record. 

 If, for example, five (5) versions of a record exist and version 3 is 
archived, versions 1 and 2 will NOT be archived.   

 

 

 Remember the working version? The working version of an Incident 
Record is the initial version of the Incident that the Primary Operator is 
always modifying. 
When the Operator archives either the working version (version 0) or the 
last numbered version an Incident Record, all prior versions of that 
incident are archived as well.  In the case of the working version, it will be 
renumbered to be last version number.  

 For example, if version 5 is archived, all versions (1, 2, 3, and 4) are 
archived as well.   
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 When the working version of an Incident Record is archived, all versions 
of the incident are archived and the version number of the working 
version will be renumbered as the latest version number.  For example, if 
there are five (5) posted versions of the incident 
01252005_GasMainRupture and the working version of that incident is 
archived, then working version (version 0) is renumbered by the DMI-
Services  System as version 6 and is placed in the Archived Incident List. 
 See the illustration. 

Generating Archived Incident List Reports 
 Two types of reports are available: list reports and detail reports.  The list 

reports, which are generated from the Archived Incident List screen, 
include the Posted Incident List Report and the Archived Incident List 
Report.  The Incident Detail Reports are generated from within an 
Incident. 

 An Operator can filter the list of reports. 
The Posted Incident List Report generates a summary report of all 
Incidents Posted to and from the Operator’s COG.  The Archived 
Incident List Report generates a summary report of all archived 
Incidents in the COG. 

 1. Retrieve the Archived Incident List. 
2. Select Reports from the DMI-Services  menu. 
3. The Reports screen opens. 
4. Select the type of report to be produced. 
5. Click OK to generate the report. (Or, click Cancel to cancel the 

report.) 
 

 
 6. Click OK.   
 The Select Subreports screen opens. 
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 7. Click on each sub-report that is to be included in the report.   Use the 

Shift key or the Ctrl key to select more than one sub-report at a time. 
 The Shift key selects consecutive items and the Ctrl key selects only 
one sub-report. 

8. Click OK to generate the report. (Or, click Cancel to cancel the report.) 
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CHAPTER 6: Using the Weather Tool 
About the Weather Tool 

 

Much like many weather tools on the Internet, the DMI-Services Weather 
Tool enables the Operator to obtain a weather forecast for a specific 
Postal Code.  By default, the Postal Code contained in the Operator's 
Profile is used when no Postal Code is supplied. 
 

  
 The tool provides weather forecast information on an hour-by-hour basis 

for the next 48 hours.   
The weather tool provides: 

o Increased speed of weather information delivered to those who 
need it 

o Increased resolution of weather information. 
 Using the tree view on the left, the forecast, radar image, and alerts may 

be displayed for the Postal Code area. 
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Viewing Local Weather Forecasts 
 The DMI-Services Weather Tool enables the Operator to view local 

weather forecasts based on the Postal Code. The data is 
automatically updated at regular intervals. 

 

NOTE: When the local Weather Forecasts tool is used independent of 
TIE, no data is posted. 

 
 Access the Weather Tool from the Disaster Management Tools menu, located 

in the DMI-Services menu. 
 

 To access the DMI-Services Weather Tool using the Disaster Management 
Tools menu: 

 1. From the DMI-Services menu → Select Disaster Management Tools →  
Select Weather Forecast Tool  

 The Weather Tool screen opens. 

 2. Enter the Postal Code in the field provided and click the Go button. 
 DMI-Services refresh the screen to display the forecast for the entered Postal 

Code. 
 

 
 3. To view Radar data, select Radar from the WEATHER DATA tree in the left 

pane. 
 The Radar screen opens. 



Page 135 of 220 

 

 
 4. To view current weather alerts, select Alerts from the WEATHER DATA tree 

in the left pane. 
 The Alerts screen opens. 
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 Field Description 
Date When Operator is viewing the Current 

Weather, this is the current date. 
 When the Operator is viewing a local 
forecast, this is the date the forecast is 
for. 

Time When Operator is viewing the Current 
Weather, this is the current Time. 
 When the Operator is viewing a local 
forecast, this is the time of day the 
forecast is for. 

UV Index Ultraviolet Index 
Cloud Cover (%) Percentage of cloud cover 
Current Weather Conditions Rain, Snow, Ice, Sleet, Freezing Rain, 

Partly Sunny, Mostly Sunny, Partly 
Cloudy, Mostly Cloudy 

Precipitation Type Rain, Snow, Ice, Sleet 
Ceiling Height (ft x 100) The height of the lowest layer of 

broken or overcast clouds.  
Wind Direction (Compass) The direction from which the wind is 

coming.  For example, an easterly wind 
is blowing from the east, not toward the 
east.  It is reported with reference to 
true north, or 360 degrees on the 
compass, and expressed to the 
nearest 10 degrees, or to one of the 16 
points of the compass (N, NE, WNW, 
etc.). 

Relative Humidity (%)  The ratio of the water vapor pressure 
or water vapor content to the saturation 
vapor pressure or the maximum vapor 
content at the temperature of the air or 
gas. The saturation vapor pressure in 
the air varies with air temperature, the 
higher the temperature, the more water 
vapor it can hold.  When saturated, the 
relative humidity in the air is 100 %RH.  

Visibility (mi) A measure of the opacity of the 
atmosphere, and therefore, the 
greatest distance one can see 
prominent objects with normal 
eyesight. 

Temperature (degrees F) The free air or ambient temperature 
close to the surface of the earth, 
measured in Celsius or Fahrenheit. 
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Real Feel Temperature (degrees F) How the temperature seems to feel, 
taking into account humidity and wind, 
etc. 

Dew Point (degrees F) The temperature to which air must be 
cooled at a constant pressure to 
become saturated.  

Wet bulb Dependent on the temperature and the 
humidity of the air, it is the difference 
between the dry bulb and the wet bulb 
readings.  

Wind Speed (mph) The rate of the motion of the air on a 
unit of time. It can be measured in a 
number of ways. In observing, it is 
measured in knots, or nautical miles 
per hour. The unit most often used in 
the United States is miles per hour.  

Wind Gust (mph) A sudden significant increase in or 
rapid fluctuations of wind speed. Peak 
wind must reach at least 16 knots (18 
miles per hour) and the variation 
between peaks and lulls is at least 10 
knots (11.5 miles per hour). The 
duration is usually less twenty 
seconds. 

Hourly Snow (in) The amount of snow that falls within an 
hour. 

Hourly Ice (in) The amount of ice that falls within an 
hour. 

Hourly Rain (in) The amount of ice that falls within an 
hour. 

Hourly Liquid Equivalent (in)  A way of measuring frozen 
precipitation -- the amount of 
precipitation that would be as a liquid.  
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Using the Radar Screen 
 
 The Radar Screen displays the current date and time. 
 A radar image of incoming weather for the region that contains the Postal 

Code for which the Operator is viewing weather forecast data is 
displayed. 

 Use the scroll bars to move around the radar image.  On the far right of 
the screen is a legend explaining the colors on the image. 

 

 
 
Using the Weather Alerts Screen 
 The Weather Alerts screen displays any watches or warnings that have been 

issued as of the date and time displayed on the screen. 

 

 

 On the far bottom of the screen is a legend explaining the colors used on the 
map. 
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CHAPTER 7: Using the Map Tool (also known as GIS) 
Accessing the Incident Map 
 To access the Map in TIE, open the Incident from the Incident List and 

click on the Map icon.  
 The map panel opens. 

 
GIS Tool Bar Buttons 
 
 The following are tools available to use with the map: 

 

 

Letter Meaning Letter Meaning 
A Open J Pan Right 
B Save K Pan 
C Set Map 

Properties 
L Find 

D Set Area of 
Interest 

M Identify 

E Zoom In N Refresh 
F Zoom Out O Import Marplot 
G Pan Up P Toggle Auto 

Collaboration 
H Pan Down Q Share 
I Pan Left   
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Adding Layers to the Incident Map 
 
 The map layers are symbolized and controlled by the tree structure to the 

right of the map.  Scroll to the right to display the tree structure. 
There are two types of layers:  Personal and Public.  Personal layers may 
be kept personal.  Public layers include layers added by the COG or by 
other COGs in Incidents that have been posted.  Layers created by 
members of one COG cannot be edited by another COG's Operators. 
To add layers: 
1. Right-Click in the layer area; and  
2. Select Add from the right-click menu. 

A page icon will appear with the default name of "layer." The Operator 
may want to rename the layer. 

To add sub-layers: 
1. Right-Click in the appropriate layer; and  
2. Select Add from the right-click menu. 

A page icon will appear with the default name of "layer." The Operator 
may want to rename the layer. 

 
NOTE: An Operator cannot add sub-layers to the Plotted Locations layer. 
 
To  rename the layer: 
1. Right-Click on the layer to be renamed; and  
2. Select Rename from the right-click menu. 
3. Press the Return key to save the new name. 
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Moving Through the Incident Map Layers 
 
 Moving through map layers is much like moving through the panels of an 

Incident.  To move from layer to layer, click on the icon for the layer. 
 The symbols indicate the type of markings on the map.  There are site 
markings, property damage markings, sheltering information, and 
medical facility layers. 

 

Remember an Operator can create sub layers to further refine the type 
of information on the layer.  For example, the Operator can have a layer 
that only contains Police information. 

 

 

 The layer that has the Operator’s name associated with it is the personal 
layer.  A personal layer can be used to keep an Operator’s mark-ups 
private.  To share the items on the personal layer, the Operator must cut 
them from the personal layer and paste them to the COG's layer. 
The next layer is called "Plotted Locations."  Items for this layer come 
from plotted locations on the Incident panels such as Site Information 
and Medical Information. 
The next layer is the originating COG’s layer.   
If the Incident has been posted to another COG and that COG has 
marked up the map, that COG will also have a layer. 

 

If an Operator un-selects the checkbox next to the layer name, any 
markups associated with that layer will no longer display.   
 
When a "parent" layer" is turned off, its “child” layers and any 
markups associated with them will not display. 



Page 143 of 220 

 

Using Web Map Services 
 
 DMI-Services provides for automatic creation of layers on an incident 

map through the use of the “Invoke Web Map Services” button.  This 
feature enables Operators to import layers such as Q3 flood planes and 
aerial photographs (also known as ortho-images). 

 To use Web Map Services: 

1. Select the Web Map Services Button .  
The DMI-Services System displays the Web Map Services (WMS) 
selection dialog box.  

 

 

 2. Choose a service from among the providers by clicking on the 
provider’s name.  

 
Currently there are five product providers. Their corresponding layers 
are as follows: 

 United States Geological Service (USGS) Geological Naming 
Information Service (GNIS).  This service offers layers providing the 
names of water features (creeks, rivers, lakes, etc.), parks, and 
populated places, plus the above sea-level height of summits 
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(mountains). 
Hazardmaps.gov is a service of the Federal Emergency 
Management Agency.  The maps culled from this web site provide 
layers useful in flooding scenarios. 
USGS’ Urban Areas Orthoimagery.  Ortho-images zoom in and out 
to match the view of the base map, and provide a valuable reminder 
to responders of what terrain features and structures exist 
surrounding the incident area. As high resolution ortho images of 
urban areas become available from USGS, the DMI-Services System 
makes them retrievable here.  Retrieval time is a bit longer, but the 
resolution of the aerial photographs is excellent.  
Microsoft TerraService offers two types of layers. The first is 
medium resolution ortho-images of the entire United States; the 
second is “raster” graphics.  The medium resolution aerial 
photographs are often clear enough for emergency response 
purposes and download faster than the high resolution images. 
Raster graphics are robust map images that show topographic lines 
of elevation with water and populated area features and names.  
Iowa Environmental Mesonet (IEM) RadView Service offers US 
Radar - NEXRAD, a composite of US Radar services updated every 
five (5) minutes. 
United States Geological Survey.  The Natural Hazards Support 
System (NHSS) enables users to monitor and analyze natural 
hazards events as they are occurring anywhere on the Earth. For 
example, as a hurricane nears shoreline, NHSS users can pinpoint 
the current location of the hurricane, and can access near real-time 
information on stream levels, wind speeds, and tide conditions. This 
information is presented in an integrated geospatial view that 
combines the dynamic natural hazards events with a rich set of 
reference data including shaded relief, transportation, and 
hydrograph.  The United States Geological Survey (USGS) Rocky 
Mountain Geographic Science Center (RMGSC) developed NHSS to 
aid in monitoring, responding to, and analyzing current natural 
hazards events. This is achieved by NHSS’ combination of 
information that allows users to easily monitor either a single natural 
hazard event or see the geospatial relationships of different natural 
hazards events. 

 3. Click on the layer name description of the desired layer. 
4. Select the Add button. 
5. The DMI-Services System retrieves the layer and displays it in the 

map window. At the same time the new layer will be represented in 
the layer tree along the right side of the map. Features retrieved are 
visible on the map.  
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6. Set the transparency of a Web Map Service layer by right-clicking the 
appropriate Web Map Service layer and select Transparency from 
the right-click menu. Use the slider to indicate the level of 
transparency. The scale goes from zero to 100% in increments of five 
percent (5%). By default the transparency is set to 100%. 

 

 

 

NOTE: The feature data retrieved is only as good at the data offered by 
the provider. The data offered by the provider is only as good as the data 
given by local governments when it was sent to the provider. DMI-
Services simply serves the data and cannot guarantee its completeness 
or accuracy. 

Tips for Using Map Layers 
 
 When an Operator clears the checkbox next to a map layer, the visible 

symbols and markings associated with the layer will no longer display.  
All markings associated with “child” layers to that “parent” layer will no 
longer display.  It may be a good idea to add layers logically so markups 
on each layer are complementary – the next layer builds upon the 
previous layers. 

 

Consider the difference in the following scenarios.  In the first scenario, 
there is a layer that has two child layers.  The parent layer is called Car 
Accident and the child layers are called Police and Fire.  If an Operator 
chose to hide the Car Accident layer (by clearing the checkbox next to 
the words Car Accident), the information associated with the layers 
Police and Fire would also be hidden. 
Now consider the following scenario: If the Car Accident layer and the 
Police and Fire layers were all on the same level, the Operator could hide 
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Car Accident and still display Police and Fire information. 
 Another point to keep in mind is that the names of layers named for the 

panels that populate them cannot be changed.   For example, if a layer is 
named Site because the points that are plotted on it came from the Site 
Information panel, the Operator cannot change its name and it will 
always be called Site.  Also, an Operator cannot add markups on layers 
such as the Site layer. 
Keep in mind the difference in an Operator’s personal layers and the 
COG’s layers.  When an Operator marks up personal layers, they must 
cut and paste them to the COG's layer.  The Operator can only mark up 
either personal layers or layers owned by his/her COG.  An Operator of 
one COG cannot add markups on layers owned by other COGs. 

Marking Up the Incident Map 
 
 The mapping application comes with several tools to enable an Operator 

to easily mark up the map as appropriate. 
The Operator can add lines, shapes, dots, etc. 
Choose from several symbols on the symbol palette to denote police, 
hospitals, schools, etc. 
To change the color of a line: 
1. Right-click on the line and select the Attributes command.   
2. From the Attributes cascaded menu, select Line.   
3. To select the color, click Select Color, then select a color from the 

color picker screen. 
 To change the color of the fill in a filled shape: 

1. Right-click on the shape and select the Attributes command. 
2. From the Attributes cascaded menu, select Fill. 
3. To select the color, click Select Color, then select a color from the 

color picker screen. 

 

To move a shape elsewhere on the map, delete the shape and draw 
another one. 



Page 147 of 220 

 
Use  To 

 
Pen 

To draw a freehand line: 
1. Click the place on the map to start the line; and  
2. Hold down the left mouse button. 
3. Drag the cursor to the place where the line will end.  
4. Release the left mouse button. 

The line will display on the map.  To change the color of the 
line use the Attributes command. 

 
Fill 
Polygon 

To draw polygons: 
1. Click the polygon icon.   
2. While holding down the SHIFT key, click on the area 

of the map where the polygon starts.   
3. Click on the areas on the map where the corners will 

be.   
4. When finished drawing the polygon, release the 

SHIFT key.   
The polygon will be complete.  
To change the color of the line and the fill, use the 
Attributes command. 

or  
Rectangles 

To draw rectangles on the map, use the Rectangle button. 
 Remember, there is the option of filled or empty rectangles. 
 To change the color of the line and the fill using the 
Attributes command. 

 
Text 

To enter text on the screen, use the text icon.   
To enter text: 

1. Click the text button; and 
2. Click on the map where the text should display.    
3. Enter the desired Text and  
4. Press the Enter key. 

or  
Circles 

Use the circle icon to make circles on the map.   
To make the circle: 

1. Click the desired circle button and  
2. Click on the map where the circle should display.  

Change the color of the line and the fill by using the 
Attributes command. 

 
Line 

To draw a line: 
1. Click on the line button; and 
2. Click on the map where the line should appear.   
3. Drag the line to the point where it should end; and  
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4. Click to terminate the line. 

Adding Symbols to the Incident Map 
 To add symbols to the map, use the symbol palette to the left of the map. 

 From this palette select symbols to place on the map. The symbols to 
denote police, hospitals, schools, natural events, operations, etc. 
 
To add a symbol: 

1. Click once on the symbol; and  
2. Drag it onto the appropriate spot on the map.  

 
Use tabs to move through the categories of symbols (Medical, 
Incident, Hazard, Fire and Police). 
Specify a Damage/Operational Status level for any Operational or 
Infrastructure symbol on an Incident map layer. The status levels 
are defined by the Homeland Security Working Group Symbology 
Reference (http://www.fgdc.gov/HSWG) and are reflected in the 
various color-coded symbol borders. The status levels are: 
Level 1 - Fully operational/open 

  
Level 2 - Operational, but filled 
to capacity or otherwise closed 

 
Level 3 - Operational, but 
partially damaged or partially 
incapacitated  
Level 4 - Destroyed or totally 
incapacitated 

 
By default there no status level is assigned to a symbol. 
 
 

http://www.fgdc.gov/HSWG


Page 149 of 220 

 

 

 

Nearly all of the map symbols used in DMI-Services are part of the 
standard Homeland Security Working Group Symbology Reference. 
This reference, containing Emergency Management Symbols, can 
be found online at www.fgdc.gov/HSWG. 
See Map Symbols  

Creating Links from Map Markups 
 An Operator can create a link from a drag/drop markup object on a layer to 

a locally stored file.  Link a markup on the map to a floor plan .jpg file, 
MSDS document, or any other file relevant to the markup.  

 To create a link:   

1. Activate the cursor by selecting the cursor button  at the bottom of 
the map. 

2. Right click the markup object; and 
3. Select the Link menu item. 
 

 
 

4. Enter the path to the file if known, or use the Browse command to 
search for the file desired.  

5. When the file is found, highlight it and  
6. Select the Link button. 
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The cursor will become an hour glass while the link is being established. 
 Once established, the object displays a small arrow at its lower left corner.   

 To view the linked file, simply double-click on the markup object. 

Deleting Lines, Shapes, and Symbols 
 All of the lines, shapes, and symbols added by an Operator may also be 

deleted. To delete any line, shape or symbol placed on the map, just place 
the cursor on the item, right-click on it and select Delete from the right-click 
menu. 

 
 Icons (such as stars) that correspond to sites that have been plotted from 

addresses entered on other panels (such as the Site Information panel) 
cannot be deleted like any other symbol.   
To remove these sites, deselect the Plot on Map checkbox on the 
corresponding panel.     

Icons plotted using the Find Icon  will be deleted if the Operator closes 
the Incident and re-opens it. 
EXAMPLE: Here’s how to delete the Hospital symbol that an Operator 
places on the map from the palette versus deleting the Hospital symbol that 
appears when the Operator checks the Plot on Map checkbox for an 
address on the Medical Information panel.   
Delete the symbol from the palette by right-clicking. 
The other symbol can be hidden by either de-selecting the Plot on Map 
checkbox or by de-selecting the checkbox for the Medical Facilities layer. 

 

 
 As shown above, the checkbox for Medical Facilities layer is not selected, 

yet the Hospital symbol still appears on the map because it was placed on 
the map from the palette. 
For more information about working with layers, see Tips for Using Layers. 
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Cutting and Pasting Shapes 
 An Operator can cut objects from one layer and paste them onto another. 

 When the Cut command is used, it applies to all markups on the selected 
layer.  This feature is useful if the Operator wants to transfer markups 
from his/her personal layer to the layer owned by the COG. 

 1. To cut the items on a map, select the layer from which the items will be 
cut.   

2. Right-click on the layer and select Cut Features from the menu. 
3. Select the layer to which the item will be pasted. 
4. Right-click on the layer and select Paste from the menu. 

 

 

Tips for Plotting Areas on the Incident Map 
 When an Operator enters address information on other panels in TIE that 

contain a Plot on Map checkbox, the address is plotted on the Map.   
NOTE: The more accurate the address information, the more accurate the 
plot will be on the Map.  While not all fields are required to save the 
incident information, it helps to have state and Postal Code included to 
more accurately plotting a point on the map, especially if unsure about the 
street address. 

Refreshing the Incident Map 

 At times, it may be necessary to refresh the map.  To refresh the map, 
click the Refresh tool. 
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When refreshing the map, it is re-loaded from the server. Reloading 
can be slow, depending on the speed of the Operator's Internet 
connection. 

Sharing the Incident Map 
 
 The Share tool and the Auto Collaboration tool work together.   

 
Auto-Collaboration lets an Operator work with all other COG Operators 
in marking up map layers. 
 
If Auto Collaboration is turned off, the marked-up layers cannot be 
shared with anyone -- including the members of the Operator's own 
COG. 
 
However, the Operator can click on the Share icon to share markups 
with the members of the COG when not in Auto Collaboration mode. 

 

NOTE:  Any shapes placed on the personal layer will not be shared 
even when the Operator clicks the Share button. 
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Using the Snap Command 
 
 Use the Snap command to quickly bring into focus the area where all 

markups exist for a layer and any associated child layers.  
Suppose an Operator has been panning around the map and their view of 
the map has moved away from the initial area of interest.  The Operator 
can select the layer on which markups reside and use the right-click menu 
to "snap to" that new area of the map (even if the area is not visible). 
Icons for that layer and its "children" are displayed. 

 To use the snap command: 
1. Select the layer of the map on which the markups display. 
2. Right-click on the layer; and    
3. Select Snap to from the right-click menu. 

 

 

Toggling Auto Collaboration 
 
 The Auto Collaboration mode enables an Operator to share his/her 

markups with the other members of their COG.  If the Operator does not 
want to share his/her markups, they can turn off Auto Collaboration. 

 Auto Collaboration and Share work together. If the Operator has Auto 
Collaboration turned off, they can share markups periodically by clicking 
on the Share button. 

 To toggle the Auto Collaboration on or off, click the Auto Collaboration 
button. 

 
Saving Incident Map Files 
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 The Operator can save snapshots of maps in a .jpg format to share with 

others or import into another application. 

 
1. After making changes to the map or zooming in as appropriate, click 

the Save button. 
 The Save dialog box opens. 
 

2. Select the folder in which the map will be saved.  Use  to create a 
new folder in the current directory.  The Operator can use the drop-

down list to find the desired folder or use the  up one folder icon. 
 

 
 3. Enter a name for the file in the File Name field and click Save. 

 

NOTE: The only file type available to save a map in is the .jpg file type. 

Opening Saved Incident Maps 
 
 1. To open a saved map, click on the Open file icon. 

The Open File dialog box opens. 
2. Select the name of the file to open and click OK.  If necessary, 

browse for the appropriate file by using the Look in drop-down 
menu. 

 

 
 The Open File dialog box works much like the Windows Open File 
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dialog box.  

 

NOTE: The only file type available to save a map in is the .jpg file type. 

Setting the Area of Interest 
 

 
Use the Set Area of Interest tool to zoom in on a specific area on the map. 
 This tool gives an Operator more control over the zooming-in process than 
the Zoom Tool.  While the Zoom Tool only zooms in on the general area of 
the map, the Set Area of Interest tool zooms in only on the area specified.   
To use this tool, click on the tool button and then click on the map near the 
area of interest on the map.  Drag the cursor across the map to an endpoint 
for the zoom. Now release the mouse button. The map will show the 
zoomed-in view of the area of interest. 

 Suppose an Operator needs to zoom in on Three Rivers Stadium.  Click on 
the map just to the top-left of the stadium complex.  Drag the box over the 
map and release the mouse button when the stadium complex is enclosed 
in the box.  When the map is refreshed, the stadium complex will be the 
most prominent area on the map. 
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Using the Zoom Tool 

 
Use the Zoom tool to zoom in on the map.  An Operator will not have as 
much control over the area that is zoomed in as with the Navigation tool. 
  

 

The Zoom Tool zooms in on the general area of the map currently 
being displayed. 

Finding Addresses 
 
 Enter address information on this screen to plot it on the map. To plot 

the address: 

 
1.  Click the Find icon. 
The Find dialog box opens. 
Search on an address or a coordinate. 

 2a. Enter information in the Street, City, State, Country, and Postal 
code fields; or 
2b. select the Coordinate radio button and enter the coordinates for 
Latitude and Longitude in their appropriate fields.   
3.  Click OK to plot the address (or click Cancel to cancel the operation). 

 

A red star will appear on the map to indicate the address. This star will 
only remain as long as the Operator is in the Incident.   
 
NOTE: Only stars that represent sites entered in the Site Information 
panel will be saved.   If the Operator closes the Incident and later returns 
to the map, the red star will no longer be there.  

Using the Identify Tool 
 
 Use the Identify Tool to identify an address on a map. 

 1. To use the identify tool, click the Identify icon on the Map's toolbar. 
 2. Right click on a symbol on the map → select address 
 3. The address is displayed. 
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 4. Click anywhere outside of the option box to close. 

Importing Shape Files 
 
 Use Desktop Mapping to import Shape Files.  Remember the information 

being imported must be in a .shp file format. 
To import a Shape File, the Operator must be in the map panel of TIE.  

 1. Click the import button. 
The Import Shape File screen opens. 
2. Select the file to be imported (this is the file in the .shp Shape File 

format). 
3. Click Open to import the file or Cancel to cancel the import. 
 

Importing Marplot Files 
 
 Use Desktop Mapping to import Marplot Files.  Carefully plan what will be 

exported from Marplot, as only one type of information may be imported at 
a time. The reason only one type of information may be imported at a time 
is that the Operator must choose a symbol to represent all of the data 
being imported.  Also, remember the information being exported from 
Marplot must be in a .txt file format. 
To import a Marplot File, the Operator must be in the map panel of TIE.     

 1. Click the import button. 
The Import Marplot screen opens. 

2. Select the file to be imported (this would be the .txt file that was 
created when the Operator originally exported the map in Marplot). 

 3. Click Open to import the file or Cancel to cancel the import. 

Saving the Incident Map Properties 
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 An Operator may save a default map view for all new Incidents.  This lets 
the Operator choose to have a certain locality in focus every time the map 
is opened.  If the Operator plots something outside of the locality chosen 
as a default, the map will first open to the default setting, and then display 
the plotted address. 
To save the map property: 

1. Find the desired locality and zoom in or out as appropriate.  

 2. Click the Save Map Properties icon.  
 The following dialog box is displayed. 

 
 3. Click OK to close the dialog box. 

Using the Panning Tools 
 
 Use the Panning Tools to move the area of the map being viewed. 
 The arrows indicate the direction in which the Operator is panning. 

 
 

Use the Pan Tool  to pan on a specific point.  This tool lets the 
Operator quickly move the part of the map being viewed so that the area 
of interest at is in the center of the screen. 

 The zoom stays the same when using the panning tool. 
 Suppose the Operator has zoomed in on an area of the city and wants to 

move the view of the map to an area just to the right.  Click once on the 
arrow pointing to the right.  When the map is refreshed, the Operator will 
see the area just to the right of the previous location. 
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CHAPTER 8: COG Location Map 
 Use the COG Location Map to obtain information about other COGs. This 

map enables COG Operators to see neighboring COGs, determine COG 
location and obtain Point of Contact information.  
 
Select DMI-Services ► Disaster Management Tools ► COG Location Map. 
 

 
 
The DMI-Services System will display a map of the area surrounding a 
COG’s geographic center. The map shows stars representing each COG in 
that area. To view details on a given COG, right-click the appropriate star 
and then click on the Details icon. DMI-Services  will display a screen 
containing the following COG information: 
 

o COG Name 
o COG Address 
o City 
o State 
o Country  
o Postal Code 
o POC Name 
o POC Title 
o Office Phone Number 
o Email Address 

 
Use the controls on the View Neighboring COGs map to obtain detailed 
information about COGs including location and Points of Contact 
information. 
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  View Neighboring COG Map Buttons 
 Button Description 
 

 
Enables the Operator to select an appropriate Incident 

 
 

Refreshes Incident and Site information 

 
 

Saves map display as printable image 

 
 

Saves map display settings 

 
 

Reverts to saved display settings 

 
 

Zooms in on a selected area 

 
 

Zooms out 

 
 

Pans left 

 
 

Pans right 

 
 

Pans up 

 
 

Pans down 

 
 

Provides details for an Incident 

Using the Zoom Tools 
 Use the Zoom Tools to zoom in and out on the COG Location Map. 
 To Zoom in an area of the map: 

 1. From the map, click the Zoom In button. 
 2. Drag the cursor across an area of interest. 
 DMI-Services briefly display a grid over the area selected to zoom in 

on. 
 DMI-Services refresh the map to display the area of interest. 
 Continue to zoom in until the map is at the desired magnification. 
 To Zoom out: 

 1. Click the Zoom Out button. 
 DMI-Services refresh the map. 
 Continue to click the Zoom Out button until the map is at the desired 

magnification. 

Using the Panning Tools 
 Use the Panning Tools to move up, down, left, or right on the COG 

Location Map. 
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 Use the following button to pan the map: 
 Button Description 
 

 
Pans left 

 
 

Pans right 

 
 

Pans up 

 
 

Pans down 
 

Displaying Details for a COG on the Map 
 Display the details of a COG on the COG Location Map. 
 To view the details of a COG: 
 1. From the COG Location Map, click on a COG (indicated by a yellow 

star). 
 DMI-Services highlight the star to indicate that the COG is selected. 

 2. Click the Details button. 

 DMI-Services displays the COG Information Record panel.  The 
screen displays the COG name, COG Address, City, State, Country, 
Postal Code, Point of Contact Name, POC Title, Office Number and 
Email Address. 

 3. Click the Close button to close the panel. 
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CHAPTER 9: Using the Alerts Tool 
About Alerts 
 To save time distributing Alerts and notifications, DMI-Services Operators 

can quickly and effectively broadcast information to other DMI-Services 
Operators and DMI-Services enabled systems. Alerts may be shared 
among systems such as WebEOC, Blue 292, and others. Alert messages 
are available as a standalone tool in DMI-Services or they may be created 
and accessed through the TIE subsystem.  

 All Alerts in DMI-Services conform to the Common Alerting Protocol 1.1 
(CAP), a standard for Alerts.  CAP Alerts provide many benefits to users: a 
consistent, universal format, simple distribution model of "write-once, send 
once over multiple networks," saving time and money by reducing the 
number of custom warning systems to own and operate. 

 CAP Alerts have a consistent format of elements no matter how the Alert is 
distributed.  While an Alert may not have all elements in the standard, the 
CAP format gives first responders and emergency management personnel 
many options to include details and additional resources.  For example, 
any file of any type may be attached to a DMI-Services /CAP Alert. 

 Currently, DMI-Services can only broadcast Alerts among computers. The 
need to distribute Alerts from computers to body-worn communications 
devices is understood, but not yet implemented in DMI-Services. The next 
step toward that goal will be converting text messages to speech for 
broadcast over the National Weather Service radio system. 

 CAP Alerts give DMI-Service Operators the power to write-once and send 
via multiple networks, save time and money by avoiding having to learn 
many specialized warning systems. Whether a single Alert/notification of a 
current disaster (or a series prior to potential disaster e.g. hurricane) DMI-
Service Alerts help emergency personnel respond more efficiently and 
effectively. 

Generating a Quick CAP Alert 
 
 A Quick CAP Alert enables a COG Operator to more quickly enter 

the most essential information about an Alert.  Once saved or 
posted, the Operator may go back into the full Alert and add 
additional information to expand the COG’s knowledge about the 
Alert.  

 To generate a new Quick CAP Alert: 
 1. Select the New Alert button on the Quick Start screen or 

select Alerts List from the Disaster Management Tools 
menu, located in the DMI-Services menu. 
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 2. From within the Alerts List, click the Quick CAP Alert toolbar 
button. 
DMI-Services display a new Quick CAP Alert screen. 

 

 
 
The following fields are pre-populated and may be changed: 
Sender Name: (pre-populated with COG Operator’s name) 
Effective Date: (pre-populated with current date / time) 

 3. Enter information in the following required fields: 
o Alert Title 
o Category (select one of the following valid values: Geo, Met, 

Safety, Rescue, Fire, Health, Env, Transport, Infra, CBRNE, 
Other) 

o Severity (select from these valid values: 
Extreme, Severe, Moderate, Minor, or 
Unknown) 

o Certainty (select from these valid values: Very 
Likely, Likely, Possible, Unlikely, or 
Unknown) 

4. Enter Optional Information into the following fields: 
o Description 
o Information URL 
o Contact 
o Instructions 
o Effective Date: (pre-populated with current date and 

time; click on the Calendar icon to select the date and 
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time when the Alert is effective) 
o Expires Date: (click on the Calendar icon to select the 

date and time when the Alert is effective) 
o Web Link: (enter the web address of a related 

resource) 
o Web Desc: (enter a description of the linked resource)  

 

 
Select Save from the File drop-down menu or click the Save 

toolbar button.  
DMI-Services save the Quick CAP Alert. 
NOTE: When a Quick CAP Alert is created, DMI-Services will 
automatically designate values for certain required fields of a 
regular CAP Alert.   
For a Quick CAP Alert:  

o Sender Name (pre-populated with COG Operator’s name) 
o Sent / Creation Date (pre-populated; not editable by Operator)  
o Message ID (pre-populated with "DM" followed by a DMI-

Services generated unique 19-digit ID) 
o Status will be Actual  
o Scope will be Public 
o Language will be "en-US"  
o Type will be Alert, and  
o Urgency will be Immediate 
o Version will be 0 

The values for these fields will be reflected in the entry for this 
Quick CAP Alert on the full alert screen.  
NOTE: Currently, the DMI-Services Operator may not sort the Alert 
List to distinguish Quick CAP Alerts from the long form version of 
Alerts. 

Retrieving the Alerts List 
 

 
Access the Alerts List from the Disaster Management Tools menu, located 
in the DMI-Services menu.  

 To Retrieve the Alerts List from the DMI-Services  Menu: 
 1. Select Alerts List from the Disaster Management Tools menu, 

located in the DMI-Services menu. 
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 DMI-Services  displays the Alerts List screen, which contains tabs to show 

each of the following types of alerts: 
o All Alerts (working, posted, received and optionally expired Alerts) 

 
NOTE: To review expired Alerts, the Operator may check the Retrieve 
expired alerts checkbox and then press the Refresh button. The 
expired Alerts will display as integrated with the unexpired alerts in the 
list box. The list is sorted by Sent/Creation Date then by severity. 

 
o Working Alerts that a COG has created and saved (but not posted) 
o Posted Alerts are versions of Alerts that have been posted to one or 

more (perhaps all) COGs 
o Received Alerts tab displays a list of all Alerts posted by other 

COGs 
 

 
 For each Alert listed, the following fields are displayed: 

o Alert List Icon 
o COG Name 
o Version 
o Name (Event: Headline) 
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o Sent /Created Date and Time 
o Status 
o Scope 
o Type 
o Received Date and Time 

 From this screen, an Operator may open Alerts, create Alerts, edit Alerts, 
save Alerts, and post Alerts. 

 The Alerts List is refreshed whenever the Operator saves, deletes, or posts an 
Alert.  Also the Alert List is automatically refreshed every three (3) 
minutes regardless of activity.  The Operator may refresh the Alert List 
manually by pressing the Refresh button. 

 To sort the Alert List by a particular field, click on the appropriate column 
heading. 
The default sort order for the all Alerts list is by status (working, posted, and 
then received) and within that order by Sent/Creation Date then by severity. 

Alerts List Icons 
 
 The symbols on the Alerts List indicate the status (working vs. 

posted) of the Alert and indicate if the Alert contains attachments. 
 

Icon Description Definition 
 Working Alert This version of an Alert is a draft form 

that has been saved for possible posting 
at a later time. 

 Posted Alert (can also 
have an Attachment) 

This version of an Alert has been posted 
to the COG so other members have 
received notification of the Alert and may 
review its details. A posted Alert may also 
have attached files. 

 Working Alert with 
Attachment 

This version of an Alert is a draft that has 
been saved for possible posting at a later 
time. The attached files show or describe 
the subject event. 

 Alert Posted from 
another COG 

Alert has been received from another 
COG and may be sent in anticipation of a 
subject event (e.g. flood, tornado, etc) 
from a neighboring locality. 
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 Alert Posted from 
another COG with an 
Attachment 

Alert has been received from another 
COG and may be sent in anticipation of a 
subject event (e.g. flood, tornado, etc) 
from a neighboring locality. The attached 
files show or describe the subject event. 

Generating an Alert 
 

To generate a new Alert: 
 1. Select Alerts List from the Disaster Management Tools menu, 

located in the DMI-Services menu. 
       

 

2. Select New from the File menu.  
DMI-Services display the New Alert screen. 

 

 

 

NOTE: To generate an Alert from within an open Incident 

Record, click on the Alert toolbar button . A new Alert 
screen will be generated and displayed.  
 
In addition to pre-populating the Sender name, the Alert will 
pre-populate the Alert Name and will create Additional 
Information based on the details in the Incident. 
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 3. As the new Alert is created, several fields are pre-
populated from the Incident. These fields are: 

o Version Number (will default as 0) 
o Sender (the name of the COG) 
o Sent /Creation Date and Time (date and time 

that the authored content was last saved) 
o Identifier (required -- The DMI-Services  System 

creates a unique ID number “DM” followed by 19 
digits) 

The Identifier may be modified as necessary. However, a 
COG may not have two Alerts with the same Identifier. 
NOTE: Received Date and Time will appear as blank 
when the Alert is initially created; the field will be populated 
by the DMI-Services System once the Alert is received by 
the receiving COG. 
4. Enter the information in the following required fields: 

o Status (select Actual, Exercise, System, Test, or Draft) 
o Scope (select Public, Restricted, or Private) 
o Type (select Alert, Update, Cancel, Acknowledge, or Error) 

 5. Depending on how the Scope of an Alert is set, other 
fields may apply. For example: 

o If the Scope of an Alert is set to Restricted, the 
COG Operator may specify the Restriction in the 
Restriction field;  

o If the Scope of an Alert is set to Private, the COG 
Operator may wish to use this Address field as a 
note field to amplify or provide rationale. 

The Alert Detail list box displays all rows of Additional Alert 
Information.  
 
Scroll horizontally to view data into the following fields: 
o Event (required; displays the name of the event) 
o Description (displays the details of the incident) 
o Urgency (required; displays one of the following 

valid values: Immediate, Expected, Future, 
Past, or Unknown) 

o Severity (required; displays one of the following 
valid values: Extreme, Severe, Moderate, 
Minor, or Unknown) 

o Certainty (required; displays one of the 
following valid values: Very Likely, Likely, 
Possible, Unlikely, or Unknown) 
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o Category (required; displays one of the 
following valid values: Geo, Met, Safety, 
Rescue, Fire, Health, Env, Transport, Infra, 
CBRNE, Other) 

o Effective Date (pre-populated with current date 
and time; click on the Calendar icon to select 
the date and time when the Alert is effective) 

o Expires Date (displays the date and time when  the 
event is expected to be over) 

 
For information on entering Additional Alert Information, see 
"Additional Alert Info." 

 6. Click on the Optional tab.  

 
Enter data into optional fields. Optional fields include: 

o Note (Type any additional notes in the scrolling 
text box.)  

o Identifier (required -- The DMI-Services  System 
creates a unique ID number “DM” followed by 19 
digits) 

o Operator or Device ID (Type the Operator's 
name or role.  For example, the Operator for a 
large fire department may type “FDNY 
Coordinator.”) 

o Restriction (If the Scope of an Alert is set to 



Page 170 of 220 

Restricted, the COG Operator may specify the 
Restriction in the Restriction field) 

o Addresses (If the Scope of an Alert is set to 
Private, the COG Operator may wish to use the 
Addresses field as a note field to amplify or 
provide rationale.) 

o Handling Codes (Type an appropriate standard 
abbreviation for chemical, biological, or 
radioactive materials.) 

o Reference ID (Type the unique ID of any prior Alert.) 
o Incident ID (Type in the name of original Alert.) 
o Plot on the National Summary Map(Buttons located in tool 

bar when an Alert is open) 
o Plot on My Map(Select or deselect with a check) 

 7. The DMI-Services System saves the Alert. 

Additional Alert Info: Alert Detail 
 
 The Operator may fill out the screen entitled Additional Alert 

Information.  
There are many ways to open the Additional Alert 
Information screen. The Operator may select Add Row 
from the Actions drop-down menu or press the Add Row 
button along the top menu bar.  
A new Additional Alert Info screen will display. 
 

 
 In the Alert Detail screen, enter data into the following fields: 

o Event (required; type in the name of the event) 
o Headline (type in a headline for the incident) 
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o Description (type all the details of the incident) 
o Urgency (required; select Immediate, 

Expected, Future, Past, or Unknown) 
o Severity (required; select Extreme, Severe, 

Moderate, Minor, or Unknown) 
o Certainty (required; select Very Likely, Likely, 

Possible, Unlikely, or Unknown) 
o Sender Name (pre-populated with COG Operator’s name) 
o Language (pre-populated as "en-US" which 

represents U.S. English) 
o Response Type (select one of the following 

valid values: Shelter, Evacuate, Prepare, 
Execute, Monitor, Assess, None) 

o Category (required; select one of the following 
valid values: Geo, Met, Safety, Rescue, Fire, 
Health, Env, Transport, Infra, CBRNE, Other) 

o Instructions (type in detailed recommendations) 
o Effective Date (pre-populated with current date 

and time; click on the Calendar icon to select the 
date and time when the Alert is effective) 

o Onset Date (click on the Calendar icon to select 
the date and time at which an event is expected 
to occur) 

o Expires Date (click on the Calendar icon to select 
the date and time when  the event is expected to be 
over) 

 
The required CAP Alert fields are designed to describe an 
expected or actual event in terms of how much time 
responders have to prepare (urgency), the impact the 
event may have (severity), as well as how confident the 
Alert-issuing agency is that the subject event will occur 
(certainty). 
 
To save Additional Alert Detail data, press the OK button. 
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Additional Alert Info: Other Detail 
 While in the Additional Alert Info screen, the COG 

Operator may select the Other information tab and 
(optionally) enter data into the following fields: 

o Information URL (type a headline for the Alert) 
o Contact (type in a person’s name and phone 

number as a main contact) 
o Parameter (type in a name and value pair to 

describe any additional parameters such as 
method of travel and route as the best way to 
reach the event site or indicate technical 
requirements) 

o Audience (type a description of the intended 
audience, for example, “EMT Staff”) 

o Targeting Code (type in a name and value pair 
describing the system and system-specific code to 
identify the type of Alert. For example name=Postal 
Code; value=43212). 

 

 
To save this Other Alert data, press the OK button. 
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Additional Alert Info: Area Detail 
 While in the Additional Alert Info screen, the Operator may 

add Area Details and optionally enter data to give COG 
Operators a better understanding of the area in which the 
event is (or may be) occurring. 
 
Select the Areas tab. The Areas screen will display the 
Description, Geocode, Circle, Polygon, Altitude and Ceiling 
fields. 

 
  
Double-click on a blank row to open the Alert Areas detail 
screen. Enter the appropriate data for the fields as indicated:  

o Description (required; type a few brief details about 
the affected area). 

o Geocode (type the geographic code name and value 
associated with the area where the subject event is 
occurring or has occurred). 

o Circle (type the point and the radius values to define 
a circle around the affected area). 

o Polygon (type the paired values of points defining a 
polygon that surrounding the affected area). 

o Altitude (type the specific or minimum altitude [above 
sea level] of the affected area). 

o Ceiling (type the maximum altitude [above sea level] 
of the affected area). 

 
To save this Areas data, press the OK button. 
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Additional Alert Info: Resources Detail 
 While in the Additional Alert Info screen, the Operator can 

add Resources to give COG Operators information on how 
to access additional resource files that may be useful during 
response and recovery.  
 
Select the Resources tab. The Resources screen will 
display the following fields: 

o URI (Uniform Resource Identifier; the most common 
URI is a web address) 

o Description (if a URI is entered, this field is 
required; enter a text description of the URI or 
type of resource) 

o MIME (also known as Multipart Internet Mail 
Extensions, MIME Type is a set of standards for 
describing different file formats of content; enter 
the MIME Type to tell a Web browser or mail 
program how to handle files received from a 
server) 

o Size (Integer indicating the size of a resource file; 
enter the size of a resource file in kilobytes [kb] or 
megabytes [mb]) 

o Digest (enter the code representing the digital 
digest or “hash” computed from the resource file; 
it enables application software to validate the 
format of the resource file you’re trying to 
access. Authentication of the “hash” is 
calculated using the Secure Hash Algorithm 
(SHA-1) per FIPS Publication 180-2.) 

o DerefURI (enter the base-64 encoded data 
content of the resource file.  May be used either 
with or instead of the URI in cases when 
retrieval of a resource via a URI is not feasible.) 
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 Double-click on a blank entry row. The Resources entry 

screen will display. 

 
 
Enter Resource data for each field as appropriate, then 
press the OK button to save the Resource entry. 
To save this Resources data, press the OK button. 

 

NOTE: To save the Alert to the National Summary Map, the operator 
must first choose the required check box located in the Alert Panel  
 

 

To save the Alert, click the Save menu button or select 
Save from the File drop-down menu.  An Operator may 
edit an Alert that has been saved.  
Once an Alert has been posted, it may not be edited or 
updated. Instead, create a new Alert and refer to the ID of 
the previously-posted Alert. 

 

It is not necessary to post the Alert at this time.  An 
Operator can simply save the Alert and post it later. 

 If desired, close the Additional Alert Info screen by 
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selecting the Close command from the File drop-down 
menu or press the Close menu button. Or press the 
small square X icon in the upper right-hand corner. 

 Once complete, the additional information may be 
accessed by clicking on its entry in the Alert Detail list 
box or by selecting the appropriate row of information 
with the cursor and pressing the Additional Info 
button.  
NOTE: There may be more than one Additional Alert Info 
entry listed within the Alert Detail list box.  

Editing a Working Alert 
 
 After a Working Alert has been saved, it may be edited and re-saved 

prior to being posted. 
To edit an Alert : 

 1. Retrieve the Alerts List.   
 2. Select the desired Alert from the Alerts List. 

 3. Click the Open icon to open the Alert or double-click on the Alert or 
select Open from the File drop-down menu. 

 The Alert screen opens. 

 4. Click the Edit Data button and update the fields as necessary.  
The following fields may be edited: 

o Status (select Actual, Exercise, System, Test, or Draft) 
o Scope (select Public, Restricted, or Private) 
o Type of Alert (select Alert, Update, Cancel, Acknowledge, 

or Error) 
 
Depending on how the Scope of an Alert is set, a conditional field may 
be edited. For example: 

o If the Scope of an Alert is set to Restricted, then the 
Restriction field will state yes;  

o If the Scope of an Alert is set to Private, the COG Operator 
may specify a street address in the Address field. 

 
Other fields that may be edited are: 

o Identifier (This unique ID number [“DM” followed by 19 
digits] may be modified to suit the business needs of the 
COG.) 

o Operator or Device ID (Type a name or role. For example, 
the Operator for a large fire department may type “FDNY 
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Coordinator.”) 
o Handling Codes (Type an appropriate standard 

abbreviation for chemical, biological, or radioactive 
materials.) 

o Note (Type any additional notes in the scrolling text box.)  
o Reference ID (Type the unique ID of the prior Alert.) 
o Incident ID (Type in the name of original Alert.) 

 
If desired, edit Additional Alert Information, Resource Details, 
and/or Area Details. 
 
The following fields cannot be edited: 

o Version Number (the working version will remain as 0) 
o Sender (the name of your COG) 
o Sent /Creation Date and Time (date and time stamp 

 

NOTE: To save the alert to the National Summary Map, choose the 
required check box located in the Alert Panel  
 

 5. Save the Alert. 
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Posting an Alert 
 Alerts are shared with other COGs through the Post function. The act of 

posting an Alert creates a snapshot of the data contained in the Alert at 
the moment it is shared with another COG.  

 To Post an Alert : 

 1. Click the Post button. 

 The Post Alert screen opens. 

 

 
 2. At the Post Alert screen, the Operator may search for a specific 

COG or they may select a COG from the list box by clicking or 
highlighting the COG(s) in which to Post the Alert.  
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To post to a Distribution List, locate the Distribution List by search for 
"DL-<name of distribution list>" in the search field, then select the 
appropriate Distribution List and post as usual. 
To post the Alert to multiple COGs, they must use the CTRL key to 
select more than one COG.  
Send a Global Alert message -- an Alert sent to and received by all 
COGs in the DMI-Services system -- by highlighting ALL available 
COGs and posting as normal. 

 
 
 

 

3. Click the OK button to post the Alert. 
 
Note: For instructions to plot an alert to the National Summary Map or 
My Map, please review the chapter - Display or Remove an Alert from 
the Map in DMI-Services Web Tools. 
 

 The Posting screen opens. 

 
 4. Click the OK button to post the item.  If the Cancel button is 

selected, the post will be cancelled. 
 
The DMI-Services System will show a message stating that the Alert has 
been Posted. 
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After an Alert has been posted, it cannot be edited and re-posted. 
 Instead generate a new Alert and may refer back to the original Alert by 
specifying its ID number.   
 
For example, suppose a Los Angeles COG Operator posted Alert 
LAX100504-1 regarding a suspected bomb in Concourse A of a Los 
Angeles International airport (LAX).   After posting this Alert, the 
Operator received information regarding a second suspected bomb -- 
this time in Concourse C of LAX.   The Operator will now issue a second 
Alert and will reference his original Alert, LAX100504-1, in the 
Reference ID field of the Alert screen. 

 

If an Operator tries to re-post an Alert, DMI-Services will display an error 
message: "An Alert with the same identifier has already been posted. 
Please choose a unique identifier." 

Display or Remove an Alert from the Map in DMI-Services Web Tools 
 
 

Overview 
 
From the DMI-Services Desktop, choose to plot an Alert (depending on 
permissions) to the map located within DMI-Services Web Tools. 
 
Within DMI-Services Web Tools, operators have access to view all 
posted alerts that are version 1 and up.  Operators can display the 
National Map Alerts and/or their COG’s Alerts via My Map.  

National Summary Map 
 
Only Primary Operators have permission to plot Alerts to the National 
Map.   

My Map 
Both Primary and Update Operators have permission to plot Incidents 
to their COG via My Map. 

  
Menu bar → select Disaster Management Tools → then Alert List. 
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From the Alert list, select the Alert.  
 
*After selection of the Alert, the line will change in colors. 

 

 Plotting from a Working Alert. 
 
A Working Alert is always version 0.  This can be seen from the Alerts 
List.   
 

 

 

 
Whether you’ve created a new Alert or opened an Alert from the 
Working Alert List, make sure all required and necessary information 
has been completed.   
 

 After the Working Alert is filled out → Click the Post Button from the 
Tool Bar. 
 

 
 
 

  
Post Dialogue Box opens → Choose COG for Post →  Select checkbox 
to have the alert displayed on the  National Summary Map, My Map, or 
both → Click Ok. 
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An acknowledgment will follow. 

 

 
 Plotting from a Posted Alert. 
 
From the Alert List, a Posted Alert is recognized by its Alert Icon.  In 
addition, it will never be version 0 
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 Once all of the applicable forms are completed, look to the tool bar for 
the Plot Buttons.  Click on whichever button to plot an incident to the 
National Summary Map or My Map.  
 

        
 
If the box is selected with a check mark, the Incident may not be added 
to the Map but instead removed.    
 
This button serves as the only way to remove an alert from the map. 
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CHAPTER 10: Using NOAA's HazCollect System 
The National Weather Service is conducting Operational Acceptance Testing of the 
HazCollect System through mid-November 2006.  Consequently, the HazCollect 
functionality within DMI-Services is not yet available to the general public.  Emergency 
Managers should continue to check the NWS HazCollect homepage for further updates 
at www.weather.gov/os/hazcollect/. 

About Non-Weather Emergency Messages (NWEMs) 

 

NWEMs will be broadcast over public systems including NOAA 
Weather Radio, NOAA Weather Wire Service, EMWIN, Internet, 
radio and TV.  Emergency Alert System (EAS) activation will be 
requested.  Carefully review the message to ensure it is correct 
and suitable for PUBLIC broadcasts outside DMI-Services.  An 
INACCURATE or MISLEADING MESSAGE could have SEVERE 
CONSEQUENCES. 
Non-Weather Emergency Messages (NWEMs) are critical warnings 
used to inform the general public of various types of emergencies. 
The messages are created for public broadcast, specifically for 
distribution to National Weather Service (NWS) public dissemination 
systems such as National Oceanic and Atmospheric Administration 
(NOAA) Weather Wire and NOAA Weather Radio. Like standard 
Alerts, NWEMs conform to the Common Alerting Protocol (CAP) and 
include message types such as natural disasters (e.g. avalanches, 
volcanoes, floods, and earthquakes), AMBER alerts, technological 
accidents (e.g. chemical releases, oil spills, nuclear power plant 
emergencies, maritime accidents, radiological hazards), and terrorist 
attacks. 
 

 DMI-Services and other DMI-Services enabled emergency systems 
create NWEMs for dissemination of emergency information by using 
the DMI-Services Alerting mechanism.  The essential need to 
centralize the collection and distribution of these messages is met 
through the All Hazards Emergency Message Collection System 
(HazCollect).  Once messages are created, they are posted to the 
HazCollect Server for conversion to an NWS format and for 
dissemination through the existing NWS warning systems.  All 
messages distributed must meet HazCollect security requirements for 
user authentication and authorization. 
 
NWEMs are created for warnings at local, state, regional and national 
levels.  Based on proper authorization, Emergency Managers (EMs) 
create and transmit messages, via HazCollect, to appropriate 

www.weather.gov/os/hazcollect/
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servicing NWS offices, including State Liaison Weather Forecast 
Offices (WFOs).  Information created for public dissemination can be 
simultaneously shared with multiple Collaborative Operating Groups 
(COGs) on various levels, as necessary, depending on the scale of 
the incident and the level of collaboration required. 
 
By augmenting DMI-Services and the existing NWS infrastructure, the 
existing manual dissemination process for handling creation and 
distribution of NWEMs is replaced by a more efficient, automated 
system. This new system decreases time/effort in handling those 
messages, reduces error potential, decreases security risks and 
increases outreach to federal, state, and local emergency 
management agencies. 
 

Retrieving the Alert List 
 
 Access the Alert list from the Disaster Management Tools menu, 

located in the DMI-Services menu. 

 

NOTE:  This Alerts List displays all Alerts.  An NWEM is a specialized 
form of an Alert with unique functions and behaviors.  Not all COGs 
will have access to creating an NWEM. 

 
To retrieve the Alert List from the DMI-Services Menu: 
Select DMI-Services  ► Disaster Management Tools ► Alerts List 

  DMI-Services display the Alerts List screen, which contains tabs to 
show each of the following groups:  All, Working, Posted and 
Received Alerts.  
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NOTE:  To review expired Alerts, check the Include Expired 
checkbox.  The expired Alerts will be included in the updated list of 
Alerts.  The list is sorted by Sent/Creation date.  In addition, the 
display of the menu bar revealing the 'New NWEM Button’ is only 
viewable by some COGs.  NWEM COGs are determined by NOAA. 
 

 For each Alert listed, the following fields are displayed:   
COG - The name of the COG that owns the Alert and is able to 
modify, post to the public and disseminate to other COGs  
Version - Working = 0 and Posted = 1 
Name (Event) - Subject of the Alert. 
Sent/Created Date and Time - The time and date of the 
origination of the Alert.  This is a system timestamp and is not 
editable. 
Status - Identifies whether the message is informing the public 
about an actual emergency or is being used for training 
purposes.  The status identifies the appropriate distribution 
process for the message. 

Not Assigned - used for creating and saving an Alert 
without posting.   Prior to posting, the Status must be 
changed to Actual, Exercise, System, Test, or Draft.  
Actual - A real message created for dissemination to the 
public through HazCollect to the NOAA Weather Radio. 
System - A message created for the purpose of training.  
It will not be sent out for public dissemination. 
Exercise - provides the ability for a message to be 
distributed even though it is not an actual emergency. 
Test - A message created for system test purposes which 
may or may not be distributed.  
Draft - A message created which can be saved without 
posting. This message may or may not be modified and 
distributed in the future.  

o Scope - A description of the intended distribution of the 
NWEM.  Public is the default selection and there are no 
other options available for an NWEM. The message will 
be distributed to the general public. 

o Type - Shows the kind of message being communicated.  
Alert is the default selection that indicates the message is 
an official warning or emergency notification. 
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 From this Alerts List, Alerts and NWEMs may be opened, created, 
edited, saved, posted and plotted to the National Summary Map. 
The Alerts List is refreshed whenever an Alert is saved, deleted, or 
posted.  It is also automatically refreshed every three (3) minutes 
regardless of activity.  The list may be refreshed manually by 
clicking the Refresh button. 
 
1. To sort the Alert List by a particular column, click on the 

appropriate column heading.   
 
The default sort order for the All Alerts list is by Status (working, 
posted, then received) and within that order by Sent/Creation Date. 
  
2. View the list of Alerts.  The Alerts List provides the ability to group 

NWEMs and CAP Alerts by: 
o • All - A combination of Working, Posted and Received 

Alert s. 
o • Working - Created Alerts that are saved but not posted. 

 A Working Alert will have a version number of zero (0) and 
is editable by members of the owning COG. 

o • Posted - An Alert that has been posted to the public and 
potentially to one or more COGs.  A posted Alert cannot be 
edited and will have a version number of one (1). 

o • Received - A list of Alerts posted from other COGs. 
 

 

To view Expired Alerts in the Alerts List check the Include Expired 
checkbox. The Expired Alerts will then display in the Alerts List. 
 
NWEMs and Alerts are Expired when the Save/Sent Date plus the 
Duration is after the current Date/time. 
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Alerts List Icons 
The symbols on the Alerts List indicate the status (working vs. posted) of the 
Alert and indicate whether the Alert contains any attachments. 
 
Icon Description Definition 

 Working Alert This version of an Alert is a draft form 
that has been saved for possible posting 
at a later time. 

 Posted Alert This version of an Alert has been posted 
to the HazCollect Server and to other 
COGs (if applicable) so other members 
have received notification of the Alert and 
may review its details. A posted Alert 
may also have Attached files. 

 Working Alert with 
Attachment 

This version of an Alert is a draft form 
that has been saved for possible posting 
at a later time. There are attached files 
that show or describe the subject event. 

 Alert Posted from 
another COG 

This Alert has been received from 
another COG. 

 Alert Posted from 
another COG with 
an Attachment 

This Alert has been received from 
another COG. The Alert contains 
attached files showing or describing the 
subject event. 
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Generating an NWEM 

 To Generate a New NWEM: 
1. From the Alerts List select File ► New NWEM or click the New 

NWEM button. 
The NWEM Alert screen opens. 

 
 The system pre-populates the Sender name, the Identifier and the 

Operator/Device ID.   
2. As the new NWEM Alert screen opens, the following data fields are 

populated: 
o Version Number (will default as 0) - indicates this is a working 

NWEM. 
o Sender - The name of the COG that owns (creates) the 

message. 
Sent /Creation Date and Time - (Populated on Save) - The time and 
date NWEM was created and saved.  
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When the message is posted the Sent/Creation Date and Time field is 
updated with the Post date and time.  This is a system timestamp and is 
not editable. 

o Scope (Pre-populated) - A description of the intended distribution 
of the message.  Public is the default selection.  There are no 
other options available. The message will be distributed to the 
general public. 

o Type (Pre-populated) - Shows the kind of message being 
communicated.  Alert is the default selection that indicates the 
message is an official warning or emergency notification. Valid 
values are: Alert, Update, Cancel, Acknowledge, and Error. 

o Identifier (Pre-populated) - A unique ID number (“DM” followed by 
19 digits) identifying the message.  Each message has a unique 
identifier. NOTE: The Identifier field is displayed on the Optional 
Information screen. 

o Operator/Device ID (Pre-populated) - Unique ID linked to the user 
that created the message.  

o NOTE: The Operator/Device ID field is displayed on the Optional 
Information screen. 

3. Enter information in the following required fields: 
o Status - identifies whether the message informs the public about 

an actual emergency or trains emergency response personnel. 
The status selections are:   

o Not Assigned - used for creating and saving an NWEM without 
posting.   Prior to posting, the Status must be changed to Actual, 
Exercise, System, Test, or Draft.  

o Actual - A real message created for dissemination to the public 
through HazCollect to the NOAA Weather Radio. 

o System - A message created for the purpose of training that will 
not be sent out for public dissemination. 

o Exercise - provides the ability for a message to be distributed 
even though it is not an actual emergency. 

o Test - A message created which may or may not be distributed 
even though it is not an actual emergency depending on COG 
authorizations. 

o Draft - A message created which can be saved without posting. 
This message may or may not be modified and distributed in the 
future.  
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o Category - is a characterization of the event(s) described in the 
message. Valid options are:  

o Geo - Geophysical (including landslides) 
o Met - Meteorological (including floods) 
o Safety - General emergency and public safety 
o Security - Law enforcement, military, homeland and local/private 

security 
o Rescue - Rescue and recovery 
o Fire - Fire suppression and rescue 
o Health - Medical and public health 
o Environment - Pollution and the environment  
o Transport - Public and private transportation 
o Infra - Infrastructure such as utilities, telecommunications and 

other non-transport services 
o Other - any miscellaneous characterizations. 

 4. Click on the Optional tab to enter data in the following optional fields: 
o Note -Type any additional notes in the scrolling text box. 
o Reference ID(s) - The unique identifier of previous 

NWEMs or Alerts (optional for new NWEM, default 
populated for Updates and Corrections) - Provides the 
NWEM identifier for previous NWEMs that have been 
created. 

NOTE: The following optional fields are not applicable to NWEMs: 
o Restriction - Not applicable for NWEM since all 

NWEMs are Public.  Used when the scope of the Alert is 
Restricted.   

o Addresses - Not applicable for NWEM since all 
NWEMs are Public.  Used when the scope of the Alert is 
Private.   

o Handling Codes -Type an appropriate standard 
abbreviation for chemical, biological, or radioactive 
materials. 

o Incident ID(s) (optional) - Unique identifier if the Alert is 
created from an incident. 
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Alert Detail/Additional NWEM Information 
 Alert Detail is required for NWEMs and delivers essential information 

about the emergency.  The Headline and the Description fields comprise 
the actual message that will be broadcast through HazCollect.  Unlike an 
Alert, only one Alert Detail row may be added. 
5. Click the Add Info button or click the Add Row button next to the 

Alert Detail field in the NWEM Alert screen. 

 
 The required fields are identified by an asterisk (*) in the Alert Detail 

NWEM Information screen.  They include: 
o Event 
o Headline 
o Description 
o Areas 
o Duration Time 
o Urgency  
o Severity 
o Certainty 
o Language 
o Category  

6. Click on Event to select the type of NWEM that will be generated.   
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 After selecting the Event, click on the Information button to enter a 
detailed description of the Event. 
7. Enter the Headline - The title of the message. 
8. Enter the Description - (The body of the NWEM).  This text, in 

addition to the Headline, will be the message that is translated into the 
audio message and distributed through the NOAA Weather Wire 
Service, the NOAA Weather Radio and other NWS facilities. 

 
The Headline may not exceed 160 characters.  The Headline and the 
Description fields from this screen are used to construct the actual 
message for broadcast and may NOT exceed 160 words.  The message 
description may only contain letters, numbers, + (plus sign), - (minus 
sign), (period), or … (ellipse). 

This message will be broadcast over public systems including NOAA 
Weather Radio, NOAA Weather Wire Service, EMWIN, Internet, radio 
and TV.  EAS activation will be requested.  Carefully review the message 
to ensure it is correct and suitable for PUBLIC broadcasts outside DMI-
Services.  An INACCURATE or MISLEADING MESSAGE could have 
SEVERE CONSEQUENCES. 

 9. Add Call to Action to the Body of the NWEM.  Click on 
the ellipse button to view the Call to Action list. 
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10. The Call to Action screen will be opened. 
 
 

 11. If the call to action already is listed, click on the desired 
text and select the OK button. 

12. To create a new Call to Action click the Add Button and 
type in the desired call to action. 

13. Click OK to save the new Call To Action Statement.  The 
system provides notification that the Call To Action was 
saved.  Click OK. 

14. The Call To Action is added to the Additional NWEM 
Information screen. 
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 15. On the Call to Action screen click the Add button.  The statement is 
added to the NWEM Description field. 

 

 
 
 16. Click on the ABC Button to check the spelling of the 

description. 

 17. Click Finish when complete with the Spell Check and click 
the Add button to add the statement to the Description 
field. 

 Area Detail is used to define the geographic area for 
disseminating the message through HazCollect.  Geographic 
areas are visible and selectable based on a COG’s level of 
authorization.  The COG’s available areas include only those 
states, counties and marine areas where authorized 
messages can be broadcast. 
Selections may include:  

National - Includes all states, counties and marine 
areas. 

USA - Includes all states and counties. 
State (level) – Includes all counties within the 

state. 
County (level) – Includes only the county selected. 
Country (level) – Includes only the country 

selected. 
Marine Areas – Includes all marine areas. 
Marine Area (level) – Includes only the marine 
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area selected. 

 18. Select the Areas button next to the Area table to open the 
Select Areas for Alert screen. 

 

 19. Click on the icon next to the geographic area that will 
receive the message.  

20. Click on the checkbox by the locations. 
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 21. Click OK to close the window and return to the Areas 
screen and retain the desired areas.  Click Cancel to 
close the window without retaining the areas information.  

 

 
 
 22. The Areas NWEM Information screen will be updated with a 

list of the selected area(s) including the: 
o Description - Name of the County  
o Geocode - Unique numeric identifier of the county. 

23. Select Duration Time - This field is used to specify the amount of 
time an NWEM will be valid (maximum of 6 hours). 

24. Select the level of Urgency - The desired action's level of 
importance.    

o Immediate - Indicates action should be taken 
immediately. 

o Expected - Indicates action should be taken within 
the next hour. 

o Future - Indicates action should be taken in the near 
future. 

o Past - Indicates action is no longer required. 
o Unknown - Indicates that the degree of urgency is 

not known. 
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25. Select the Severity level - Represents the level (or degree) of 
threat to life and property.  

o Extreme - Indicates extraordinary threat to life or 
property. 

o Severe - Indicates a significant threat to life or 
property. 

o Moderate - Indicates a possible threat to life or 
property. 

o Minor - Indicates a minimal threat to life or property. 
o Unknown - Indicates the threat to life or property is 

not known. 
26. Select the level of Certainty - The degree to which an event is 

likely to occur.  
o Observed - The event is determined to have 

occurred or is ongoing.  
o Likely - The event may occur.  
o Possible - The event is possible but not likely to 

occur (chance is equal to or less than 50%).  
o Unlikely - The event is not expected to occur. 
o Unknown - The degree of certainty is unknown. 

27. Optional fields in the Additional NWEM screen are:   
o Instructions - type in detailed recommendations 
o Information URL - enter links to other web sites that 

provide additional information. 
o Contact - Type in a person's name and phone 

number as a main contact. 
o Parameter(s) - Enter any additional parameters 

such as the best way to reach the site or indicate 
technical requirements. 

o Effective Date - Select the date and time when the 
NWEM is effective.   

o Onset Date - Select the date and time when the 
NWEM will occur. 

28. Select the Language – Select the language in which the NWEM 
will be broadcast (English or Spanish). 
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Currently, only Puerto Rico may receive NWEMs in Spanish. 
  
 
 

 

 
Resources  
 
 Resources in the form of image/audio files, applications, text messages, 

or instructions can be referenced using the Resource data field.  For 
each resource, a web link and description can be made available. 
Optional file details can be provided as necessary. 
 
29. Click on the ellipse next to Resources to add other useful resources. 
 

A new NWEM Resources screen will be displayed. 

 
 
 Although the NWEM Resource screen is optional, there are two 

required fields that must be completed if resources are to be included 
in the NWEM: 
 URI - (Uniform Resource Identifier) an internet address that 

identifies resources in the web:  documents, images, 
downloadable files, services, electronic mailboxes and other 
resources. 

 Description - The subject event of the NWEM. 
 
 The optional fields on the NWEM Resources screen are: 
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MIME (Multipart Internet Mail Extensions) A set of standards for 
describing different file formats of content.  A MIME extension 
tells a Web browser or mail program how to handle files received 
from a server. 
Size - Indicates the size of a resource file. 
Digest - The code representing the digital digest of "hash" 
computed from the resource file.  It allows application software 
to validate the format of the resource file you're trying to access. 
DerefURI - The base-64 encoded data content of the resource 
file. This may be used in instances when the retrieval of a 
resource via a URI is not feasible. 
 

30. To update the message with the NWEM Resources, click on the 
OK button.  Or select the Cancel button to cancel the addition of a 
resource. 

 
  

 

 
 

 

NWEM Resources are displayed as rows within the Resources list 
box on the Additional NWEM Information screen. 
 
The NWEM Resources Detail Box may list multiple resources.  
Enter Audience (Optional) information to identify the people who 
would be interested in viewing the NWEM. 
Close the Additional NWEM Information screen by clicking OK or 
Cancel.  Clicking OK updates the NWEM Alert screen with the 
Event, Description and Effective Date.  Clicking Cancel closes the 
Additional NWEM Information screen without populating the Alert 
Detail information 
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Saving a New NWEM 

 

NOTE: To save the NWEM to the National Summary Map, the 
operator must first choose the required check box located in the 
NWEM Panel. 

 To save the NWEM, click the Save button or select File ►Save.   

 

 

Saved NWEMs that have not been posted may be edited at any time. 
 After an NWEM has been posted, it CANNOT be edited. 
 
To close the message, click on the Close button, select File ►Close 

or click the small X icon. 
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 Save Copy 

 

NOTE: To save the NWEM to the National Summary Map, 
the operator must first choose the required check box 
located in the NWEM Panel  

 Save Copy enables the saved NWEM to be copied and saved as a new 
NWEM.  An entire message may be used as the template for a new 
message. 
 
From an open NWEM select File ► Save Copy from the main menu or 

select the Save Copy icon below the main menu. 
 

 Enter the new name of the new NWEM and click OK.  The new NWEM 
is created and a new NWEM Alert window is opened.  Note the new 
Name and Identifier number. 
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NOTE: To save the NWEM to the National Summary 
Map, the operator must first choose the required check 
box located in the NWEM Panel  

 The new NWEM contains all the same information from the initial 
NWEM.  Select Save to save the NWEM. 

 
 
Editing an NWEM 
 
 After an NWEM has been saved, it may be edited and re-saved prior to 

being posted. 
 
To edit an existing NWEM: 
1. Retrieve the Alerts List as described earlier in "Retrieve the Alerts 

List." 
2. Select the desired NWEM from the Alerts List. 
3. Click the Open button, or click on the ellipse at the right side of the list 

screen. 
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 The NWEM Alert screen opens. 
4. Select Actions ► Edit or click the Edit Data button and update the 

fields as necessary. 
The following fields may be edited: 

o Name 
o Status 
o Password 
o Restrictions  
o Addresses 
o Handling Codes 
o Notes 
o Reference ID 

Incident ID 
The following fields may not be edited: 

o Version Number 
o Sender (the Name of the COG) 
o Sent/Creation Date and Time (date and time stamp) 

 
 

Edit Alert Detail/Additional NWEM Information   
 
 5. Click on the Alert Detail row and click on the ellipse to view the 

Additional NWEM Information screen. 
The Additional NWEM Information screen is displayed: 
6. Update the desired fields: 
All fields except Sender Name are editable.   

o Event 
o Headline 
o Description 
o Area 
o Instruction 
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o Information URL 
o Contact 
o Parameter 
o Effective Date 
o Onset Date 
o Duration Time 
o Urgency 
o Severity 
o Certainty 
o Language 
o Category 
o Resource Details 

 
7. Close the Additional NWEM Information screen by clicking OK or 

Cancel.  Clicking OK updates the NWEM Alert screen with the 
Event, Description and Effective Date.  Clicking Cancel closes the 
Additional NWEM Information screen without populating the Alert 
Detail information. 

 
8. To save the updated NWEM, click the Save button or select File 

►Save.  

 

NOTE: To save the NWEM to the National Summary 
Map, the operator must first choose the required check 
box located in the NWEM Panel  

Posting an NWEM 
 
 The primary purpose of posting an NWEM is to broadcast messages to 

the general public.  NWEMs must be posted to HazCollect for 
dissemination.  Posting also enables the NWEM to be sent to other 
COGS.  The act of posting an NWEM creates a snapshot of the data 
contained in the NWEM at the moment it is shared with another COG.  If 
an Emergency Manager wishes to generate a message to other COGs 
without posting to HazCollect, an Alert should be generated. 
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 To Post an NWEM: 

1. From Alerts List or an Open NWEM click File ► Post or click the 
Post button. 

 

Prior to posting, the Status must be changed from the default of Not 
Assigned to Actual, Exercise, System, Test, or Draft. 

 The NWEM Public Broadcast Confirmation screen opens so the 
actual message to be distributed may be reviewed. 
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 2. To continue posting the NWEM click on the check-box next to "I 

confirm I have reviewed this message and it is ready for PUBLIC 
broadcast."  To update the message click Cancel to return to the 
NWEM for modification. 

 
 

 
 
 

 
 

 3. Clicking the confirmation checkbox enables the Broadcast button. 
Click the Broadcast button to send the message to HazCollect. 

 4. The DMI-Services system will show a message stating the NWEM 
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has been posted. 
 

 

After an NWEM has been posted, it cannot be edited and re-
posted.  Instead a new NWEM must be generated and referred back 
to the original NWEM by specifying its ID number.  See Create 
Update section of the guide for further information.  The Updated 
NWEM will include a reference ID of the initial message. 

 5. In addition to releasing an NWEM to the public the NWEM may 
also be sent to other COGS.  To select the COGs that will receive 
the NWEM click the COG Name.   

 
 
 

 
 
 

 

To post the NWEM to multiple COGs, use the CTRL key to select 
more than one COG. 

 6. Click the OK button to post the NWEM. 
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7. The Posting screen opens. 

 

 8. Click the OK button to post the item.  If the Cancel button is 
selected, the post will be cancelled. 

 
9. Select Save from the File menu or press the Save button. 

Update NWEM 
 
 Once a message has been posted, the Update function provides a 

method to disseminate more information related to the original message.  
For instance, if the original message provided a specific time that an event 
occurred, the updated message could provide an updated time for the 
event.  Areas, Instructions, Contact, Parameter, Onset Time, Duration 
Time, Urgency, Severity, Certainty, Language, Category, Resources, 
and Audience are pre-populated from the previous message but are 
editable.  Sender Name is not editable.   
 
To send an updated NWEM on a message that has already been posted: 
1. Select DMI-Services  ► Disaster Management Tools ► Alerts List 
2. DMI-Services display the Alerts List screen. 
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 3. Select the posted NWEM to be updated (version 1). 
4. The NWEM is displayed. 
5. Select File ►Save Copy 
6. An Enter Name screen is displayed. 

 

 

NOTE: To save the NWEM to the National Summary 
Map, choose the required check box located in the NWEM 
Panel  

 
 7. Enter the name of the NWEM to be created. 

8. Click OK 
9. A new message identifier will be automatically added and the old 

message identifier will be moved to Reference ID(s).  
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 10. The NWEM Update screen will open. 

 

Not all fields are editable.  Some fields are pre-populated with 
information from the previous NWEM. 

 11. Click on the row in the Alerts Detail field. 
 

 
 12. Click on the ellipsis to open the Alerts Details screen. 

 
 

 
 
 The system default populates Event with Administrative 
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Message/Follow up Statement. 
13. Enter the updated Headline and Description. 

 

Other fields in this screen may be modified even though they are pre-
populated with information from the previous message.  Areas, 
Instructions, Contact, Parameter, Onset Time, Duration Time, 
Urgency, Severity, Certainty, Language, Category, Resources, and 
Audience are editable.  Sender Name is not editable. 
 
14. Modify the appropriate information.   
15. Click OK to close the Additional NWEM Information – UPDATE 

window. 
16. Click Save to save the message or Post to disseminate the 

message. 
 

Create Correction 
 
 A Correction message is submitted when a previous NWEM had 

incorrect information in the Headline or the Description field.  All other 
data fields are un-editable. 
 
To send an NWEM Correction on a message that has already been 
posted: 
1. Select DMI-Services  ► Disaster Management Tools ► Alerts 

List 
2. DMI-Services display the Alerts List screen. 
3. Click on the posted tab and select the NWEM to be updated then 

click the Ellipse icon or Open button. 
The NWEM is displayed. 

4. Select File ►Correction 
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 An Enter Name screen is displayed. 

5. Enter the name of the updated correction. 
 
 

 6. Click OK 
The NWEM Correction screen is displayed. 
7. Click the Edit Data button to enable editing of the message text in 

the Additional NWEM Information screen. 
None of the fields in the NWEM Correction window is editable. 

8. Double click on the event listed in the Alert Detail field. 
The Additional NWEM Information – CORRECTION screen is 

opened. 
9. Modify the Headline or the Description field.  All other fields are not 

editable. 
10. Click OK to close the screen. 
11. Click Save to save the NWEM or click Post to disseminate the 

message. 
 

 

NOTE: To save the NWEM to the National Summary Map, 
the operator must first choose the required check box 
located in the NWEM Panel  

 o To return to the top of the page at any time, click either the 
Home or Back button. 

 o To print the list, click the Print button.   
NOTE: Because of the size of the list, printing may take a few minutes. 

 o To copy and paste text from the list into another application 
(such as MS Word), click and drag the cursor across the text 
to highlight it and select Copy from the right-click menu.  Then 
open the other application and paste. 
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CHAPTER 11: DMI-Services Messenger 
Using DMI-Services Messenger 
 DMI-Services Messenger is the online "chat" capability that enables 

Operators to communicate with other DMI-Services members. Using 
DMI-Services Messenger, an Operator can communicate with members 
of other COGs in "real time".  All DMI-Services Operators who have DMI-
Services Messenger running are available for the online chat capability. 
If the Operator responds to an invitation to joins a DMI-Services 
Messenger chat session, the DMI-Services Messenger will display the 
session in progress. Otherwise, the session area of DMI-Services 
Messenger will be blank.   

 

If the Operator does not have Automatically Launch DMI-Services 
Messenger on Start Up selected in their DMI-Services Desktop 
Settings screen, then they will have to launch DMI-SERVICES    
Messenger from the Disaster Management Tools screen, located in the 
DMI-Services menu. 

 
To begin a Messenger Session: 

 1. From the DMI-Services Messenger start up screen, click New 
Messenger. 

 
 The DMI-Services Messenger screen opens. 
 Add other Operators to the session using the Add button.  To send 

messages, enter the text in the text box on the lower left part of the 
screen and click the Send button. 

 

NOTE: In addition to the status bar message, DMI-SERVICES    now 
plays a sound prompt to alert Operators that a new Instant Message is 
being displayed. 
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Accessing DMI-SERVICES    Messenger from the DMI-SERVICES    
Menu 

 

NOTE: If an Operator has Automatically Start DMI-SERVICES    
Messenger at Start Up selected in their default settings, the DMI-
SERVICES    Messenger message box will be automatically displayed 
when DMI-Services  is started.  In this case, it is not necessary to 
perform Step 1. 

 1. Select DMI-Services Messenger from the Disaster Management 
Tools menu, located in the DMI-Services menu. 

 The DMI-Services Messenger start up screen opens, stating that DMI-
Services Messenger is running. 

 

 
 2. Click the New Messenger button. 

 
 The DMI-Services Messenger screen opens.   

 
For more information about this screen, see Using DMI-Services 
Messenger. 

Adding Operators to a Messenger Session 
 
 Only Operators that are currently logged into DMI-SERVICES    

Messenger can be added to a Messenger session.   

 
1. From the DMI-Services Messenger screen, click Add to add 

another Operator to the DMI-Services Messenger session. 
 The Add New User screen opens.   
 2. Select the Operator's name from the list. 

 

NOTE: The Operator can search for a specific Operator and filter this 
search by specifying the COGs they wish to Search. As a result, it is 
much easier to find an Operator's name from the list of COGs. 
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3. Click the Add button to add the Operator. 

 The Operator has the option to accept or refuse the invitation. 
 If the Operator accepts the invitation, the Operator's name appears in 

the Operator List. 
 Once the other Operators have accepted the invitation, the Operator can 

begin sending messages in the text box in the lower left part of the 
screen. 

Joining a Messenger Session 
 
 If an Operator wants to invite another Operator to a Messenger 

session: 
1. An Operator has selected the participant from a list of Operators 

currently running the DMI-Services Messenger. 
An invitation box displays indicating that the recipient Operator has 
been invited to a DMI-Services Messenger session. 

 2. Click Join to join the Messenger session or click Refuse to refuse 
to join the session. 

 If the Operator clicks the Join button, the Messenger screen opens, 
displaying the session and a list of Operators participating. 

 

NOTE: DMI-Services Messenger must be running to be invited to a 
DMI-Services Messenger Session. 
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Removing Operators from a Messenger Session 
 The Operator that began the Messenger sessions can remove other 

Operators from the session.  
 1. Select the Operator's name from the Active Operators List. 

 

2. Click Remove to remove the Operator from the DMI-Services  
Messenger session. 

 

NOTE: Any participating Operator, who did NOT begin the Messenger 
session, will NOT be able to remove any other Operators from the 
session. 

 
Sending Messages 
 
 1. Type the message in the text box. 

.   

 
Click Send to send the message.  The message appears in the top left 
corner of the screen. 
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Map Symbols 
To view the Map Symbols used in DMI-Services, access the link below for more 
information. 
 
Link to Map Symbols 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contacting Us 

 

 
Need help with DMI-Services software or require additional 
information, please contact the Service Desk.  Assistance with the 
Service Desk may be acquired via the following methods:  

Telephone Support: 1-800-451-2647 
 
Email: help@dmi-services.org 
 
Thanks again for using DMI-Services. 
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